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1.1	Member Plan

Pick a Plan that Works for You. According to your system requirements, you can choose either Windows Version or Mac Version.

100% Secure | No malware | Ads Free | 24 H/7 Response

Index

01Individuals
02Team & Business
03Educational
04Bundles

Individuals

ANNUAL PLAN

This product is a paid subscription. You will be charged the same amount when your subscription auto-renews annually. You can cancel your subscription at
any time. You can enjoy below:
Over 10 updates annually, including product features like Video Editing, Audio Editing, Color Editing, Stock Media (Unsplash, Giphy, Pixabay), etc.
Service including 1 GB Wondershare Drive storage.
Click to see more information about ANNUAL PLAN.
Learn how to reset Wondershare ID if you need it.

CROSS-PLATFORM PLAN

This product is a paid subscription. You will be charged the same amount when your subscription auto-renews annually. You can cancel your subscription at
any time. You can enjoy below:
The cross-platform license can be used across 6 devices (Windows, macOS, Android, iOS, iPad, Android tablets), but can use only one instance of Filmora at a
time. You are entitled to:
Desktops (Windows, macOS):
- full access to the features of Filmora for desktops
- 1GB of Filmora cloud storage - 30 minutes of Speech-to-Text (STT)
- *An extra cost needed for resources
Phones (iPhones, Android Phones):
- full access to the features of Filmora for phones
- 1GB of Filmora cloud storage per user
Tablets (iPads, Android Tablets):
- full access to the features and resources of Filmora for tablets
- 1GB of Filmora cloud storage
- 30 minutes of Speech-to-Text (STT)
- 5,000 characters of Text-to-Speech (TTS)
Service including 1 GB Wondershare Drive storage.
Click to see more information about CROSS-PLATFORM PLAN.

PERPETUAL PLAN

If you buy a Perpetual License, you will get perpetual access to the version of the software you purchased the license for, including updates. However, this plan
does not include future versions of the software. Should a new version be released, you will need to purchase a new plan to access it. You can enjoy below:
1 update annually, including product features like Video Editing, Audio Editing, Color Editing, Stock Media (Unsplash, Giphy, Pixabay), etc.
Service including 1 GB Wondershare Drive storage.
Click to see more information about PERPETUAL PLAN.

Team & Business

For Team

The Team plan gives you the flexibility to provision, track and manage licensing across groups and teams.
You can get the price of the corresponding Annual Plan according to the number of users you select. Besides, you will get the following:
All Filmora's Editing Features
Free Updates
Free Senior Tech Support
Permission for Company Use
No Attribution Required (You won's have to include a statement that your video is made in Filmora when using it for a commercial purpose)
Multi-User Control
Volume discount
1-1 Sales Report
Flexible payment options

For Business

Please fill out the online form and contact our sales team to purchase a business plan for more than 5 users.
Click to see more information about BUSINESS PLAN.
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Educational

For Student

Read Student Pan Policy and log into Student Beans Account.

For Educator

Please fill out the online form and contact our sales team to purchase a business plan for more than 20 users.
Click to see more information about EDUCATIONAL PLAN.

Bundles

Buy Filmora 13 (for Windows) in bundles to save more. Bundles include:

Image BG Remover and Video Editing Solution

Wondershare Filmora 13
Wondershare PixCut

All-in-One Photo and Video Editing Solution

Wondershare Filmora 13
Wondershare PixStudio

Capture, Record, and Edit Videos Like a Pro

Wondershare Filmora 13
Wondershare DemoCreator

Edit and Convert Video as the Way You Like

Wondershare Filmora 13
Wondershare UniConverter
Click to see more information about BUNDLES PLAN.

2.1	Latest Versions and Features: V14

We are excited to say that Filmora 14 is now officially updated! We've issued plenty of new features which will help improve your video editing efficiency and
produce professional output results! Let's see more!

Note:

Filmora will push the new features to your PC/Email via the Message Center Check for Upgrade. You can also download it directly via our website.

Index

01Smart BGM Generation
02Filmora Copilot 2.0
03Planar Tracking
04Multi-Camera Editing
05Keyframe Path Curve
06AI Face Mosaic
07AI Video Enhancer
08Video Denoise
09AI Color Palette
10AI Voice Enhancer
11AI Translation- Lip Sync
12AI Portrait Cutout
13AI Sound Effect Generator
14Magnetic Timeline
15Advanced Compression
16Smart Scene Cut
17Smart Short Clips

Here's what's new within the new version of Filmora 14:

Try it Free
For Win 7 or later(64-bit)
Try it Free
For macOS 10.14 or later
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Smart BGM Generation

Automatically generate appropriate background music based on your video's content and mood. The AI analyzes your footage and selects music that complements
the scenes, saving time on manual music selection and editing.

Filmora Copilot 2.0

An AI assistant that helps you with the video editing workflows, providing support for tasks like batch processing, resource finding, and effects application.

Planar Tracking

Using advanced 3D tracking technology, attach image, graphic, text, or video elements to flat surfaces in your footage, ensuring they follow the camera's natural
movements.

Multi-Camera Editing

Edit footage from multiple angles on a single timeline track. Easily switch between perspectives during editing for smoother transitions.

Keyframe Path Curve

Design and control complex motion paths for video and animation elements through keyframe editing, creating smoother and more dynamic animations.

AI Face Mosaic

Automatically detects and blurs faces in your videos with precise tracking of facial movements.

AI Video Enhancer

Enhance quality in low-resolution or blurred-focus footage by restoring detail, texture, and improving overall clarity with cloud-based AI algorithms.

Video Denoise

Reduce grain and image noise in videos shot in low-light or high ISO, with adjustable intensity for optimal quality.

AI Color Palette

Replicate the color schemes of reference images or videos, instantly giving your video a cinematic look, while also ensuring the natural rendering of skin tones
colors.

AI Voice Enhancer

Enhance voice recording quality by reducing background noise and improving clarity for a professional sound.

AI Translation- Lip Sync

An easy-to-use translation feature, now with lip sync for natural-looking translations in single-person videos.

AI Portrait Cutout

Cut out your subject from the background with improved keying functionality that handles finer details like hair strands, for cleaner, more precise separations.

AI Sound Effect Generator

Create custom sound effects with text prompts. Describe the sound, and AI will generate it for you.

Magnetic Timeline

Automatically snap track clips and link secondary track clips to improve your editing workflow.

Advanced Compression

Significantly reduce video file sizes while preserving high visual quality. Optimize video files for sharing and storage.

Smart Scene Cut

Analyze faces, bodies, and content to automatically identify and clip notable moments in your video featuring people and tagged objects with the power of AI. This
allows you to quickly compile highlights or trim away less engaging parts with efficiency.

Smart Short Clips

Automatically split longer videos into multiple short clips ideal for social media. The AI identifies key moments based on speech and visual content, then recomposes
these highlights intelligently into vertical videos with background music, dynamic subtitles, and templates.

Previous Releases of Filmora

Version History | What's New in Filmora

2.2	The Full User Guide of Filmora

Welcome to Wondershare Filmora's Guide! Let's learn step-by-step how to use every feature in Filmora, regardless of your skill level.
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An Overview of Filmora's User Guide

01Preparations Before Editing
02Starting by Creating Projects
03Importing and Recording
04Video Editing
05Audio Editing
06Text Editing
07Video Customizations
08Export & Share & Backup

🔥Get Start With the Top Creators- Filmora Editing Skills For Beginners🔥

Download the latest version of Filmora to explore the latest features:

Try It Free
For Win 7 or later(64-bit)
Try It Free
For macOS 10.14 or later

1. Preparations Before Editing

Check the system requirements, compatibility, preferences, and performance settings, and navigate the interface of Wondershare Filmora.

Account and Subscription
Get Started and Basic Settings
Compatibility and Tech Specs
Performance Settings

2. Starting by Creating Projects

Know how to create, move, relocate, and open projects in Wondershare Filmora in any case.

Creating New Projects

3. Importing and Recording

Know how to import videos from different sources, whether from local drives, cameras, phones, or third-party drives. Also, know how to record PC screens.

Importing
Recording

4. Video Editing

Know how to steps for each video editing feature. You can find basic video skills like trimming, rotating, cropping, etc in the basic column; navigate keyframes,
video masks, speedramping, etc in the advanced; and AI-powered video editing features like AI portrait, AI smart cutout, video object remover, etc.

Basic Video Editing
Advanced Video Editing
AI-Powered Video Editing

5. Audio Editing

In this part, you will learn all audio editing features, from basic audio fading to advanced audio mixer or AI-powered audio editing skills, which help improve editing
efficiency. You can generate your own background music, perform voice cloning, voice changer, etc.

Basic Audio Editing
Advanced Audio Editing
AI-Powered Audio Editing

6. Text Editing

If you want to know how to add, edit, and animate texts, you will find all solutions here.

Basic Text Editing
Advanced Text Editing
AI-Powered Text Editing

7. Video Customizations

You will find all video effects, audio effects, transitions, stickers, filters, color editing, animations, and templates in this section.

Video Effects
Audio Effects
Transitions
Stickers
Filters
Color Editing
Animations
Templates

8. Export & Share & Cloud Backup

Know how to export selected clips, the whole clip, burn DVDs, and upload them to other social media platforms.
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Export & Share
Cloud Backup

In addition to desktop software, we also provide Wondershare Filmora for different devices. You can try Filmora for smartphone and pad.

Click the button below to get the Filmora on your mobile device! Now, get started with the full mobile user guide!

Try Filmora for Smartphones

 

Try Filmora for Tablets

 

Note:

Filmora is now compatible with both Android and iOS systems. The cross-platform plan allows you to use Filmora on multiple devices with the same account by one
individual. From video recording to editing and sharing, Filmora is with you all the way, improving every step of your creative journey.

Get creative with Filmora's free trial right now!

2.3	Windows Panel Layout

Wondershare Filmora is now equipped with four types of panel layouts and even more layout models to unleash your creativity. Read more to learn what's new and
changed with Filmora's latest version on Windows.

Index

01What's New
02Property Panel
03Player Panel
04Media Panel
05Timeline Panel
06Layout Modes
07Resizing Panel Groups
08Action Cam Editing
09Dark & Light Mode
10Custom Toolbar
11Project Settings
12Set Preference

1. What's New

Filmora 12/13/14 is now equipped with a new addition to its layout called the Property Panel.
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2. Property Panel

The Property Panel shows you all relevant information on your project to display your clip's video, audio, color, and speed properties in the Timeline Panel or
Preview Window. This makes all the info readily available so you can make adjustments when editing on the spot.

3. Player Panel/Preview Window

The Player Panel (Preview Window) shows you how the video plays in the Timeline. This is where you can adjust different settings, such as:

• Playback quality and display settings

• Capture a snapshot of the video

• Mark in and Mark out

The Player Panel can also be used as an independent panel or replaced with the default position by simply dragging the panel.

  

 9/641

  

 



Note:

Underneath the time code is the Snapshot button. Snapshot lets you take a full-resolution still frame and automatically saves the picture to your Media Library as an
image.

4. Media Panel

Also called your "Media Library," the Media Panel will display all your imported source files when creating a project.

Here is a brief introduction to the functions:
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• Media: Where your media files are imported.

• Stock Media: Choose royalty-free stock media from GIPHY/Pixabay/Unsplash.

• Audio: Explore Filmora's audio files.

• Titles: Choose between available preset titles to use on your video.

• Transitions: Make your project eye-catching by using different Transitions.

• Effects: Choose eye-popping effects for your video.

• Stickers: Add elements to your projects like Stickers.

• Templates: Allows you to split screen videos with preset Templates.

5. Timeline Panel

The Timeline Panel is where you unleash your creativity by assembling your media files and adding effects to your video project. This is where you can perform
various actions such as:

• Delete video clips, audio, transitions, elements, etc.

• Split your video clips or audio files.

• Edit your media file's parameters.

• Render your video for a preview.

• Add marker.

• Record voiceover.

• Mix audio and more.

6. Layout Modes

There are six layout models to choose from when editing your projects. You can choose between:

• Default: This will help you back to the original layout panel.

• Organize: The media panel will be extended to the bottom line in this mode.

• Edit: The property panel will be extended to the bottom line in this mode.

• Short Video: Best suit creators who intend to upload a short-form vertical video.

• Classic: for people who like the way it looked with the original version of Filmora.

• Dual: This mode works best for people who are accustomed to multiple monitors.

7. Resizing Panel Groups

If you want to resize any of the panels, drag the resizing icon at the borders between each panel to adjust to your preferred fit.
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Method 1: To resize panels horizontally, position the pointer on the sides until the pointer becomes a left and right arrow.

Method 2: To resize the panels vertically, position the pointer underneath the panels, and then the pointer becomes an up-and-down arrow.

8. Action Cam Editing

Filmora also has a number of features tailored to GoPro and action cam footage and an Instant Cutter to trim the clip without losing any quality. Please visit the Lens
Correction guide to learn more.

9. Dark & Light Mode

To toggle between Light and Dark modes, go to File > Preferences > General and choose Light Mode or Dark Mode under Appearance. Click Ok to save the
change.

This is what the light mode looks like:
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Note:

The skin color of the program will be consistent with your operating system if you choose System Default during setup.

10. Custom Toolbar

Filmora's editing interface is accessible, and with its custom toolbar located upfront, users can find all the major features like "Effects," "Stickers," "Transitions,"
"Titles," and more in the primary window. In this guide, users will learn how they can access Filmora's custom toolbar:

Step 1: Create a New Project

First, download Wondershare Filmora and launch it on your device. Once you reach its main display after the launch, click the "New Project" tab in its main display
window.
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Step 2: Access Custom Toolbar

Once you are in Filmora's main editing window, navigate upwards and locate a bar where you can find "Media", "Stock Media", "Effects", and other tabs. This is
named Filmora's custom toolbar, and each tab has unique features.

11. Project Settings

If you want to adjust the basic parameters before editing videos. You can view the top and find File-Project Settings.
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Project settings include aspect ratio, resolution, and frame rate. You can adjust the parameters you want.

12. Set Preference

Learn how to get the most out of Filmora by configuring preference settings for several things from appearance to folders, editing, and more.

You can customize the look and behavior of Filmora, from determining the default length of transitions to setting the brightness of the user interface.
Most of these preferences remain in effect until you change them. The preferences you set for scratch disks, however, are saved with your projects.
Whenever you open a project, it automatically defaults to the scratch disks you selected for it when you set up that project.
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set preferences

You can set up General, Folders, Editing, Save, and Performance as you want. When you finish setting, click ok to apply.
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2.4	Media for Use

Easy start with Filmora media for use to make a creative video. You can also save your video materials and templates on the cloud and exchange them with other
creators.

Index

01Stock Media
02Project Media
03Global Media
04Cloud Media
05Influence Kit
06Adjustment Layers
07Compound clip
08Relink Media
09Filter and View Options

Stock Media

Project media refers to the media files you used for your videos, including your resources, AI image, library.

Stock Media

Find the Mine tab at the top, where there are two categories: Favorites, Downloads.

Favorites

Click Favorite while hovering over a resource to add an tem to this folder.

Downloads

The media downloaded from Filmora will be displayed here.

AI Image

You can use AI image generation to create the pictures you need.

Library

You can editing background materials here.

Project Media

You can import media files here.

● Right-click on Project Media, you can add a new folder.
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● Right-click on Folder; you can rename and add a new folder.

Global Media

Import media here to use it in multiple projects.

● Right-click on Global Media, you can add a new folder.

● Right-click on Folder; you can rename, delete and add a new folder.

Cloud Media

Import media here to use it in multiple projects.

● My Cloud Media: You can drop or upload your video clips, images, or audio here to save them to your Cloud for backup.

● Downloads: The media downloaded from your Cloud will be displayed here.

Influence Kit

This tool can help you create opening and ending credits for your videos.

Adjustment Layer

Preset

Drag or click + icon to add the adjustment layer to the timeline. You can apply different effects, change the settings and edit again at any time without affecting
the original clips.

Custom

After you have adjusted the settings, click Save as Custom, and your custom adjustment layer will be shown here. For multiple variable object uses, you can use the
layer directly.

Compound Clip

It is a versatile tool that allows you to group a collection of video clips, audio clips, and graphics as a single bundle.

You can Import Clips and Place in the Timeline Panel and Create a Compound Clip.

You can click to learn more about Compound Clip

Relink Media

● Right-click the media file that you import in Project Media, choose Relink Media, you can replace a new media.

● If the selected file and the clip you used in the project have different durations, they cannot be relinked. Please reselect a file with the same duration to avoid issues.

Filter and View Options

● Filter by File Type
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Filter by File Type

On the right side of the Search Media bar, there are four filters here: All, Video, Audio, and Image

● View Options

View Options

You can view by:

Large Thumbnail View
Medium Thumbnail View
Small Thumbnail View

Your media files can be sorted by:

Name
Duration
Type
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Date Created
Ascending
Descending

Your media files can be grouped by:

None
Type
Date Created
Camera Name
Duration
Ascending
Descending

2.5	Preview Render Files

Preview rendering reduces the preview lag which can occur when editing complex or high-resolution projects.

This results in smoother playback. Filmora offers 2 ways to render your timeline preview:

Index

01Manual Render (Render Preview)
02Auto-Render

Manual Render (Render Preview)

Click the Render Button to begin rendering your timeline whenever this red line appears (as when you add media or make other changes to your timeline).

The render preview window will pop up, showing the render progress and the estimated remaining time.
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Once the rendering is complete, the red line will turn green.

Note:

You will need to wait until the rendering process is finished to continue editing.

Auto-Render

Besides manually clicking the Render Button, you can also use a feature called Background Render. If you enable it, your videos will be rendered automatically
when you add your videos to the timeline for editing.

You can go to File-Preferences-Performance, set a starting time, and enable it.

By default, the render process will be performed after 5 seconds of inactivity on the timeline.

Click OK to save your settings.

Note:

The rendered parts of your timeline will be indicated by a green line. The line will be red for the un-rendered parts. Once you change, modify, or add effects to the
rendered section you’ll notice the line turning red to indicate you need to render again.

2.6	Change Playback Quality

You can adjust the playback quality of the Preview window for a smoother editing experience. For example, you can improve the performance of your preview by
playing your video at a lower resolution than you want for your finished project or by creating proxy media files to edit with.

Note:
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Proxy files are more manageable versions of your clips that are easier to edit because they are smaller in terms of data (i.e. they are at a lower resolution). You can
edit with a proxy file in Filmora, then export with your full-sized original clip.

If Filmora detects lags, it will prompt a message to ask you to lower playback quality.

Reducing your playback quality can eliminate lags and save you time. Click the playback quality control menu, and then choose from these options:

Full: preview your video without changing the original resolution
1/2: preview your video at 1/2 the original resolution
1/4: preview your video at 1/4 the original resolution

Note:

The reduced playback resolution only applies to the video preview and will not affect the export settings.
Bonus: Want to learn more? Let's get started >> How to reverse playback with Filmora

2.7	Release Notes

Find more helpful resources about recent Filmora updates.

Index

01Overview
02Latest Version
03System Requirements
04Online Resources
05Contact Us

Overview

Filmora is an intuitive video editor for every skill level, available on Mac, and Windows. It provides one platform to push your storytelling boundaries and features a
host of tools that help you quickly create videos efficiently so that you can easily tell your stories. You can access tutorials, tools, and a platform to make even better
videos to share with our built-in community.

Latest Version

The latest/most current version of Filmora is the Octuber release. For more information, see below:
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● Latest Versions and Features: V14

● What's New Overview

System Requirements

● For the latest system requirements, see Tech Specs.

Online Resources

● Watch the video tutorial for how to use Filmora: Video Tutorial

● Enhance your mastery of advanced video editing skills: Master Class

● Find out how to create a special effect: DIY Special Effects

● All the information you need to help you use Filmora: FAQs

Contact Us

● For assistance with product usage, sales, registration, and troubleshooting, see Contact Us.

2.8	Keyboard Shortcuts List
Use this handy list to reference keyboard shortcuts for Filmora and even print a PDF of the keyboard shortcuts. You can also use the visual keyboard layout to
customize the shortcuts and assign multiple shortcuts to a command.

Index

01Keyboard Shortcuts List (Windows)
02How to Set Up Shortcuts?

Keyboard Shortcuts List (Windows)

Here is a list of the default keyboard shortcuts supported by Filmora. You can configure via File > Keyboard Shortcuts. Learning a few of these shortcuts can save
you a bunch of time!

If you want to check out the keyboard shortcuts on Mac, check here to start.

File

Action Windows Shortcut
New Project Ctrl+N
Open Project Ctrl+O
Save Project Ctrl+S

Save Project As Ctrl+Shift+S
Archive Project Ctrl+Shift+A

Import Media Files Ctrl+I
Record Voice-Over Alt+R

Preferences Ctrl+Shift+,
Exit Alt+F4

Add a New Folder Ctrl+Alt+N

Edit

Action Windows Shortcut
Undo Ctrl+Z
Redo Ctrl+Y
Cut Ctrl+X

Copy Ctrl+C
Paste Ctrl+V
Delete Del

Ripple Delete Shift+Del
Close Gap Alt+Del
Select All Ctrl+A

Copy Effects Ctrl+Alt+C
Paste Effects Ctrl+Alt+V

Duplicate Ctrl+D
Select Clip Range X

Cancel the selected range Shift+X
Nudge Left Alt+Left

Nudge Right Alt+Right
Nudge Up Alt+Up

Nudge Down Alt+Down

Tools
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Action Windows Shortcut
Edit Properties Alt+E

Split Ctrl+B
Trim Start to Playhead Alt+[
Trim End to Playhead Alt+]

Crop and Zoom Alt+C
RotAlte 90 CW Ctrl+Alt+Right

RotAlte 90 CCW Ctrl+Alt+Left
Group Ctrl+G

UnGroup Ctrl+Alt+G
Uniform Speed Ctrl+R

Add Freeze Frame Alt+F
Detach Audio Ctrl+Alt+D

Mute Ctrl+Shift+M
StabilizAltion Alt+S

Color Correction Ctrl+Shift+C
Chroma Key Ctrl+Shift+G
Red Marker Alt+1

Orange Marker Alt+2
Yellow Marker Alt+3
Green Marker Alt+4
Cyan Marker Alt+5
Blue Marker Alt+6

Purple Marker Alt+7
Grey Marker Alt+8

Select All Clips With Same Color Mark Alt+Shift+`
Render Preview Enter
Add keyframe Alt+Left Click

Previous Keyframe [
Next Keyframe ]

Motion Tracking Alt +X
Color Match Alt +M

Keyboard Shortcuts Ctrl+ Alt +K
Insert Shift+I

Overwrite Shift+O
Replace Alt+Mouse Drag
Rename F2

Reveal In Explorer Ctrl+Shift+R
Apply Alt +A

Add To Favourite Shift+F
Keyframing Alt+K
Crop to Fit Ctrl+F

Add Audio/Video Keyframe Alt+Left Click
Select Mode V

Open AudioRemix Mode S
Close AudioRemix Mode Shift+S

View

Action Windows Shortcut
Play/Pause Space

Stop Ctrl+/
Full Screen/Restore Alt+Enter

Previous Frame Left
Snapshot Ctrl+Alt+S

Previous Frame/Move Left Left
Next Frame /Move Right Right

Previous Edit Point/Move Up Up
Next Edit Point/Move Down Down

Go To Previous Second Shift+Left
Go To Next Second Shift+Right

Go To Previous Marker Shft+Up
Go To Next Marker Shift+Down

Go To Project Beginning Home
Go To Project End End

Go To Selected Clip Start Shift+Home
Go To Selected Clip End Shift+End

Zoom In Ctr+=
Zoom Out Ctrl+-

Zoom To Fit Timeline Shift+Z
Select Previous Ctrl+Left
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Action Windows Shortcut
Select Next Ctrl+Right
View Left Alt+Scroll Up

View Right Alt+Scroll Down
View Up Scroll Up

View Down Scroll Down

Maker

Action Windows Shortcut
Mark In I

Mark Out O
Clear In And Out Ctrl+Shft+X

Add Marker M
Edit Marker Shift+M

Miscellaneous

Action Windows Shortcut
Help F1

Export Ctrl+E

How to Set Up Shortcuts?

Many commands have keyboard shortcut equivalents to complete tasks with minimal mouse use. You can also create or edit keyboard shortcuts.

Go to File > Keyboard Shortcuts to see a list of available shortcuts.

Set Up Shortcuts

Note:

Click on any shortcut to change it. You won’t be able to change it to anything already in use. Click Okay when you’re done to save your changes. You can restore the
default shortcuts at any time by clicking Restore Defaults.

Switch to other shortcut presets

Go to File > Keyboard Shortcuts to change your shortcut presets from Final Cut Pro X or Premiere Pro.
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2.9	Register | Update | Uninstall

The latest and greatest version of Filmora Video Editor for Windows and Mac can be downloaded from the official website's top navigation bar.

Index

01Download & Install
02Register
03Update
04Uninstall

1. Download & Install

If you don't have Filmora yet, click the button below to download it. Choose Windows or Mac depending on your OS, and then follow the instructions to finish the
installation process.

Download to try now:

Free Download
For Win 7 or later(64-bit)
Free Download
For macOS 10.14 or later

2. Register

❶ Install and open the program. Click the Login button in the upper right corner.
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Login Filmora

❷ Log in with your Wondershare ID (the email you used to place the order) and your password in the pop-up login panel. Find your Wondershare account and
password in the confirmation email you receive after the purchase. You can also sign up and log in with Facebook, Google+, or Twitter.

Log in with Wondershare ID

❸ For creating an account, you can read this guide to learn how to create a Wondershare ID.
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Create a Wondershare ID

Note:

You can use Filmora without logging in, but any videos you export will have a watermark on them unless you are logged into a Wondershare ID that has a paid
license associated with it.

❹ Once you log in successfully, click the Avatar icon and check your activation status.

Check Your Activation Status

3. Update

There are two ways to keep Wondershare Filmora up to date: check automatically for updates or check for updates manually. Follow the steps below to check for
updates automatically:

Check for Updates Automatically

Choose Preferences under File in the top menu. Select the frequency of update checks you want in the Check for updates automatically menu: Every day, Every
week, depending on your preferences.
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Check for Updates Automatically

If there is an update, a Live Update window will pop up when you open Filmora. Select Update Now to download the latest version of Filmora.

Note:

After downloading the Update, click YES to close the program and install the new version. You can also click Cancel to install it the next time you open Filmora.

Check for Updates Manually

If you don't want to be prompted to update, set the Check for updates menu to Never first, then select Check for Update on the Help menu to check if a new version
of Filmora is available.
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Check for Updates Manually

Tips:

Please save your project manually before updating Filmora to ensure you never lose your work.

4. Uninstall

Method 1

Right-click Filmora icon, click Open File Location and double-click unins000.exe to uninstall.

Open File Location
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Uninstall

Method 2

To remove Filmora from your system, go to Control Panel> Programs> Uninstall a program, right-click the Filmora icon and select Uninstall. Once the "Are you
sure you want to remove Wondershare Filmora 11 completely and all of its components?" window pops up, click on Yes to continue the uninstallation.

Uninstall a program

Select Uninstall

2.10	Marked Favorites for Windows

Wondershare Filmora has already allowed users to mark their favorite effects, templates, and stickers. However, the new upgrade has improved the system, and now
users can do much more than add graphics to favorites. To know more about this functionality and how to access it, keep reading this guide:

Customizing Marked Favorites

With the addition of tags, users can now customize their favorite stickers in different categories, and given below is a detailed overview of how to do it:

Step 1: Initiate a New Project in Filmora

Following a successful download of Filmora, login to your account and, navigate towards the left panel, click the "Create Project" option. From the options
appearing on the main screen, click "New Project".
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Create a new project to start

Step 2: Add a Graphic Element to Favorites

Now, pick a graphic you want to add, which can be an effect, sticker, music, or anything. Once you select the graphic tab, go to the elements below and mark your
favorites by clicking the "Star" icon.

Select a graphic option from toolbar

Step 3: Go to the Marked Favorites

While staying in the same graphic tab, navigate towards the "Mine" category on the left side and expand it. From the given options, select "Favorites" and hover
towards one of the marked favorites.
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Access the favorites option

Step 4: Assign Tags to Marked Favorites

Afterward, right-click on this favorite, and from the options, choose "Add Tag", and you'll see multiple options there. You can categorize your favorite elements in
two tags named "Recently Used" and "Commonly Used". These categories will be displayed at the top of the favorites section.

Add a tag from given categories

Step 5: Customizing a Tag

Furthermore, you can add a personal category by selecting "New Tag". Once you click the "New Tag" option, a pop-up will appear where you can customize the
name for your tag and click "OK" to proceed. You will be able to access or see the new tag at the top of the favorites section with other tag categories. From there, if
you want to create a new tag, you can do it by clicking the "+" option.
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Name a new tag

Step 6: Delete or Rename a Tag

If you are unsatisfied with the name of the tag or want to remove it, choose the "Manage Tag" option. A small manage tags window will appear; go to the tag's name,
click on the "Three Dots" icon, and rename or delete it. This method allows you to customize a tag or add your marked favorites to a tab.

Delete a tag and press close

3.1	Windows System Compatibility Detection

You may need to update your graphics drivers to run Filmora. Please keep your computer's graphics drivers updated to get the best performance out of your
hardware.

Index

01Filmora for Win System Requirements
02Supported Input Formats
03Supported Output Formats
04Supported Effects & Plug-ins

Filmora for Windows System Requirements

Operating System

Supported: Windows 7 / Windows 8.1 / Windows 10 / Windows 11
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Note: 64-bit OS only

Processor

Minimum: Intel i3 or better, multicore processor, 2GHz or above
Recommended: Intel 6th Gen or newer (ideal for HD and 4K video editing)

Memory (RAM)

Minimum: 8 GB
Recommended: 16 GB (required for HD and 4K projects)

Graphics

Supported:Intel HD Graphics 5000 or later; NVIDIA GeForce GTX 700 series or later; AMD Radeon R5 series or later
VRAM: Minimum 2 GB (4 GB recommended for HD and 4K editing)

Storage

At least 10 GB of free disk space for installation
SSD (Solid State Drive) recommended for editing high-resolution videos

Internet Connection

Required for software registration and access to online features such as Filmstock.

See the trailer below to get what's new in Wondershare Filmora 14:

For the product version for Smartphones and Tablet, try Filmora for the different devices below:

Try Filmora for Smartphone

 

Try Filmora for Tablet

Supported Input Formats

Type Container formats

Video Formats

MPEG-1/2 Video file: (.mpg, .mpeg, .m1v, .m2v)

MPEG-4 Video file: (.mp4, .m4v, .3gp, .3g2, .3gp2)

QuickTime Movie File: (.mov encoded with MPEG 4 or MJPEG codec only)

Camcorder File: (.dv, .mod, .tod, .mts, .m2ts, .m2t)

Flash Video: (.flv, .f4v)

Audio Visual Interleave (.avi)

Matroska Video File: (.mkv encoded with MPEG 4 or MJPEG codec only)

HTML5 Video File: (.mp4, .webm,. ogv)

Non-encrypted DVD Titles: (.vob, .vro)

Audio Formats .mp3, .m4a, .wav, .wma, .ogg, .flac, .aif, .aiff, .caf, .au

Photo Formats .jpg, .png, .bmp, .gif, .tif, .tiff

Supported Output Formats

Type Container formats or Device/SNS profiles

Format .mov, .mp4, .m4v, .mkv, .avi, .f4v, .ts, .mpg, .3gp, ProRes, .m4a, .mp3, .gif
4k:	.mov, .mp4, .m4v, .mkv,

Devices iPhone, iPad, Apple TV, Apple TV 4K, iPods, Apple Generic, Android Generic, PlayStation, PSP

Social Network YouTube, Vimeo

DVD DVD disc, DVD folder, ISO disc image file

Note:

Some of the above codec formats may need to be supported by the system.

Supported Effects & Plug-ins

Effects & Plug-ins
Filmstock Standard
NewBlue FX (Not available on Mac with M1 chip)
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Effects & Plug-ins
Boris FX (Not available on macOS v10.14 and Mac with M1 chip)
AI Portrait

3.2	Fixed Bugs

Find fixed bugs in the latest release of Filmora.

Index

01Fixed Issues

Fixed Issues

Note:

Last update on Dec 04, 2024
These are the issues we fixed in recent Filmora release.

Fixed Issues in Filmora 14.0.5

Fix the issue where adjusting the 4K setting on the audio equalizer has no effect.

Fixed Issues in Filmora 14.0.10

Solve the problem where custom titles are lost after updating to Filmora V13.4.6.7442.
Solve the problem where all videos generated by AI short clips display a black screen.

Fixed Issues in Filmora 14.1.0

Has fixed the issue where the Y parameter would not change after adding a keyframe to the corner pin effect

Fixed Issues in Filmora 14.1.5

Solved the issue where the project could not be opened when using Filmora Win V13.6.13.
Resolve the issue caused by upgrading and installing V14.
Solve the problem where the hotkey for silent detection 'visible' is displayed as (J), but pressing it does not trigger the corresponding function.

Fixed Issues in Filmora 14.2.5

Fix the problem of software crashes when running Smart Scene Cut.
Fix the issue where adding a shape and filling it with screen color doesn't work.

4.1	What is Proxy Video Editing
Once all the video clips you'd like to use in your next video are transferred from the camera to a computer and organized properly, you can start thinking about the
most efficient way of piecing them together.

That's where the creation of proxy files comes in, as you don't have to work with the original size RAW files. Instead, you can create proxies that are significantly
smaller than the video files your camera has captured and still export the video in the 4K or UHD resolution.

Index

01How Does a Proxy Work
02How to Create and Use Proxy in Filmora

How Does a Proxy Work

Proxy video editing is a great option if the computer you’re using for editing has a modest amount of RAM or if its processor is not powerful enough to
support the demanding tasks of applying complex visual effects.
Even though proxy files can shorten the amount of time you need to spend in the editing room, this video editing technique is only useful in a particular
context.

How to Create and Use Proxy in Filmora

Video content creators who often shoot their videos with action cameras and other devices that can record video in 4K resolution can easily create proxy files in
Filmora.

Install the software and create a new project.
Head over to the File menu, and find Preferences option. Alternatively, you can use the shortcut “CTRL+SHIFT+,” to bring up the Preferences window and
then click on the Performance tab.
First, Click Enable GPU Acceleration and Hardware Acceleration. Run a GPU Check if can’t find the Graphics card you’re using.

  

 36/641

  

 



Project Settings

Scroll down and option and Automatically create proxies when media resolution is higher than: option in the Proxy menu, and pick either 1280x720p or
1920x1080p resolution.

Project Settings

You can also choose a folder on your computer's hard drive where all proxy media files are saved.
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In case you want to delete all proxy files you created after you've completed a project, you can enable the Automatically delete proxies when a project is closed
option and then click on the OK button.
Go to the Media Panel to start importing media files you'd like to use in your project and Filmora will automatically create proxies for each file that has a
resolution that is higher than the resolution you've specified earlier.

Note:

Filmora is going to need to create proxy files depends on the size of source files and the number of files you are transcoding at the same time.

4.2	HDR

The HDR (Highly Dynamic Range) function mainly targets semi-professionals or professionals whose devices support HDR. HDR materials shot by users or
obtained from other channels can be edited, previewed, and exported in Filmora.

Index

01Key Functional Features
02Color Space Setting
03Export Color Space
04Functional Limitations and Reminders

Key Functional Features

HDR displays a more comprehensive range of brightness from the darkest to the brightest. In addition, it accommodates more brightness, shadow detail, and
saturation for a more natural and realistic display without compromising tones in bright or dark areas.

Note:

You can switch to HDR export when the current device meets the GPU acceleration conditions.

Color Space Setting

Project Settings

You can select the preferred HDR option value in the Color Space drop-down menu by clicking File > Project Settings. The default value is SDR - Rec.709.

Project Settings

Export Color Space Option
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• You can change Export Color Space to the export settings page: SDR - Rec.709、HDR - Rec.2100HLG、HDR - Rec.2100PQ. You can switch to HDR
export when the current device meets the GPU acceleration conditions.

Export Color Space

Tips:

The MP3 format export page of Filmora for Windows does not have this setting. The MP3/M4A format of Filmora for Mac does not have this setting.

Export Color Space

On the Export interface, click SETTINGS. When the Export Color Space is always on, the current device has enabled GPU acceleration (GPU acceleration in the
preferences).

If the Export Color Space option displays in gray, GPU acceleration is not available on the current device (GPU acceleration in the preferences). If either of these two
conditions is not met, the option displays in gray, and the option value is the default when the option displays in gray (SDR - Rec.709).
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Export Color Space Settings

Functional Limitations and Reminders

Timeline Rendering

After rendering in HDR state, the player preview video clarity will be reduced.

GPU Support

Enable GPU acceleration for preview, rendering, and export. Filmora has a corresponding pop-up reminder on it. After the GPU settings for Windows are
adjusted, please restart to take effect.

Export Speed

The export speed of HDR video is about 4 times slower than that of SDR video.

Device Support

The preview function of HDR is limited to the case that the device supports and HDR is on. If your device does not support or does not turn on HDR, Filmora
will prompt a pop-up window.

4.3	GPU Driver Requirements and GPU Accelerated Rendering
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1. GPU Driver Requirements

To get the best video editing experience with Filmora for Win, it is recommended to make sure your GPU meets the below requirements:

Processor: Intel i3 or better multicore processor, 2GHz or above (Intel 6th Gen or newer CPU recommended for HD and 4K Videos).
Operating System: Windows 11/Windows 10/Windows 8.1/Windows 7 (64-bit OS).
RAM: 8 GB RAM (16 GB required for HD and 4K videos)
GPU: 2GB GPU Memory

Also, keep your Win system updated to ensure your GPU Driver is up-to-date.
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2. GPU Accelerated Rendering

This guide provides insight into GPU Accelerated and Hardware Decoding/Encoding in Filmora and Filmora Media Encoder.

GPU Acceleration reduces the stress that video editing software applies to the CPU and improves the speed and efficiency of this software.

Enabling GPU acceleration for video rendering, and playback saves you from waiting and improves the playback quality.

How to enable GPU Acceleration in Filmora for Win?

❶ Click File > Preference

❷ Choose the Performance Tab

❸ Under the GPU section, check the boxes in front of "Enable Hardware Acceleration for video rendering and playback".

❹ If you would also like to enable hardware acceleration for video decoding, you can also check the box in front of it.

GPU acceleration

5.1	Startup Window for Windows

Get to know the new startup window. The new startup window is more informative and intuitive as it is redesigned to be more user-friendly. It allows you to have a
better understanding of the software’s features and what they can do for you to create amazing videos.

Index

01Create Projects
02Filmora Cloud
03Creator Hub
04AI Toolbox

You select the function you need by clicking the corresponding tab based on your operational purpose.
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startup window interface

1 Create Projects > 2 Filmora Cloud > 3 Creator Hub > 4 AI Toolbox >

Note:

If you don't see this startup window, please upgrade to the latest version, and then go to File > Preferences > General tab to enable this startup window. It will show
when Filmora launches next time.

Create Projects

The Create Project tab contains a variety of features, along with your recent local projects changeable to list view or thumbnail view. The new Start-Up Window is
designed to help you get started with your project as quickly as possible. It contains all the tools you need for creating a video.
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1Use the drop-down menu to choose an aspect ratio.You can choose from a wide variety of aspect ratios by clicking on the appropriate option in this drop-down
menu.
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2To begin editing, click on Create Project and it will take you to the new user interface.

Filmora Cloud

Filmora Cloud is a great way to safely store your project documents, project templates, and finished videos. Get your FREE 1GB cloud storage in Filmora 13!
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1. Download and open Filmora.
2. Click “Filmora Cloud ” and then log into your account to activate the cloud.

Now you can enjoy Filmora Cloud and have your files securely backed up to Wondershare Drive. You can also use Filmora’s cloud storage for other purposes such as
sharing your projects with others, so they can view files with their device.

Creator Hub

Scale up your inner creative video editing skills with the help of Creator Hub. Creator Hub is a place where you can find tutorials and secret skills to inspire your
video editing. We've embedded YouTube's API so that you can search, save, and comment on creative training videos directly within Creators Academy. Creator Hub
is perfect for beginners and professionals alike. With a simple layout that makes it easy to learn how to edit videos, this software will help you create high-quality
footage quickly and easily. Videos directly within Creators Academy.
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AI Toolbox

The startup window has added shortcuts to screen tools, which you can select to use as desired.

a. You can start by choosing a template by using "Instant Mode" if you want your videos to look more engaging and creative.

b. Easily record your screen with "Screen Record" conveniently so you won’t have to record with other third-party apps.

c. Reframe a video quickly with Auto Reframe powered by AI technology that automatically detects the focal point of your video and crops it, always keeping it in
the frame like magic!

d. Smoothly cut out unwanted parts to trim your awesome videos with the built-in "Instant Cutter".

e. Automatically detect and remove silence with "Silence Detection", so you won't have to remove the silence from your video manually.

f. Effortlessly use "Auto Beat Sync" to synchronize your videos to the rhythm of the music of your choice.

g. Make proficient video scripts automatically with the help of the newly-introduced feature of AI Copywriting in Filmora. Simply access the “AI Copywriting”
button for auto-generating video content with a pre-integrated connection with ChatGPT.

5.2	Open Project
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Learn how to open Filmora projects for Windows.

Filmora for Windows can open project files created with earlier versions of Filmora.

Index

01Open an Existing Project in Startup Window
02Open an Existing Project in Editing Panel
03Open the uploaded project in Cloud

Open an Existing Project in Startup Window

When you launch Filmora, your most recent projects will be shown in the Project Files. Select the target project to reload the. wfp project file. If your project isn't
shown in the Project Files, click Open Project to locate it.

Open a project from the Project Files

Open an Existing Project in Editing Panel

Besides opening projects at the startup window, you can also open an existing project when editing. Click File > Open Project (Ctrl+O) or File > Open Recent to
locate the. wfp file.
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Open an Existing Project in Editing Panel

Open a project in Filmora Cloud

If you back up your project in the Wondershare Filmora Workspace, you can find your uploaded project from the Filmora Cloud in Startup Window.
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Open the uploaded project in Cloud

5.3	Move Projects

Learn how to move and archive Filmora projects.

If you need to edit your project on another computer, open the project, click File > Archive Project or use the hotkey Shift+Ctrl+A, then the project file and the
source files will be archived together in the archived. wfp file.
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Move Project

You can copy or transfer that archived project in. wfp format to another computer and continue your editing.

Note:

Please do not just move the saved project to another computer directly. You must click File > Archive Project to archive the project first.

5.4	Relocate Projects

Learn how to relocate Filmora projects.

Once you change the location of the source files, rename them, delete them, or disconnect the external drive where they are saved, Filmora will not be able to find
them anymore through the saved path.

Step 1

If you click the changed save location or deleted project file from Project File, the window will prompt you that project does not exist in the saved location.
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Find Deleted Files from Project File

Step 2

If you click a moved or missing project file from the source file save location, you will see a window of Locate missing files showing that "Some file(s) in your
project have been moved or are missing. Please select the file(s) from the list below and relocate them one by one."
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Locate Missing Files

Select Ignore/OK – You will skip to the player panel directly and a red exclamation mark will appear on the video.

Ignore Missing Files

Select LOCATE SELECTED - The source file save location window for project file storage will pop up. You can relocate the missing files.

Step 3

If you click the clip with red exclamation mark, the window will pop up displaying "Unable to locate file. Click RELOCATE to try importing the file again,
DELETE to delete it, or IGNORE to abort this operation."

Select Ignore – You will be back to player panel.
Select Delete - A window will pop up asking to confirm if you need to delete the clip.

Note:

If the files have been permanently deleted, you can choose other files as replacements.

Select Relocate - The source file save location window for project file storage will pop up. You can relocate the missing files.

5.5	Create New Project

Learn about project files, and how to create and manage projects in Filmora.

The project (. wfp format) you create in Filmora contains the settings you select for each sequence in the timeline, as well as editing decisions, effects, and music
used in the project.

Filmora project files don't store the source videos, audio, or images. They only save a reference to these types of media files based on the file names and locations. If
you move, rename, or delete a source file, Filmora won't be able to find it automatically the next time you open a project that uses that piece of media.

Note:

For your convenience, Filmora offers you the option of archiving your source files all together with the project.

Index

01Create A New Project
02Save A Project

Create A New Project

There are two ways to create a new project.

Method 1: Create New Project from Startup Window

Select the corresponding Aspect ratio at the top of the Startup Window according to the video scene requirements
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Create New Project from Startup Window

Method 2: Create New Project from Menu Bar

Launch Filmora and choose New Project to enter the editing interface. You can re-create a new project under File > Project Settings.

You can also set the resolution, aspect ratio, and frame rate for the project as you like under File > Project Settings.

Note:

The default aspect ratio is 16:9, but you can change it to 1:1 or 9:16 if you want to make videos for Instagram or other social media, or you can select Custom to
customize your aspect ratio.
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Create New Project from Menu Bar

Save A Project

After you finish your editing in the timeline, you can click File > Save Project or Save Project As, or use the hotkey Ctrl+S to save the edited project to your
computer, in case you need to modify it in the future.
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Save Project

Note:

The project will be saved as a file with the extension. wfp. And it can only be recognized and opened by Filmora.

5.6	Short Video Project

The short video project mode allows users to easily create videos by utilizing Auto Reframe and Smart Scene Cut. In the 9:16 ratio, it supports mask displays for
TikTok, YouTube Shorts, and Instagram Reels, helping users quickly adjust the layout for different platforms.

For a complete overview of this feature, explore the details in the guide:

Here is a step-by-step guide for you:

Step 1: Launch Filmora and choose a ratio of 9:16

After downloading Filmora, open the program and log in or sign up from the main menu. Next, click 9:16. Then, choose “Short Video Project.”
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choose a ratio of 9:16

Step 2: Access the short video project window

You can quickly use the Auto Reframe, Smart Cut Scene, and Social media mockup.
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access the short video project window

6.1	Importing

Wondershare Filmora enables you to import standard, HD, and even 4K videos. You can also record a video with Filmora using your computer's webcam or
recording your computer screen. You can even record a voiceover with Filmora.

Your media clips - including imported videos, images, and audio files will be shown in the Media Library, where you can access them quickly and easily.
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01Methods to Import Media Files into Filmora
02How To Make Image Sequence Into a Video
03How to Select Multiple Files at Once

Methods to Import Media Files into Filmora

There are 3 ways to import media files into Filmora.

Check the complete list of supported file formats here.

Method 1

Click File > Import Media. Choose Import Media Files, Import a Media Folder, Import from a Camera or a Phone, or Import with Auto Beat Sync.
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Import Media

There is also a click entry for Import in the bar next to Project Media.

Import Media from the bar

The Beat Sync operation window will pop up if you click Import with Auto Beat Sync. Click Import Media from the upper left corner.
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Import with Auto Beat Sync

You can click to learn more about Auto Beat Sync.

Method 2

With media selected in the menu bar, click on the first tab Project Media. Click the import media area as shown below, and then choose one or more media files
from the pop-up window.

Import from Project Media

Method 3

Drag and drop media files into the Media Library.
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When you import a media file, Filmora may ask you to create a proxy file to accelerate your editing process.

A proxy file is a second media file smaller than your original file. Usually, more timeline efficiency will be required when the video has a very high resolution.

Creating a proxy file can lower the video resolution in the editing to accelerate the whole editing process without affecting the final export quality.

Create A Proxy File

How To Make Image Sequence Into a Video

Import Image Sequence: Click "Import" to upload your JPEG/JPG images. Alternatively, you can drag and drop them into the media library. Select the first
image, check the "Import as image sequence" box, and click "Open." Make sure your images are in JPEG format and named in order.(e.g., image001.jpg,
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image002.jpg).

Add to Timeline: Drag the image sequence to the timeline. Right-click any image to adjust the duration if needed.

Export Your Video: Click "Export," choose your video format and frame rate, set the output location, and click "Export" to create your video.

Note:

We recommend selecting Yes to create proxy files for a faster video editing experience.
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How to Select Multiple Files at Once

Holding down the Ctrl key or the Shift key as you click a file.

Ctrl allows you to select multiple files anywhere on your file list, not necessarily next to each other.

Shift allows you to choose a group of files next to each other. Click one file, hold Shift and click the last file. All in-between files can be selected.

You only have to have the Ctrl or Shift key held down while clicking. Once you are finished selecting files, you can let go of the key, and the files you selected will
remain selected. Note: If you're using Filmora 9 or 10, click here to learn how to import media clips.

6.2	Import from Third-Party Cloud Drives

With the new release of Filmora V13, users can import video files from third-party cloud drives – Dropbox. The following are the detailed steps to use this new
feature.
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Open the Editing Panel

Run Filmora and click "New Project" to open the editing panel. Now go to "File" and then move your mouse to "Import Media".

Import From Other Apps

Then you'll see 6 options here, choose "Import from other Apps" and then click "Dropbox".

Import From Other Apps

Authorization Refreshing

A new "Authorization Refreshing" window will appear, and your browser will open the dropbox.com.
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Authorization Refreshing Filmora

Go the browser and now you'll be asked to sign in with your account, Type your account and password to move forward.

Type Account To Use Dropbox

If you don't have an account, you'll need to create an account with your Google or Apple account.

Sign Up With Google Apple

Click the "Allow" option to let Wondershare Filmora to view the video files in your Dropbox storage.
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Allow Filmora Use Dropbox

Download and Start Editing

Go back to the Filmora interface, it will show you all the files and folders in your Dropbox. Download the video and you can start editing.

Download Dropbox Video Filmora

7.1	Optimized Screen Recording for Windows

Filmora offers a comprehensive functionality for recording the screen of your device by offering multiple capturing options. You can record the entire screen or a
specific part of the screen using this efficient tool. Moreover, you can capture the screen with or without the camera and other settings.

The new update has introduced some real-time capturing functions, such as blurring or removing the background while recording. Learn how this screen recorder
works in the following section:
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01Entrances to Record in Filmora
02Steps to Record in Filmora

Entrances to Record in Filmora

Method 1:

Open Filmora video editing software, you can easily see "Screen Recorder" option in the startup window.
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Method 2

Enter the player panel, click "File" > "Record Media", and choose the record option you prefer from "Record from Webcam", "Record PC Screen", or "Record
Voiceover".

Method 3

On the Search Media bar below the menu bar, click "Record", and three record options will be expanded: Record from Webcam, Record PC Screen, and Record
Voiceover.

Steps to Record in Filmora

Step 1: Specify the Screen Resolution for Recording

After selecting the screen recorder from either of the above options, then comes the ratio of screen to record from. Under the "Square" icon, users can choose three
resolutions: "Full Screen", "Custom", and "Target Window". In addition, they can adjust the length and width values manually or manipulate the ratio appearing on
the screen.
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Step 2: Choose the Type of Recording

In Filmora, users can choose from three recording options on the screen recorder window. Users can use "Microphone" for what they are speaking during the
recording session. Moreover, they can turn on or off the "System Audio" or "Camera" option.

Step 3: Adjust Settings

After this, expand the "Settings" option at the bottom left corner of the recording window and customize the rest of the settings.

Step 4: Press the Record Button to Start Recording

Now press the red recorder button to start screen recording. A countdown will appear, but if you want to skip this part, simply press the "Start Directly" button
below the countdown. From the player given below the screen recording, you can "Pause", "Stop", and start "Re-record" with the screen recording.

Step 5. Change Camera Display Options

When you select the Camera option from the recording settings, a new window with the camera enabled will be opened. Hover over the camera preview to enable the
floating toolbar on the screen. You can choose your required option, like blurring the background or entirely removing the background. Once selected, press the Red
recording button to begin the screen recording with the camera.
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8.1	Split & Trim Video

To remove unwanted parts from the video, you can split or trim the clip. You can split a video into two separate clips, trim off the beginning and/or ends of a video
clip.

Note:

Trimming or splitting the media clip will not affect the original source media.

Index

01Split Video Clip
02Trim Video

Split Video Clip

Splits the selected clip. Position the Scrubber to where you want the clip to be split, and then click this button.

❶ Split Video with the Split Button in Timeline

Click the video in the timeline, drag the playhead to the position where you want to split, and click the split button on the playhead to create the split.
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Split Button

Note:

If you don’t select a specific track in your timeline, you will split all of the clips under your playhead. To split media in a single track, you need to select the track
first and then click the Split button.
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Split button setting

Note:

If you didn’t see the Split Button in the timeline, you can go to File -> Preferences -> Editing to show it.

❷ Split Video into Parts with the Split icon

Click the video in the timeline, and move the playhead to the position in the clip where you want to split it.
Click the scissors icon above the timeline to separate it into two clips.
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Split icon

❸ Split Video with the Split Option

Select the video and place the playhead at the position where you want to split the clip, right-click and choose Split from the context menu.
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Split Option

Note:

You can also split large videos based on scenes. For more details, check Scene Detection.

➍ Quick Split Mode

Import your video to the timeline, choose “Quick Split Mode” icon, and then click on the timeline to split your video.

Just choose the parts you want to split and then click the mouse to quickly split long clips with ease.
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Trim Video

You can use the trim feature to remove unwanted segments at the beginning or the ends of the video.

❶ Trim with Mark In and Out in Preview Window

In the Preview window, you can use the Mark In and Mark Out points to break down a video into multiple segments without importing it to the timeline first.

Double click the video in the Media Library to view it in the Preview window.
Use the player controls to find where you want the trimmed clip to begin, and then click the Mark In button when you get the frame of the video that you want
to use as the beginning point.
Click the Mark Out button to set the point that you want it to be the end frame.
Drag the clip from the Preview window to the timeline, the video segment you want to keep will be loaded in the timeline.
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Mark In and Mark Out

Note:

After you mark in and out points, you can always change your mind before you edit the clip into the timeline. Just drag the Mark In and Mark Out points to a new
position in the Preview window.

❷ Trim Video in Timeline

Select the video on the timeline you want to trim, hover your mouse over the left or right edge of the video until the trim tool shows.

Click and drag the edge of your clip forwards or backwards to trim off the unwanted portion.

Trim Video in Timeline

Note:

Filmora also has an option for you to quick trim from the start or end of a clip. Move the Playhead on the frame want to trim, and right click on it to select Trim
Start to Playhead or Trim End to Playhead under Trim context menu, depending on whether you want to delete what's behind the playhead or in front of it. If
you're using Filmora 9 or 10, click here to learn how to trim a video.

8.2	Crop & Pan & Zoom Video

You can crop the video to a specific aspect ratio so that only the area you selected appears when playback. Or, you can use the Pan & Zoom effect to make the
camera appear to zoom in or zoom out of the clip. For example, you can choose to start a video clip in full-frame view, then gradually zoom in to reveal a specific
subject in the video, then pan to reveal other subjects in the video.

Index
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01Crop Videos and Photos
02Pan & Zoom for Videos and Photos

Crop Videos and Photos

You can use the Crop tool to crop out unwanted portions of the video and customize the aspect ratio.

Step 1 Select the video in the timeline, and then click the Crop icon  to open the Crop and Zoom panel. Or you can right-click on the clip in the timeline,
and select the Crop and Zoom option from the Video context menu to enter the Crop and Zoom panel.

Find the crop and zoom tab

Step 2 In the Crop and Zoom panel, set up the ratio of the crop area by choosing the ratio presets:
16:9: set the crop area at 16:9 aspect ratio, for example, the standard aspect ratio for YouTube on a computer.
4:3: set the crop area at 4:3 aspect ratio, which is popular back in 80s and 90s.
9:16: set the crop area at 9:16 aspect ratio, namely a vertical video.
Custom: set up a customize aspect ratio using the Width and Height fields manually.
Other Ratio Options: 1:1, 3:4, 21:9, 4:5 and Original Ratio

Set up the ratio

Step 3 Drag the corner handles in the rectangle area to adjust the size and position of the crop area.
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Drag the corner handles

Step 4 Click Apply to save the setting and crop the video.

Crop options and customize the crop area

Pan & Zoom for Videos and Photos

A 'Pan' is when the camera moves between two subjects while filming and a 'Zoom' is when the camera either moves closer or farther to one part of the frame
through the use of a zoom lens.

For example, you can start showing a close-up of a subject in the video, and gradually zoom out to show the full scene.

Right-click on the video in the timeline and choose the Crop and Zoom option under the Video context menu.
Switch to the Pan and Zoom tab in Crop and Zoom panel. Two frames will appear over your footage: a green frame marked Start and a red frame marked End.
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There are 5 pan & zoom modes to choose from under the right corner, click one to apply quickly.
Zoom in mode: Zoom in from the larger green frame to the smaller red frame, i.e. from far to near. You may do this to get a close up on a character's face.
Zoom out mode: Zoom out from the smaller green frame to the larger red frame, i.e. from near to far. You may do this to reveal a larger scene.
Pan left mode: Move horizontally from the green frame on the left to the red frame on the right. You may do this to move between characters or follow a
moving subject.
Pan right mode: Move horizontally from the green frame on the right to the red frame on the left. You may do this to move between characters or follow a
moving subject.
Swap mode: Swap the start and end area.
Drag the handles in the Start frame rectangle area and the End frame rectangle area to resize until it is framed in the way you want.
Click the Apply button to apply the changes

When playing back, the clip is cropped at the beginning as set by the Start frame and zoomed in or out based on how the End frame is cropped. See how to pan and
zoom on Filmora X.

pan and zoom videos and photos

8.3	Change Video Playback Speed

You can change the playback speed of videos in several ways with Filmora. Speed up the video and play it at lightning speed to add comedy to the video, or slow
down the video to emphasize details. Changing the speed at various instances in a clip makes the video more engaging.
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Change Video Speed with Uniform Speed

Using the Uniform Speed feature, you can adjust the speed of the selected clip to the same rate.

Step 1 - Get to the Uniform Speed Panel

Here you have three ways to go to the Uniform Speed tab:

1 Double click on the video or audio clip that you want to change the speed. In the pop-up editing window, select Speed>Uniform Speed.

2 Right-click on the video or audio clip, go to Uniform Speed

3 Kindly tab on the Speed icon on the toolbar, then choose Uniform Speed.
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Uniform Speed

Step 2 - Change Video Speed to Constant Speed

Drag the Speed slider to the right or left to speed up or slow down the playback speed. Optionally, you can enter your preferred value in the Duration field to get a
more precise output.

Change Video Speed to Constant Speed

Speed: You can speed up or slow down the videos or audio by dragging the slider to the right or the left. The default speed is x1.

Duration: It will show the exact duration of the video. You can increase or decrease the duration by changing the values. Increasing the duration will make the video
speed slow down certainly.

Reverse: You can reverse the video or audio clip to make a funny effect.

Ripple: The Ripple Edit is a trim tool used to trim a clip and “ripple” the rest of the clips in the timeline.

Maintain pitch:It means keeping the original pitch of a sound the same, even if you change its speed or other aspects.

If you feel satisfied after the adjustments, you can click OK to save the settings. Otherwise, you can click on the Reset button to restore the previous settings.

Step 3 - Preview the Video and Save

Click the Play button in the Preview window or press the Spacebar to preview the modifications.

Preview the Video

Note:

It is recommended to enable Maintain Audio Pitch option to keep the video audio sound natural.

Modify Video Playback Speed with Speed Ramping

In addition to constant speed changes in Uniform Speed, you can create variable speed effects with Speed Ramping, where a clip's playback speed changes
dynamically. You can set up different playback speeds for each portion of the video.

❶ Step 1 - Go to the Speed Ramping Panel

Click the video in the timeline and click the Speed icon, select the Speed Ramping option, and then you will see a couple of options on the property panel:
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Speed Ramping Panel

None: Apply no speed ramping.

Customize: By default, five-speed points allow you to customize the speed exactly the way you want.

Montage:Six speed points in the playback speed of the selected video: 0.9x, 0.9x, 6.9x, 0.3x, 1.0x, and 1.0x, which present a slow, slow, fast, slow, and normal
rhythm.

Hero Moment: Eight-speed points in the playback speed of the selected video: 1.0x, 1.0x, 5.4x, 0.5x, 0.5x, 5.4x, 1.0x, and 1.0x, which present a normal, fast, slow,
slow, fast, and normal rhythm.

Bullet Time: Six-speed points in the playback speed of the selected video: 5.2x, 5.2x, 0.5x, 0.5x, 5.2x, and 5.2x, which present a fast, fast, slow, slow, fast, fast
rhythm.

Jumper: Five-speed points in the playback speed of the selected video: 0.6x, 0.6x, 6.0x, 0.6x, and 0.6x, which present a slow, slow, fast, slow, slow rhythm.

Flash in: Four-speed points in the playback speed of the selected video: 5.2x, 5.2x, 1x, and 1x, which present a fast, fast, normal, normal rhythm.

Flash out: Four-speed points in the playback speed of the selected video: 1x, 1x, 5.2x, and 5.2x, which present a normal, normal, fast, fast rhythm.

Speed Ramping Default Interface

❷ Step 2 - Select and Customize Speed Ramping Preset

Please select one of the presets to apply variable video speed and customize it based on your needs. Variation in the speed will remain effective until the Play head
reaches the next speed point. The speed of the video will gradually change as the Play head moves between the speed points.

Adjust the speed of the section: Drag the speed point up or down to increase or decrease the speed of the section.

Adjust the range of the section: Drag the speed point left or right to change the portion applying the speed.

Add speed point: Place the play head to the point you want to change the speed, and then click the Plus + icon on the left to add a speed point.

Delete speed point: Select the speed point and click the Plus – icon to remove it.

Add a freeze frame: Place the play head to the point you want to freeze, and then click the snow icon to add a freeze frame. Set up the freeze time and click Apply
to save.
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Add Speed Ramping Preset

Note:

You can also click the Customize option to set up the speed ramping from scratch.

❸ Step 3 - Preview the Video and Save

Press the Spacebar on your keyboard or click the Play button in the Preview window to preview the modifications in the video. You can click Reset to remove the
settings. Also, you can save the speed ramping setting by clicking the Save as a custom button.
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Save Speed Ramping Settings as Custom

Note:

If the Uniform Speed and Speed Ramping options are not visible, try upgrading Filmora to the latest version.

Change Speed in Timeline

You can drag the video edge in the timeline to speed up or slow down the video.

Press the Ctrl button on your keyboard, then hover the mouse over the end of the video in the timeline. You will see the around speed change icon.
While holding down the 'Ctrl' button, drag the edge of the clip backward to slow down the clip or forward to speed it up.
After you slow down the clip, you will see a purple strip showing the speed change. After you speed up the clip, you will see a red strip showing the speed
change.
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Change Video Speed in Timeline

Playback Speed Shortcuts for Windows

Changing the speed of your video is just a click away. Here is a step-by-step guide to changing the playback speed of video:

Step 1: Download Filmora and Initiate a New Project

To utilize this functionality, download Filmora on your PC and initiate it. After logging into it, go to the left panel and select "Create Project" from the given option.
Go to the "New Project" tab to start creating or editing.
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Click the new project button

Step 2: Import the Video and Drop it on the Timeline

Once in the editing window of Filmora, navigate towards the top toolbar, click "Files", select "Import" from the options menu, and import your media clip. After
that, place your cursor on the video in the timeline, bring it on the timeline, and release it on a track.
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Bring the clip to timeline

Step 3: Reverse a Video

To reverse a video in the timeline, the user must press the "J" key on the keyboard. The playback speed range for reversing a video is from -x1 to -x32.
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Use J key to reverse video

Step 4: Pause a Video

You need to pause a video several times while editing it in the timeline, and sometimes, reaching the pause option may take time. To speed this up, tap the "K" key
on your keyboard, and your video will be paused.
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Use K key to pause video

Step 5: Forward a Video

To move forward with a video in the timeline, place your finger on your keyboard's "L" key and tap it repeatedly until you reach the desired speed. The playback
speed range for forwarding a video in Filmora is from 2x to 32x.
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Use L key to forward a video

8.4	Manage Timeline and Tracks

The timeline is where you edit your clips most time. In this guide, you will find how to add, adjust, lock, and hide video and audio tracks in the timeline of Filmora.

Index

01Using the timeline
02Adjust Timeline View
03Adding Managing Tracks
04Hide & Lock Timeline

Using the timeline

The Playhead is an indicator that shows you where on the timeline you are currently located and allows you to move through the media files you placed on the
timeline. The frame at which the Playhead is positioned is going to be displayed in the Preview window.
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Adjust Timeline View

As you hover over the area of the timeline that shows time with your mouse, the pointer is going to change into a two-way arrow. Move the mouse either to the left or
to the right while holding the left click to zoom in or zoom out of the timeline.

The Zoom to Fit the Timeline icon is located in the upper right corner of the timeline. Clicking on this icon will enable you to see all the media you’ve added to the
timeline within a screen. Alternatively, you can use the zoom slider if you want to adjust the zoom level manually.

Adding Managing Tracks

A track is the part of the timeline where all the media is located. Tracks in Filmora9 can either hold video or audio files, and you should keep in mind that audio and
video clips can never be on the same track.

❶ Add One Track Each Time

To create and add a new track you just have to drag and drop the audio or video file to the blank area of the timeline, and Filmora will automatically create a new
track for the elements dragged to the timeline.

You can also click the “Manage Track” button to add, delete, and adjust any tracks.

❷ Add multiple tracks at the same time

Click the Manage Tracks icon located in the upper left corner of the panel and a drop-down menu that lets you add new audio and video tracks or delete a track
is going to appear on the screen.
Click the Open Track Manager option and then you can add up to 99 video and audio tracks to a project from the Track Manager window. Moreover, the
Placement drop-down menu lets you choose how the tracks are arranged.
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If you right-click on the section of the timeline below the Manage Tracks icon where the information about tracks is displayed, you can access each of these
options from the right-click drop-down menu.
Under the Manage Tracks menu, you can increase or decrease the size of the tracks from the Adjust Track Height submenu.

Hide & Lock Tracks

You can click on the Toggle Track Output icon that looks like an eye on a particular track if you want the media invisible. The Toggle Track Output option is depicted
as the sound icon on audio tracks and it enables you to mute an entire track.

The Add Marker icon is located in the upper right corner of the timeline and after you click on it, a new marker will be added to the same location on the timeline
where you placed the playhead.

Double-click on the marker you created if you want to gain access to the Marker Editor window where you can change the name or the color of the marker or add a
comment.
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If you would like to add a marker to a video clip you just have to make sure that the clip is selected and click on the Add Marker icon. Creating notes can be useful
when working on large projects because you can use them to line up different types of media assets.

8.5	Group Editing

Filmora allows you to link clips together as a group so you can move them without changing the positions relative to each clip within the group.

How to Group Clips

To combine multiple clips into a group, hold the Ctrl key on your keyboard and click the clips that you want to group in the timeline.
Then, right-click the clip and select Group from the context menu. You can also group them with shortcut Ctrl+G.
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Mark Groups with Colors

Besides using the group feature, you can now mark the clip in the same color. Currently, you can mark the clip with eight colors, including red, orange, yellow,
green, Cyan, blue, purple, gray and white.
Right click on the clip and select the option Select all clips with the same color mark, all clip in the same mark will be selected automatically, and then you can
drag them as a group.
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Ungrouping Clips

To unlink your grouped clips, right-click one of the grouped clips in the timeline and select Ungroup.
You can also ungroup them with shortcut Ctrl+Alt+G.
Right click on the clip and select the option Select all clips with the same color mark, all clip in the same mark will be selected automatically, and then you can
drag them as a group.
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8.6	Take a Snapshot of a Video Clip

You can take a photo snapshot in the Preview window when selecting a specific frame on the timeline.

Index

01Capture Snapshot in the Preview Window

Capture Snapshot in the Preview Window

Select the video in the timeline, click the play icon in the Preview window, and pause when you get to the frame you want to take a snapshot of.
Click the camera icon under the Preview window to take a snapshot.
The snapshot photo is automatically added as a still image in the project library. Right-click on the snapshot photo in the media library and select Reveal in
Explorer to find the exact saving location.
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Filmora Snapshot

Note:

You can also click the camera without pausing first. The snapshot will be saved in .png format.

8.7	Playing Videos in Reverse

Index

01Select Reverse Under Speed Option
02Choose Reverse Under Speed Icon

To play the video backward, you can try the Reverse feature. Here are several ways to do that in Wondershare Filmora video editor:

Select Reverse Under Speed Option

Click the video in the timeline to enter the Video edit panel, and then switch to the Speed tab. Check the box next to Reverse Speed.
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Enable Reverse in Speed in Filmora

Choose Reverse Under Speed Icon

Select the video in the timeline, go to the Speed icon in the toolbar, and then select the Reverse option. Note: If you're using Filmora 9 or 10, click here to learn how
to play videos in reverse.

  

 94/641

  

 



Reverse Option in Filmora

8.8	Using Freeze Frame

A freeze frame is a single frame of the video clip shown repeatedly on the screen, and it can be any frame from a video clip. You can use freeze frame to show a
specific frame in the video. For example, you can use freeze frame to show the tiny details, such as a smile or reaction that you’ve captured. When you add a freeze
frame to a video, the video is split at the freeze point automatically and the frame you choose is inserted as an image file and displayed onscreen for the duration that
you set.

Index

01Add Freeze Frame to Video

Add Freeze Frame to Video

1. Hover the play head to the position that you want to add a freeze frame, and then right click the video. You can use the Backward and Forward buttons in the
Preview window to navigate the video frame-by-frame to find the frame you want.

2. Right-click on the video in the timeline, and then select Add Freeze Frame option from the pop-out video context menu. Filmora will take a snapshot of the
current frame of the video and then insert it into the position where the play head locates.
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Add Freeze Frame

Tip:

You could also find the Speed icon in the toolbar above the timeline and click the Freeze Frame option.

Alternative Way to Add Freeze Frame

Note:

There will be no audio, sound, or voiceover in the freeze frame portion.

3. To change the duration of the freeze frame, drag either edge of the freeze frame in the timeline, or click the Speed icon in the toolbar and select Duration option
to adjust.

Note:

To change the duration of all freeze frames, go to Preferences -> Editing -> Default Duration, and change the duration for freeze frame.

8.9	Applying Drop Shadow for Windows

This guide introduces how to add the drop shadow effect to a video on Windows.

You can create a natural-looking shadow for the object added to the video afterward through the drop shadow effect. The object includes shapes, images, and even
moving objects.

Index

01Add Drop Shadow to Image and Video
02Add Keyframes on Drop Shadow

Add Drop Shadow to Image and Video

Follow the procedure below to apply the drop shadow effect in your image and video.

Step 1: Add your needed video or image

After launching the application on your computer, import or directly drag your video to the timeline. And then drag the PIP video or image to the above track. Adjust
the size, position, and mask of the PiP video accordingly.

Step 2: Activate the drop shadow feature

Double-click the PiP video in the timeline. Then, in the property panel on the right side of the screen, find Drop Shadow in the Video>Basic section. Click the
button beside Drop Shadow to activate the feature.
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Step 3: Adjust the settings

Change the settings of the drop shadow based on your needs.

You can change the Type from None to Soft, Regular, or Retro.
If you want to modify the Angle, you can rotate the dot in the circle below the Angle to change the value.
Color is used to change the color of the drop shadow.
Drag the slider of Distance, Blur, and Opacity to add more features.

Add Keyframes on Drop Shadow
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If you want to add the customized animation of the drop shadow in part of the video, you need to apply keyframe features. Here are the steps for adding keyframes.

Step 1: Add the start keyframe

Drag the pointer to where you want to add the start keyframe. In the property panel, after setting the feature of the drop shadow, click the diamond icon beside the
feature. If you click the diamond icon beside Drop Shadow in the toolbar, all features below this section will be added to the keyframe.

Step 2: Add more keyframes

Repeat the above-mentioned steps to add more keyframes. You can add as many keyframes as you need. The minimum of keyframes needed in animation is two.

When you are done with the settings, Filmora will analyze the changes from the start keyframe to the end one. Then, it will output a natural and smooth animation of
the drop shadow.

8.10	Auto Enhance

The Auto Enhance feature is used to adjust the video brightness and sharpness with one click, which makes the video looks more natural. (Enhance video on Filmora
X)

Click the video in the timeline to enter the Video panel.

Choose the Video>Basic tab and scroll down the property panel. Then click the button next to Auto Enhance.
Adjust the result by dragging the amount slider and viewing the result in the Preview window. Click OK to save the result.
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Auto Enhance Video

8.11	Apply Transforming for Windows

This guide introduces how to apply the transform feature while editing a video.
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01Step-by-step Guide on How to Activate Transform
02Four Uses of Transform

Step-by-step Guide on How to Activate Transform

You can follow the steps below to activate the feature and transform your clip.

Step 1: Import media to the application

After you launch Filmora, you can drag and drop your files to the timeline.

Step 2: Activate the transform feature

Click the clip in the timeline and find Transform in Video>Basic in the property panel on the right side of the interface. Then, click the button beside Transform to
start editing.
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Four Uses of Transform

The following are four uses of transform you can apply to edit your videos.

1. Resize Videos

To change the display size of a video, drag the slider under Scale. X is used to change the width, and Y is used to change the height. X and Y change simultaneously
by default. Click the lock button to change one of them individually.

2. Change Position

You can apply the Position feature to change the location of the video. Insert numerical values in the Position to adjust where the video is displayed on the screen.
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3. Flip or Rotate Videos

Under the Flip tab, there are four choices:

1) Click the Flip Horizontal icon to reverse the clip from left to right, or click the Flip Vertical icon to turn the clip upside down;

2) Click the rotate Clockwise or Counterclockwise icons to rotate the clip directly;
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3) Otherwise, insert a value in the box under the Rotate tab, or drag the dot in the circle, to adjust the angle of the clip.

Tip: When you put the mouse cursor in the Rotate value box, the cursor will become a double-ended arrow. If you move the cursor to right, the video clip will rotate
clockwise; if move to the left, the clip will rotate counterclockwise.

4. Add Keyframes

Keyframe is a customized way to add animation of transform. Here are the steps to add keyframes to the video.

Step 1: Add the start keyframe

Drag the playhead to where you want to add a keyframe. Then, change the settings in the Transform tab to meet your needs. When you are happy with the changes,
click the diamond icon beside the features. If you click the diamond icon beside Transform on the toolbar, all features in the tab will be selected as the feature of this
keyframe.
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Step 2: Add more keyframes

Repeat the step above to add other keyframes. There is no limit to the maximum of keyframes you add, but the minimum number is two. You need at least one start
keyframe and one end keyframe.

When you add all keyframes you need, Filmora will automatically analyze the changes from one to another and output the smooth animation of the transform.

Tips: Now, you can also customize the anchor point position.

The anchor point is the reference center for transformations, and it is set by default at the center of the video. After customizing the anchor point, all transformations
will be centered around the new anchor point.

There are two ways to modify the anchor point position:

1- In the property panel, find the Anchor Point and enter the coordinate values.

2- After selecting the video, click on the preview screen and directly drag the anchor point icon to adjust the position.
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Bonus: Learn more about how to flip video on a Mac or iPhone with Filmora.

8.12	Compositing

Note:

Wondershare Filmora provides a wide range of compositing tools. You can easily import composites into Filmora.

To make an entire clip uniformly transparent or semi-transparent, use the Opacity effect in Compositing. You can set a selected clip’s opacity in video or image
editing settings.

Index

01Composite Images and Videos
02Apply Compositing Effects to Blend Videos

Composite Images and Videos

Add the image as an overlay, choose to adjust the opacity (transparency) and add a blending mode (i.e., have the video you can see through the image be darkened or
tinted behind it).

❶ Click the image to enter the Image Basic Settings and go to Compositing.

❷ Choose a blending mode from the drop-down menu (your options include Screen, Darken, Multiply, and more). You can also move the Opacity slider to adjust
the image's transparency.
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Composite Images and Videos

Apply Compositing Effects to Blend Videos

Click into the Compositing tab and select compositing to blend your main video with your PIP clip. Depending on how intense or subtle you want the effect to be,
you can adjust your opacity.
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Apply Compositing Effects to Blend Videos

Add Keyframes

Click the diamond icon next to the Compositing tab to set a keyframe for all the parameters or the diamond next to Opacity to adjust the single parameter.

8.13	Adjustment Layer for Windows

This guide shows how to create adjustment layers and use them to apply the same effect to multiple clips on the timeline.

Adjustment layers apply color, animation, and effects to the video without complicated changes or settings.
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01Usage Scenarios
02Apply Adjustment Layer to Videos on Windows
03Remove Adjustment Layer

Usage Scenarios

When you wish to edit a video but not directly destruct the original one, Adjustment Layer is the best solution for you. It allows you to make different settings and re-
edit at any time without tampering with the original clips. Besides, the layer can be saved as a preset template and used directly several times for variable objects.
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Apply Adjustment Layer to Videos on Windows

Here is how to apply the layer to the video on Windows:

Step 1: Add video to the processing interface

Launch the Filmora application. Then, drag your needed media to the timeline at the bottom of the page.

Step 2: Activate Adjustment Layer

Select Media>Adjustment Layer, then click Preset to create a new adjustment layer. Alternatively, you can click Custom if you want to find a saved adjustment
layer as the preset. Drag the Adjustment Layer to the timeline above the video clip.

Step 3: Change the settings

Drag the Adjustment Layer in the timeline back and forth to cover some or all parts of the video clip. Then, click the Adjustment Layer to launch the settings. The
settings window will appear on the right side of the page.

You can adjust the layer from two aspects, Layer and Color. The Layer section contains Animation and Basic settings, such as Transform — Scale, Position, Flip
& Rotate, Rotate, Compositing — Blend Mode, Opacity, and Auto Enhance. Plus, you can modify the color from aspects of Basic, HSL, or Curves.

When you are done, click Save as Custom.
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Tip: In the Color>Basic tab, a variety of presets are built into the system, offering you multiple convenient choices.

Step 4: Add more effects

Click Effects in the upper left toolbar. Discover what you like from various options in Filmora. You can select the one from Mine>Download or find an ideal one
from the online stock. Then, drag the effect to the Adjustment Layer in the timeline.

If you want to adjust the effect, go back to the Adjustment Layer on the right side of the screen. The Effects column is automatically shown on the interface.

Remove Adjustment Layer

If you want to remove the Adjustment Layer, right-click the mouse on the Adjustment Layer in the timeline and select Delete. Alternatively, you can click Reset in
the settings window to delete the specific modifications.
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8.14	Customizable Backgrounds for Videos and Images in Windows

Backgrounds play an important role in editing a video to its perfection. With Wondershare Filmora's new upgrade, users do not need to search for these backgrounds
online. The new updates come with pre-built and customizable backgrounds for videos. If you want to know more about this feature, go through its detailed guide
here:

Access Customized Backgrounds

This section discusses the step-by-step procedure for accessing and applying customizable backgrounds for videos:

Step 1: Initiate Filmora and Start a New Project

Once Filmora is downloaded on your desktop, log in to it. Then, from the main screen, navigate towards the left panel to select the "Create Project" option.
Furthermore, tap on the "New Project" button to start editing.

Create a new project in filmora

Step 2: Import Media into one of the Timeline Tracks

Upon reaching the editing window, tap the "Files" icon in the media section and import your files. Now, by using the drag and drop method, move this media into the
timeline track and click on it.
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Drag and drop media in timeline

Step 3: Access and Add Backgrounds

From the settings panel appearing on the screen, select the "Video" tab, and under the "Basic" option, look for "Background". Turn on the slider for "Background",
which will lead to many options further.

Activate the background button

Step 4: Personalizing Background

Under the "Background" section, you'll see the "Type" of backgrounds. Expand it and select any of the three categories, including "Blur", "Color", and "Pattern".
It has multiple options for the "Color" and "Pattern" categories that you can choose from. Click on the background you like, and it will be added automatically to
your video, which you can see in the preview screen.

  

 110/641

  

 



Customize background type and adjust

8.15	Markers for Windows

Marker is an insightful aid in Filmora’s video creation and editing since they enable users to highlight or mark the errored points in the video. In simple words, users
can pinpoint their mistakes and correct them later easily without having to watch a complete video again. Although the feature was already present in Filmora, it has
been optimized, and here is a guide to utilize it.
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Distinctions Between the Two Types of Markers

❶ Media Markers

To add a marker to the media, first choose the media and then click the Mark icon or press M.
You won't be able to see these markers until the video clip is imported into the software's video editor and placed on the timeline.
You can use them to mark a place you're not too happy with, or to highlight the part of the video clip that you intend on featuring in the final cut of the video
you've created with Filmora.
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❷ Timeline Makers

The timeline markers, on the other hand, can only be added to a project during the post-production period.
You can utilize them to highlight the parts of the video clip you want to remove from the final version of your video or to mark the spots on the timeline where
you'd like to switch from one take to another.
This type of marker is immensely useful if you want to organize the timeline in your project better and to know exactly where every clip you want to use in
your video is located at all times.
Besides being a highly efficient tool for organizing vast amounts of footage, timeline markers can also help you denote the beats in the audio file and then sync
the video clip perfectly to the beat of the tune you're using as a soundtrack to your video.

Add a Marker Before Video Editing

Markers play an important role in video editing, saving time wasted while rewatching a video. This section includes a detailed guide to adding markers step-by-step
before starting to edit a video:

Method 1: Adding Markers through the Timeline Toolbar

Step 1: Initiate Filmora and Start a New Project

Once you reach the main interface of Filmora after installing it on your PC, log in to your account by clicking the profile icon at the top bar. Navigate towards the
left-side panel, choose the "Create Project" option, and go to the "New Project" tab.
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Initiate filmora and click new project

Step 2: Place the Imported Media to Timeline

Once the new project is created, hover the mouse towards the custom toolbar and select "Media". From the left panel, choose "Project Media" and select the
"Import" option to add media at the project media bar. After this, click the media file with the help of a cursor and drag and drop it to the timeline panel.

Drop imported clip to timeline

Step 3: Add Markers from the Timeline Toolbar

To add markers, watch your video, identify the mistake, pause the video, and place the playhead at that point. From the timeline toolbar, select the "Bookmark" icon
saying "Add Marker", a marker will be added at that point. Repeat the same process for adding more markers.
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Click the marker option

Step 4: Access the Modification Option

With Filmora, you can customize your marker settings according to your video to avoid complications. For this, go to the marker you added and right-click on it.
This will open a small control panel where you have to choose the "Modify Marker" option.

Access modify marker option

Step 5: Customize the Markers

From the new window, make relative changes in the Marker Editor window. You can name your marker, add a comment in the "Comment" box, and change the
marker color.

Customize marker and click OK

Method 2: Adding Markers through the Keyboard

After importing the clip in timeline and identifying the points of error in your video, place the play on these points and press the "M" letter from your keyboard. This
will add a marker in chosen timeframes.

Press M key to add marker

Remove a Marker After Video Editing
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Once you are done editing your mistakes, you should remove those markers. To successfully remove a marker, click right on the marker and, from the options menu,
select "Delete" to delete the particular marker or "Delete All Markers" to delete them collectively.

Choose marker removing options

8.16	Auto Ripple for Windows

While editing a video in a timeline, the empty spaces disrupt the playback flow and must be eliminated. With Filmora's Auto Ripple functionality, users do not need
to remove them manually. Enabling this functionality before the editing process will auto-remove these spaces between clips and maintain the workflow. To know
more about auto rippling, keep reading:
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Enabling Auto Rippling Before Editing

For optimized editing, here is a step-by-step guide to initiate auto-rippling in Filmora before you start editing:

Enabling Auto Rippling Before Editing

Step 1: Create a New Project and Import Media in the Timeline

Download the software from Filmora's official website and launch it on your device. Upon launching, the main menu window will appear. Click the "New Project"
button and import your media files from there. Afterward, drag-and-drop functionality brings your media files to any timeline tracks.

bring the clips to timeline

Step 2: Activate the Auto Ripple
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Navigate towards the left side panel of the timeline track where you added your media files and click the "Open Auto Ripple" option adjacent to Track Manager.
Now, this function will remove the spaces between videos whenever you start editing.

click the auto ripple button

Manually Rippling the Spaces During Editing

If you forget to enable auto-rippling, you can remove the spaces manually by using the following methods discussed below:

Method 1: Using the "X" Icon

With your mouse's help, navigate the spaces between your clips in the timeline and click on them. Then click the "X" icon on the top right corner of these spaces to
remove the space.

press the x icon

Method 2: Using the Right-Click Functionality

Another way of doing this is to position the cursor within the space separating two video clips in a track and right-click on it. From the options menu that shows up,
select the "Ripple Delete" option.

choose the ripple delete option

Method 3: Using the Keyboard Shortcuts

An alternative method for removing the gaps between the clips in the timeline is clicking the space in between and clicking the "Shift + Delete" on the keyboard.

8.17	Enable/Disable Clip in Windows

When working on professional projects as a video editor, turning on and off clips helps with optimized editing. Hence, Wondershare Filmora offers this functionality
as a professional editing software. The methods to access and enable these features are straightforward, and you'll learn about them in this guide:

Index
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01Method 1: Using the Timeline Dropdown Menu
02Method 2: Using the Timeline Panel on the Left

Accessing the Enable/Disable Option

There are two ways for users to commence this action, and by reading further, you can familiarize yourself with them:

Method 1: Using the Timeline Dropdown Menu

Step 1: Import Media to Timeline

Create a new project after launching Filmora, using the correct navigations. Once you reach the editing window, click the "Import" button in the Project Media
section and import your files. Afterward, access this recently imported from "Media Library" and bring it to the timeline track.

Import and drop media to timeline

Step 2: Disable a Clip

Select this clip in the timeline panel and access the timeline dropdown menu by right-clicking on the following clip. From the dropdown menu options, locate and
choose "Disable Clip". This action will hide the clip in the timeline while you focus on others to edit.
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Hide a click by right-click action

Step 3: Enable a Clip

Repeat the same action for enabling the clip, except this time, look for the "Enable Clip" option.
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Unhide a clip by right clip action

Method 2: Using the Timeline Panel on the Left

Once you have dropped media to the timeline, select it and navigate towards the panel at the left side of the pane. Click the "Eye" icon to turn off the clip from there.
Once the editing is complete, click the same icon again to enable the clip.

Click on the eye icon

8.18	Mark In and Mark Out for Windows

In Filmora, users can mark in and mark out their clips to specify the region for editing, eliminating, exporting, and more. Keep reading the guide below to learn how
to increase your productivity using this tool:

Index
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01Method 1: Using the Preview Window
02Method 2: Using the Keyboard Shortcuts

Method 1: Using the Preview Window

Step 1: Open a Project and Import Media to Timeline

After downloading Filmora on your desktop, click the "New Project" option, choose files from your device's File Manager, and import them to the timeline.

import media straight to the timeline

Step 2: Accessing the Mark In and Mark Out Options

By using your cursor, navigate towards the Preview window, use the "{" button for the "Mark In" option, and use the "}" button for "Mark Out."

enabled mark in/mark out option

Method 2: Using the Keyboard Shortcuts

If you prefer the keyboard as your companion, click the "I" key for the mark-in and the "O" key for the mark-out option.

8.19	Logo Reveal For Windows
Wondershare Filmora believes in building brand value through various media-influenced elements. One such element is the logo itself, which creates the entire brand
setting. Recently, Wondershare Filmora has observed the introduction of a feature that transforms an existing logo into an animated logo, an enhanced and improved
version of their previous brand setting.

Index

01How To Use Logo Reveal Feature in Wondershare Filmora?
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How To Use Logo Reveal Feature in Wondershare Filmora?

Users looking to create logo brand videos should consider opting for this feature to create automated animations instantly. Not only does it save time, but it also
reduces the cost of creating such animations. Provided next are the steps to utilize the intuitive feature of logo reveal to create animated logos using Filmora:

Step 1. Access Influence Kit in Wondershare Filmora

Start the process by creating a new video project on Wondershare Filmora by clicking “New Project.” This leads you to an editing window where you should look
for the “Influence Kit” section in the “Media” tab.

Access Influence Kit Section on Filmora

Step 2. Select Desired Effect For Logo Animation

While you reside in the “Start Creating” sub-section, select "Start Creating" under the “Brand Transmission, Logo Reveal.” A new window pops up, which
requires you to select an appropriate effect for the animated logo.
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Select Desired Effect

Step 3. Add Logo and Set Text To Create

After selecting an effect and clicking “Start Creating” on the bottom right, you need to add your logo image. Consequently, set the text to be displayed in the logo
reveal animation across the "Edit Text” section. With all edits completed, click “Finish” to conclude the creation of an animation for your logo, which will be added
to the timeline across Filmora for further use.
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Add Logo and Set Text

8.20	Video Editing Ruler – Windows

Filmora is known for providing ease to video editors on the overall scale. There are multiple video editing tools available that support ease of use and guide users to
efficient video editing. However, for scaled editing across a video through rulers, there is a recent addition to Filmora, which helps with layout settings through such
visual editing.

Index

01How To Use Video Editing Ruler in Filmora?

How To Use Video Editing Ruler in Filmora?

While working on your video editing project, if it comes to managing a specific layout within the video at different time instances, you might have to scale it
thoroughly. Filmora provides a video editing ruler that helps create reference lines as guides for assisting with the layout. To figure out how it is done effectively,
look through the step-by-step instructions provided:

Step 1. Import Video To Filmora

As you initiate working on Filmora, set up a new video project using the "New Project" button. Proceed to the video editing interface and use the "Import" button to
add your content.
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Import Video To Filmora

Step 2. Access Video Ruler on Filmora

With your video added to Filmora, drag it across the timeline for further editing. To access the video ruler, lead to the preview window within Filmora and right-click
your mouse or trackpad. Look for the "Ruler" option in the drop-down menu and click to activate it. Similarly, you can use the "CTRL + P" shortcut key for
activating this option. This will display the ruler across the preview window to act as reference lines.
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Access Video Ruler on Filmora

Step 3. Create a New Reference Line

To create new reference lines within your video preview, you can go to the same drop-down menu and find the "Guides" option. In the protruding menu ahead of it,
click the "Add Guide" option to open a new pop-up window. You'll have to set up the "Color," "Direction," and "Position" of the reference line before clicking
"OK."
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Create a New Reference Line

Step 4. Hide or Lock Reference Lines of Video Ruler

While creating new reference lines, there are multiple ways to manage them across Filmora. If you want to remove all reference lines from the display, use the “Hide
Guides” option. Furthermore, if you have to restrict these reference lines across a specific point, the “Lock Guides" option would do the trick.

Hide or Lock Reference Lines of Video Ruler
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8.21	Magnetic Timeline on Windows

Wondershare Filmora's Magnetic Timeline is a game-changer for video editing, offering a streamlined way to ensure your clips align perfectly. As you drag and drop
clips onto the timeline, they automatically snap to the adjacent clips, keeping your project seamless and organized.

Learn how to use magnetic timeline in this guide.

Index

01Upload Your Videos
02Drag Within Different Tracks
03Function Introduction

Upload Your Videos

Import the video clips you want to edit and drag and drop them onto the timeline.
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Upload Your Videos

Click on the corresponding icon to open the Magnetic Timeline.
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Turn on the Magnetic Timeline

Note:What if there are already video clips on the timeline?

In this case, if you still need to add video clips, the track will automatically move when you insert the video at a different location.

In the following figure, when you insert before existing video clips, current video clips and subsequence clips move backward.
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Add Video Clips

Drag Within Different Tracks

You can drag and drop videos from your main track to other tracks as you like, and the videos in the main track will be automatically attached to the right place
without any gap.

Note: The auxiliary lines are also present to help you better perceive and understand the editing process.
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Drag Videos Within Different Tracks

Function Introduction

Trim

You can either single-select a particular video track for editing, or you can select multiple tracks for editing at the same time, and the latter will increase or decrease
in synchronization, depending on the amount of trim.

Copy/Paste

1. If the video clip to be copied is from the main track, subsequent clips (if any) are moved backward at an even speed for pasting the new video clip.
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Copy Videos on Main Track
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Paste the Copied Video

2. If a video clip to be copied is not from the main track, the new clip is pasted above the selected clip.
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Copy Videos not on Main Track
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Paste Copied Video Clip

Delete

When deleting, one thing to keep in mind is that videos attached to other video clips will be deleted along with them.

Speed

Other than the above, Magnetic Timeline can improve the efficiency of your video editing in many other ways: adding transitions, applying templates, placing SRTs,
and so on.

Conclusion

Filmora's Magnetic Timeline targets beginner editors and is designed to improve the efficiency of high-frequency editing functions through automatic attachment of
track clips and linking of sub-track clips.

8.22	Select All Clips on Timeline for Windows

If you're editing in Filmora and want to speed up your workflow, knowing how to select clips both forwards and backwards on the timeline is essential. This feature
allows you to select multiple clips at once, saving you time and effort when editing larger projects. In this guide, we'll show you how to quickly select clips forward
and backward from your playhead's position.

Index

01Select All Clips Forwards in Filmora
02Select All Clips Backwards in Filmora

Select All Clips Forwards in Filmora

When you need to select all clips from your current clip position to the beginning of your project or sequence, Filmora offers an easy way to do it. This method is
useful when selecting everything that comes after a specific point in your timeline.

1. Position the Cursor:

Move the cursor to where you want to select clips on the timeline.

2. Click on 'Select All Foward' or Use shortcut 'A':

You can choose 'Select All Forward' or use shortcut 'A' to select all clips on every track, including audio tracks and video tracks.
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Click on the clip that last clip you want to move.

Then all clips before the last clip would be selected, you can drag any of these clips to move all clips.

3. Unselect All Clips:

Once you've selected the clips forwards, you can move them, delete them, or apply effects. You can also unselect them. Just choose 'Select' or use shortcut V.
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Select All Clips Backwards in Filmora

Sometimes you might need to select clips to the left of your playhead, including all the clips before your current position on the timeline. While Filmora doesn’t
support a one-click shortcut for selecting backwards like Premiere Pro, you can still achieve this with a few easy steps.

1. Position the Cursor:

Move the cursor to where you want to select clips on the timeline.

2. Click on 'Select All Backward' or Use shortcut 'Shift+A':

You can choose 'Select All Backward' or use shortcut 'Shift+A' to select all clips on every track, including audio tracks and video tracks.

Click on the first clip in the group of clips you want to select.
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Then all clips after the first clip would be selected, you can drag any of these clips to move all clips.

3. Unselect All Clips:

Once you've selected the clips forwards, you can move them, delete them, or apply effects. You can also unselect them. Just choose 'Select' or use shortcut V.

Why This Feature Is Useful

Being able to select clips forwards or backwards allows you to quickly modify sections of your project without having to select clips one by one. Whether you're
editing a large multi-track sequence or making adjustments to specific sections of your project, this method speeds up the editing process and keeps your workflow
smooth.

8.23	Drawing Tools for Windows

When creating a tutorial or news videos, the Drawing Tools feature in Wondershare Filmora allows users to highlight important details and create banners directly on
the video clips. It enhances the engagement and storytelling visuals of the video. This feature provides several shapes, including arrow, rectangle, and oval, to help
you add a personal touch to the content.

Index

01How to Utilize Drawing Tools of Wondershare Filmora?

How to Utilize Drawing Tools of Wondershare Filmora?

To get a better understanding of how to utilize the two methods of adding elements to your videos, follow the simple guide below:
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Way 1. Utilize Filmora's Drawing Tools for Making Banners

Upon having an overview of drawing tools, let's learn how you can use them to create engaging banners for your video:

Step 1. Create a New Project

Download and install the recent version of Filmora on your PC to start the task. After launching this tool, click the "New Project" button to enter the main
workspace.

create a new project

Step 2. Add the Video and Access Drawing Tools

Once you enter the main workspace, tap on the "Import" button to add the video in which you want to insert a banner. Drag and drop the video into the timeline for
editing after importing. Access the "Drawing Tools" menu from the top of the timeline and choose the "Rectangle" option from the available shapes.
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choose the rectangle shape

Step 3. Customize Your Banner Design

Once you draw this shape on your video, position it properly by dragging it to your desired location. Next, head to the right-side panel to enable the "Fill" option and
choose a color for your banner that complements your video.
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fill color in the rectangle

Step 4. Apply Animations to the Banner

Now, shift to the "Animation" section and pick which style best matches your requirements. To apply the animation, you need to double click on the chosen option.
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apply animation to banner

Step 5. Locate Keyframe Animations

Once the animation is applied, move to the timeline section and "Right-Click" on the diamond shape on the added animation. From the pop-up menu, pick the
"Show Keyframe Animation" option.
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locate keyframe animations

Step 6. Adjust the Keyframe Animations for the Banner

Upon getting the extended keyframe animation settings, start to adjust them as per your video. You can drag the diamonds across to set the animation accordingly.
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adjust keyframe animations

Step 7. Add Titles to Your Banner

Afterward, navigate to the "Titles" section in the top toolbar, and select the title that best matches your requirement. Drag and drop the chosen title on top of the
video in the timeline. Adjust title's position once it appears within the preview window by dragging it over the banner. To customize the appearance of the title, go to
the "Video" tab, choose an effect style under preset, and add a "Text" to the video banner.
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add title to your banner

Step 8. Export the Video Banner to Your PC

When satisfied with the look of the banner, tap on the "Export" tab at the top-right of the interface. In the "Export" window, you can choose the output folder,
resolution, and format for the video. Click the "Export" button to save the video to your computer.
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adjust export settings

Way 2. Insert Dynamic Arrows Using Filmora's Drawing Tool

Apart from different shapes that can be added into your video for annotation, here is another way you can annotate your videos for a better viewing experience:

Step 1. Add Your Video and Drag it to the Timeline

Initiate the process by clicking the "Import Media" button to add your video to the interface and drag the video to the timeline.
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drag and drop video to timeline

Step 2. Select the Arrow From the Drawing Tools

Next, on the editing interface, click on the "Drawing Tools" icon and select the "Arrow" option. Then, draw this arrow across the video where you want to place
the arrow.
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choose the arrow shape

Step 3. Adjust the Arrow on the Video and Fill it

Moving on, to match the video elements, tap on the "Fill" toggle button to turn it on and add colors to it. Then, adjust the arrow on the video to place it in an
organized manner.
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add color to arrow

Step 4. Shift to the Animations to Apply it

Upon adjusting the arrow, click on the "Animations" section and pick which style best fits the video. To apply the animations to the drawing tool by clicking twice
on it.
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apply animations to arrow

Step 5. Right-click on the Arrow and Pick the Show Keyframe Animation

After adjusting the animated arrow, right-click on the element from the timeline. This gives you a drop-down menu, where you can pick the "Show Keyframe
Animation" option.
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pick keyframe animation option

Step 6. Adjust the Keyframe Animation and Export the Video

Next, from the keyframe animations panel on the timeline, you can adjust it according to your liking. Lastly, hit the "Export" button on the top right corner of the
screen to download the video to your files.
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adjust keyframe animation and export video

Way 3. Add Lines With Easy Format Customization

While Filmora offers a complete set of shapes to draw interactive elements in your video, you can also add up lines with contextual formatting to make videos
inclusive. Provided next are some simplified steps to add lines to your video content across Filmora:

Step 1. Add Line Shape in Video Timeline

After importing your video into Filmora's timeline, continue to the "Shapes" option in the timeline menu bar and choose "Line" from the list.
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add line using shapes option

Step 2. Customize Line Shape Settings in Filmora

As you draw it on the preview window, the settings involving the shape appears on the right. While you can add up animations as discussed in the previous sections,
the "Line" shape provides a special set of format customizations. Within the "Basic" section, expand the "Line" settings menu and discover different options which
allows you to enhance the outlook of this shape. You can define how to start the line or select the end style, while selecting an overall style and size for it with the
available options.
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make customizations in the line shape

9.1	Add Animation Keyframing for Windows

This guide shows how to add and edit keyframes in your video.

Keyframes are used in wide-ranging, including split screens, color grading, text editing, special effects, etc. It can also be saved as a preset custom, which you can
quickly apply to multiple objects.

In terms of animations, you can use keyframing to create your customized one. Keyframes allow you to set the value of several points and give you smooth
animation over time.

Index

01Add Keyframes
02Edit Keyframes
03Delete Keyframes

Add Keyframes

The followings are guides to adding a keyframe in a video.

Step 1: Import the media

Launch the application and import media as prompted. Or you can drag the clip from your files or the library directly to the timeline.

Step 2: Launch the Keyframe feature

Click once on the clip, and the property panel will appear on the right side of the interface. Click Video > Basic and click on the diamond icon to set a keyframe. All
features with a diamond icon can be added to the keyframe.

Step 3: Add keyframes

Drag the progress bar to where you want to add the start keyframe. Click the diamond icon in the property panel to set the keyframe.
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windows activate keyframes in the transform tab

Note:

There is an exclusive keyframe icon in the timeline toolbar. You only need to place the playhead where to add a keyframe and click the icon. Once click on it, all the
keyframe values will be selected automatically.

windows add keyframes in the timeline

Edit Keyframes

Here are the steps to edit keyframes after adding them.

Step 1: Adjust the parameters

You can change the parameters, both in and out of the property panel. Drag the slider, adjust the values of each setting, or simply apply features, to meet your needs.
The followings are some of the features you can set in a keyframe.

Video: It includes Basic settings, such as Transform, Compositing, Drop Shadow, Auto Enhance, Mask, AI Tools, and Animation.

Audio: You can make an audio adjustment at one keyframe, including Volume, Sound Balance, Fade In, Fade Out, Pitch, and Equilizer.

Titles: In addition to the basic keyframing effects, you can add animations to the whole title group or separately to each object therein if there are 2 or more title
particles in the same group.
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windows keyframes for two titles

Effects: All the elements, including the Openfx effects, can be set in a keyframe. You can explore and discover the effect you like from the Filmora huge online
effects stock.

Stickers and Split Screen: You can add keyframes to customize your animation of a sticker or the split screen.

Step 2: Add other keyframes based on your needs

After setting one keyframe, you can see a diamond icon on the timeline. Then, drag the progress bar to another point where you want to apply another animation
feature. It can be a keyframe representing the end of the animation or another animation effect. Adjust the parameters based on your needs.

windows add the second keyframe

Note:

You need to add at least two keyframes with different parameters in the clip to activate the animation feature. Otherwise, it would be an effect remaining the same
throughout the whole video.

Step 3: Save the changes

When you have added and edited all keyframes you want in the timeline, click Ok to save. The system will automatically analyze the change from one keyframe to
another and export the effect with natural transformation.

Delete Keyframes
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There are several methods to delete keyframes:

On the Property Panel

1. To delete one parameter like Scale or Position in Transform, click the back or the diamond icon next to the parameter
2. To delete all the parameters in a whole property like Transform, click the back or diamond icon at the right end of the Transform tab.
3. To delete all the keyframe values, click Reset at the bottom of the section.

windows delete keyframes in the timeline

On the Timeline

1. Right-click the diamond mark on the clip. When the icon turns yellow, select Delete Keyframe or Clear All Keyframes.

windows delete keyframes in the timeline

9.2	Masks

Masking is a process where a transparent shape layer is drawn/created over the main clip. When masking is done, any portion of the video that is covered with the
mask is visible and everything else remains hidden.

Masks are mostly used to prevent the viewers from any distraction and draw their attention to a particular action or person.

Go to the Mask tab

Click the video clip in the timeline to enter the Video panel. Switch from Basic to Mask tab, and you will find some basic mask shapes, such as rectangle, circle,
double line, single line, love and star. You can also draw a mask shape as you like.

Apply a Mask

You can apply an existing video mask or load your own video mask by clicking Import. Click one of the shapes from the Masks, you will see only the area covered
with the mask shape is visible and everything else gets hidden in the Preview window.
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Add Mask to Video

Draw a mask

Using the Draw Mask feature, you can create complex masks in any shape by dragging control points and modifying B-Splines. You can zoom in and out on the
player screen and draw the mask shape precisely. You can easily create smooth curves by holding the Alt/Option to adjust the Bessel curve for drawn masks. Also,
you can save the draw mask as preset to apply it with one click.
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Draw mask for videos

Import Shapes to Create a Mask

By importing an Alpha-channel PNG image (such as triangles, candle shapes, arrows, rectangles, etc.), the mask will be created based on the image’s outline. You
can use various shapes, such as triangles, candle shapes, arrows, rectangles, etc. The system will automatically detect the image and generate an editable mask. You
can then adjust the mask’s shape and size to fit your video content perfectly.
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Click on the import icon
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Choose the mask picture

  

 161/641

  

 



Apply the mask to videos

Adjust the Mask

Use the mask handles in the Preview window to resize, reposition or change the orientation of the mask. You can also adjust the sliders in the Mask tab to edit the
mask. You can rotate, adjust scale, position, blur strength, width, height and radius. You can even invert the mask, i.e., the original visible part turns into invisible,
and the hidden part get visible.
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Adjust and edit mask

Add Keyframe to Mask

Move the play head to the position where you want to add a keyframe, and then click Add button to add the first keyframe. Move the mask to a different position,
rotate or resize it, or adjust the blur strength to add the second keyframe to get animation effects.
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Add keyframes to mask

Note:

You can click the SAVE AS CUSTOM button to save the customized mask for future uses, and click RESET to revert the changes to their default.

Preview the Video and Save

Click the Play in the Preview window or press the Spacebar to see how the masked video appears. Finally, click Crtl+S to save your project.

9.3	Creating A PIP Effect

PIP, also known as Picture in Picture, is an effect often used to place some smaller videos on a background clip, showing two or more video clips on the same screen.

It is extremely useful to create online tutorials, product demonstrations or game videos, etc., when you need to narrate the action happening in the main clip.

Index

01Create A PIP Effect Video
02Adjust PIP Video

Create A PIP Effect Video

Import both the background video and the picture-in-picture video to the media library
Drag and drop the background video to video track 1 in the timeline.
Drag and drop the PIP video above the background video in the timeline.
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Create PIP Effect Video in Filmora

Select the PIP video in the timeline and drag its handles in the Preview window to quickly adjust its position and size.

Resize and Reposition PiP Video in Filmora Preview Window

Adjust PIP Video

You can position a picture-in-picture clip anywhere you want in the Preview window, resize it to any size, adjust its blending mode and shape, add borders.

Change PIP Blending Modes

● Click the PIP video in the timeline to enter the Video edit panel, go to the Basic tab.

● Scroll down to the Compositing field and select a Blend Mode (i.e., multiply, darken, screen, or color burn).
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● You can fine-tune the opacity until you have the look you want in the preview window.

Adjust PIP Video Blending Mode

Change PIP Video Shape with Mask

● Switch to the Mask tab in the Video edit panel.

● Please select one of the mask presets and place it in the PIP video in the timeline.
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Add Mask to PIP Video

Note:

You can import your mask from your computer and add keyframing to the mask.

Add Animation and Motion to PIP Video

Filmora provides dozens of motion effects and several animations for you to choose from.

● Double click the PIP video in the timeline switch from the Video panel to the Animation panel.

● Double click one animation preset or motion preset, or right-click on it, and then click Apply to view the result in the Preview window.
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Add Animation to PIP Video

Note:

You can also add and customize the animation to the PiP video.

Add Effects to PIP Video

● Go to the Effect tab and then search the border in the search bar.

● Drag the border effect to the PIP video in the timeline, and go to the Effect tab under the Video panel.

  

 168/641

  

 



Add Border Effect to PIP Video

● Click the PIP video in the timeline to enter the Video panel.

● Switch to the Effect field to adjust the color, size, blur, opacity, and director of the border.
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Adjust Border in PIP Video

9.4	Keyframe Graph Editor for Windows

Keyframe editing has always been a core component of this video editor, and now it has been introduced as an independent function. With the new "Keyframe Graph
Editor" in Filmora, adjust your animations within videos to make them smooth and lifelike. While it utilizes Bezier curves for enhancing the animations, it helps cater
to many issues involving the previous iterations of keyframing editing. This guide below is going to discuss the new "Keyframe Panel" option of Filmora and how to
access it on your Windows:

Access the Keyframe Graph Editor

The keyframe graph editor or keyframe panel of Filmora is all about keyframing in a precise manner. To experiment with this amazing feature, here is a step-by-step
guide to access it:

Step 1: Install Filmora and Initiate a Project

After commencing the successful installation of Filmora, log in to it. Then, from the options appearing on the main screen, select the "New Project" button. This will
take you to the editing interface of Filmora.
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Create new project in filmora

Step 2: Import Media and Move it to the Timeline

From the editing window, go to the "Media" tab in the custom toolbar and then select the "Click here to import media" option on the media screen to import media.
Once your file is imported, move it to the timeline with your cursor and place it on the timeline track.

Add media to timeline

Step 3: Enable the Keyframe Panel

Now, right click on this clip in the timeline. From there, click the "Show KeyframeAnimation".
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Click Show Keyframe Animation

The keyframe graph will be shown at the timeline. Now, add different keyframes in your videos, seamlessly edit them, and keep track through this graph editor.
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Adjusting keyframe paneling

9.5	Compound Clip for Windows

Users can try out one of the new functionalities in Filmora, navigating under the name of compound clip. This feature combines two separate videos, allowing users
to edit them simultaneously. If you have also taken multiple shots and want to apply the same effects and filters on them, learn how to make a compound clip here:

Index

01Making a Compound Clip
02Navigating Through Compound Clips
03Detach Compound Clips

Making a Compound Clip

If you also want to bring smoothness and consistency to your videos using the compound clip feature, follow the step-by-step guide given below:

Method 1: Using the Top Toolbar

Step 1: Create a New Project

Once you download Filmora and log in to your account, navigate towards the left side panel and click the "Create Project" option. This will bring up many tabs on
the main screen; find and choose the "New Project" option.
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create a new project on filmora

Step 2: Import Clips and Place in the Timeline Panel

Upon accessing the editing window of Filmora, press the "Ctrl+I" keys on your keyboard simultaneously and select clips from your device to upload. After a
successful media import, bring the clips to a similar timeline track using the drag-and-drop action.

bring clips to timeline track

Step 3: Create a Compound Clip

Once the clips are in the timeline panel, select both and navigate towards the top toolbar. From the given tabs, select "Tools", and from the dropdown menu, choose
"Create Compound Clip". This will open a pop-up window, name your compound clip, and click "OK".
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Access compound clip from files bar

Step 4: Save the Compound Clip

If you want to save this compound clip, navigate towards the timeline panel where your compound clip is and select it. Right-click on it, and from the options menu,
select "Save as Compound Clip Custom".

Save compound clip in filmora cloud

Step 5: Access Saved Compound Clip

This clip will be saved in Filmora’s cloud storage. To access it, navigate towards the top left panel and select the "Compound Clip" option. You can see your saved
clip there.

  

 175/641

  

 



Access the saved compound clip

Method 2: From the Timeline Control Menu

After dropping the media into the timeline panel, select the clip in the timeline and right-click on it. From the control panel appearing, click the "Create Compound
Clip" option. Further, name your clip and click "OK".

Activate compound clip functioning

Navigating Through Compound Clips

Once you have created compound clips in your Filmora project, the platform offers proper timeline management. To understand more about how compound clips
work once created, the steps below are to ease the idea:

Step 1: Access Compound Clips in Main Timeline

Once you have created the compound clip in Windows, they are not only displayed in the media tab but are also properly shown across the timeline. After creating
compound clips, the timeline toolbar starts displaying the layering in the video timeline. When you are in the "Main Timeline" layer, you can view all the clips as a
compound clip.
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View compound clip in main timeline

Step 2: Open Up Compound Clip in Timeline

On changing the tab to the respective compound clip from the dropdown menu, the clips combined in the compound clip are displayed in the same manner they were
combined. This helps you in switching through your video editing easily and make significant changes easily.

Navigate into compound clip in timeline

Detach Compound Clips

In the new version of Filmora, Detach compound clip is supported. Now you can restore the compound clip, making video editing more flexible.

Right click on the compound clip on the main timeline, then select "Detach Compound Clip" to restore the compound clip.

Detach compound clips in main timeline

9.6	Multi-Clip Editing for Windows

Wondershare Filmora already has a timeline feature in which users can drag and drop many videos and effects for professional editing. However, the new version
brings a Multi-Clip Editing feature that allows users to edit two or more videos simultaneously. This feature will replace the "Batch Edit" feature of Filmora with a
better functionality. Keep reading this guide to learn about the features and functionality:

Accessing Multi-Clip Editing
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In case you are confused about how to edit multiple clips at once with Filmora, here is a step-by-step instruction manual for it:

Step 1: Install Filmora and Start a New Project

By accessing the official site of Wondershare Filmora, download it for Windows, and after that, open it. Then, log in to your account and click on the "New Project"
tab appearing on the main menu.

choose new project button from screen

Step 2: Import Media and Bring it to the Timeline

Once you are in the editing window of Filmora, click the "Click Here to Import Media" button just below the "File" icon and import your files in the "Media
Library". Use the drag-and-drop method to bring files to the timeline.

import multiple videos to timeline

Step 3: Initiate Multi-Clip Editing
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You can drop these files on the same track or different ones to edit simultaneously. To do this, press the "Ctrl" button from your keyboard and, with the help of your
cursor, select both clips, one after another.

select multiple clips in timeline

Step 4: Right Click to Start Editing

After selecting the multiple clips, right-click, and the dropdown menu will appear. From the options available, you can incorporate any function on these clips. For
instance, you can enable "Compound Clip", and "Color Match", or you can "Adjust Audio" for both at a time.

right click to apply different functions

Step 5: Perform Multi-Editing With Different Features

Multi-editing can be continued across different elements within the video timeline. For instance, if you have added a video clip and a title across it, you can select
both and edit them simultaneously. For that, double-click on the video clip to open its settings at first. Continue to hold the "CTRL" key and tap the title on the
timeline to open the multi-editing system.

  

 179/641

  

 



multi clip editing with different elements

Note:

There are a few things that are to be known about this feature. This feature does not support preset keyboard operations like "centering", "zooming", or making
"vertical or horizontal shifts". Secondly, you cannot use the "Special Effects", "AI Smart Cutout", "Masking", "Motion Tracking", and "Stabilization" features in
multi-clip editing as of yet.

9.7	Keyframe Path Curve for Windows

Are you frustrated with not being able to create smooth animation paths? Filmora has recently introduced the keyframe path curve feature. When you adjust the
transition effects between keyframes, you can change keyframe type to control the speed and pacing of the animation, making it look smoother and more natural, and
helping you create high-quality video clips. Now Let us know how to use it.

Index

01Apply Keyframe Path Curve
02Adjust Keyframe Path Curve

Apply Keyframe Path Curve

Here is the guide on how to apply Keyframe Path Curve on Windows.

1. Click Create Project > New Project, then you can access the main interface.
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2. Import a media file > Drag it to the timeline.

3. Move the playhead anywhere in the media file > Add a position keyframe.

4. Move the playhead to any position in the same way > Move the position of the video on the player > A keyframe will be generated automatically. From this you
get a set of motion path.
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5. Open Path Curve to show the motion path.

Adjust Keyframe Path Curve

You can change the keyframe type to get a smooth path curve.

1. Place the mouse over the keyframe and right-click it > Select Keyframe Type > Select Linear, Curve, Continuous curve, Freeze, Ease in or Ease out to change
the shape of a curve.

2. Choose Delete Keyframe to delete a keyframe.
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9.8	Create Multi-Camera Clip

Create Multi-Camera Clip lets you combine footage from multiple cameras into a cohesive sequence. You can sync clips by setting in-and-out points or using
audio-based syncing for precise alignment. This feature simplifies multi-camera editing, making crafting polished, dynamic presentations from various angles easy.

Index

01Multi-Camera Editing Tool
02 Multi-camera editing workflow

Multi-Camera Editing Tool
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multi-camera editing tools of filmora

① Multi-Camera View Button: Click to open the multi-camera view.

② Multi-Camera Audio Source: Activate the icon to export the audio from the selected camera angle to the multi-camera editing.

③ Multi-Camera Trim Cursor: During playback, hover the mouse over the multi-camera view to switch between multi-camera clips.

④ Multi-Camera Replacement Cursor: In pause mode, select a multi-camera clip. When the cursor is over the clip, clicking on a different view in the multi-
camera interface will replace the currently selected camera angle.

⑤ Multi-Camera Audio Source: Display the audio sources of the audio tracks.

⑥ Timeline Right-Click Menu Options:

Edit Multi-Camera Timeline: Click to open the multi-camera timeline, similar to double-clicking the multi-camera clip. (Note: double-clicking the clip is
ineffective in classic layout)
Switch Multi-Camera Video Angle: Replace the camera angle of the selected clip, similar to the Multi-Camera Replacement Cursor.
Switch Multi-Camera Audio Angle: Switch the audio track of the multi-camera clip, similar to the ②and⑤.
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Multi-camera editing workflow

If you want to easily import footage from multiple cameras and seamlessly switch between angles for an efficient and convenient editing experience, follow the
detailed steps below:

Step 1: Create a New Project

Once you download Filmora and log in to your account, navigate towards the left side panel and click the "Create Project" option. This will bring up many tabs on
the main screen; find and choose the "New Project" option.

create a project in filmora

Step 2: Import footage

0:00 / 0:18
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From the editing window, go to the "Media" tab in the custom toolbar and then select the "Import" option on the media screen to import media.

import footage in filmora

Step 3: Create Multi-Camera Clip (Two Methods)

Method 1:Select multi-camera video or audio clips in the media bin, right-click, and choose "Create Multi-Camera Clip."
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create a multi-camera clip from the media bin

Method 2:Select multi-camera video or audio clips in the timeline, right-click, and choose "Create Multi-Camera Clip."

create a multi-camera clip from the timeline

Name your compound clip and choose how you want to synchronize your clips.

(When creating multi-camera clip from the media bin, there are two synchronization methods; when creating a multi-camera clip from the timeline, there are three
synchronization methods.)
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synchronize clips

synchronize clips in filmora

Note:

Audio: Use the audio waveforms from each camera angle for precise synchronization adjustments.
First Frame: Use the first frame of each camera angle as the synchronization point.
First Marker: Use the first marker in each camera angle as the synchronization point.

Step4: Enable Multi-Camera View

In the player window, you can click “Switch Multi-Camera View ” to enable the multi-camera view.

In this mode, you can simultaneously view footage from all cameras and switch between them to select the desired footage for the final edit.
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enable multi-camera view in filmora

Step5: Edit the multi-camera clips

Press the spacebar or click the Play/Stop in the player/timeline panel to start playback. While the clip is playing, clicking on the multi-camera view screen will switch
the timeline to the corresponding camera angle.

  

 190/641

  

 



  

 191/641

  

 



edit the multi-camera clips in filmora

Note:

You can also use Keyboard Shortcuts to switch between multiple video angles: File>>Keyboard Shortcuts
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keyboard shortcuts

Step6: Adjust and refine edits

Adjust the multi-camera timeline:

Timeline: Double-click or right-click to edit and adjust the multi-camera timeline within a multi-camera clip.

Media Tab: Right-click to edit and adjust the multi-camera timeline within a multi-camera clip.

Modify Multi-Camera Clips:

Select the trimmed multi-camera clip and click on the multi-camera view to switch the clip to the corresponding camera angle you clicked on.

Bidirectional Editing:

When you find that the current cut point is not suitable, hover your mouse over the cut point to change it to a bidirectional arrow. At this point, you can drag the
mouse to adjust the cut point.
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bidirectional edit in filmora

9.9	Mocha Filmora - For Windows

Using Filmora's native tracking tool, the editor struggles to maintain accurate placement, especially when the runner's body twists and moves rapidly, causing the
logo to jitter or lose alignment. However, with the new plugin introduced by Wondershare Filmora, users can now conveniently mark objects, add parameters, and
adjust the parameters according to their preferences. Editors can now apply tracked effects with greater realism, accuracy, and speed using Mocha UI.

You can access this utility under the "Effects" section of this tool. You get the ability to utilize this feature in two languages, including English and Japanese. The
effect provides various functions to create a visually appealing video with in-depth editing that looks professional.

Index

01How to Enter the Mocha Filmora Feature?
02Feature 1. Apply Planar Tracking
03Feature 2. Add Quick Masking and Roto
04Feature 3. PowerMesh Tracking
05Feature 4. Mesh Warp Tracking
06Feature 5. Stabilization
07Feature 6. Lens Distortion
08Feature 7. Insert Module

How to Enter the Mocha Filmora Feature?

To perform multiple tracking on plain and even surfaces in your video, Filmora Mocha offers various features that let you track motion and apply different
functionalities to it. Mentioned below is a detailed guide on how to use this utility efficiently:

Step 1. Create a New Project On Filmora

To initiate the process, launch Filmora on your device and click on the "New Project" option located on the homepage. Next, import your video to the tool's interface
and drag it to the editing timeline to perform editing.
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Step 2. Locate the Mocha Filmora Under the Effects Section

Once the video is imported into the interface, head to the "Effects" section and expand the "Boris FX" effect from the left side. Now, click on the "+" icon next to
Mocha Filmora effect to apply it to the video. Next, locate the "Effects" panel within the interface and press the "Launch Mocha UI" option. In the Mocha UI, you
can apply different operations to your video.
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Feature 1. Apply Planar Tracking

Mocha Filmora's planar tracking analyzes motion within flat surfaces, delivering more stable and reliable results than traditional point tracking.

Step 1. Create X-Spline Layer

To begin, head to the "Tools" menu from the toolbar at the top and expand the list. Next, locate the "Create X-Spline" layer to create a new layer in the plugin's
interface.
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Step 2. Select the Plain Area in the Video

Now, create points to select the surface in the video by dragging and clicking the cursor. Press the right-click button on your mouse once the selection is made to lock
the selection. Head to the bottom of the interface and enable the "Track" section. Next, select "Translation" and "Manual Track" by ticking the check box. Press the
"Track Forward" option and play the video; the planar surface will be automatically tracked along with the motion.

To learn more about the Planar tracking functionality of Boris FX's Mocha, watch this video.
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Feature 2. Add Quick Masking and Roto

With intuitive X-Spline and magnetic spline tools, users can quickly create and automatically drive mask shapes in combination with planar tracking data, reducing
manual keyframe work.

Step 1. Make Selections and Track Forward

Once you are within the Mocha UI, enable the X-Spline layer and make the selection. Now, choose your desired motion from the options provided and press the
"Track Forward" icon located below the preview window.

Step 2. Apply Matte Layer

To remove the selected object throughout the video, head to the "Input" drop-down menu and click on the "Matte for Layer 1" option to remove the selected moving
object from the video.
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Feature 3. PowerMesh Tracking

Filmora Mocha's PowerMesh enables advanced tracking of bending or warping surfaces like clothing or muscles. It adapts to complex deformations, ensuring
precision for organic motion overlays.

Step 1. Select the Moving Object

To begin, create an X-Spline layer and drag the cursor to select the non-planar area in the video by tracing around it. Next, head to the "Track" section at the bottom
and tick the checkboxes for "Mesh," "Translation," "Scale," and "Rotation." Next, locate the "Generate Mesh" button and click on it.
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Step 2. Apply Track Forward

To remove the selected object throughout the video, head to the "Input" drop-down menu and click on the "Matte for Layer 1" option to remove the selected moving
object from the video.

Discover more about PowerMesh Tracking and what it offers in this video.
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Feature 4. Mesh Warp Tracking

This feature distorts tracked surfaces using an auto-generated mesh grid, ideal for effects like screen warping or texture bending.

Step 1. Make Selections and Generate Mesh

Once you have made the selections using the Spline tool, enable the "Mesh" option from the bottom and click on the "Generate Mesh" button below.

Step 2. Choose Warp Spline and Track

Next, locate the "Warp Spline" option and click on it to enable the feature. Next, head to the toolbar below the preview window and tap on "Track Forward" to create
a distorted motion for the selected object.
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For a detailed walkthrough of Mesh Warp distortion ins Mocha UI, consider watching this video.

Feature 5. Stabilization

Mocha Filmora's stabilization removes unwanted camera shake by reversing tracking data from planar layers.

Step 1. Choose the Planar Area To Stabilize

After making the selection through the Spline tool, access the "Stabilize" section at the bottom and select the "Input Clip" and "Clip to Stabilize" using the respective
Drop-down menus. Enable the "All Motions" option and check the "Maximum Smoothing" for accurate results.
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Step 2. Activate Quick Stabilization

Once done, head to the top of the preview window and click on the "Activate Quick Stabilization" option to remove the shakiness and unwanted jitters from the
motion easily.

Watch this video to learn how you can stabilize your uneven videos with the Boris FX's Mocha UI.
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Feature 6. Lens Distortion

By analyzing linear elements in footage, this tool corrects lens distortion and outputs calibration data.

Step 1. Locate Calibration Lines

Once you have entered the Mocha module, head to the bottom and enable the "Lens" section. Next, press the "Locate Lines" option to let the tool detect the uneven
lines. Next, click on the "New Lines" to manually draw lines that you want to make even.

Step 2. Calibrate The Lines and Track Forward

Moving on, locate the "Calibrate" button to click it and then press the "Track Forward" icon to preview the video without any distortions.
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If you are interested in learning more about what this feature holds for you in term of video editing, watch this video now.

Feature 7. Insert Module

Starting from Filmora version V14.9.1, the Insert module in Filmora’s Mocha tracking workflow enhances compositing by allowing users to select any timeline layer
as the insert object directly within the interface. This integration streamlines editing by enabling precise alignment of tracked composites with existing timeline assets
to improve efficiency. The chosen insert layer acts like a regular timeline element, offering flexible control over duration and other elements like opacity.

Step 1. Make Selection By Creating X-Spline Layer

Once you have made the selection on the area where you want to insert the layer, head to the bottom area and access the “Insert” section. Now, expand the “Insert
Clip” drop-down menu and choose the “Insert Layer” option.
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Step 2. Choose the Layer in the Filmora Interface

Now, head back to the Filmora interface and access the “Effects” panel on the right. Expand the “Insert” drop-down menu under the “Tracking” section and choose
the video layer. Tap on the “Launch Mocha UI” to review the added video layer.
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Step 3. Enter Mocha Interface and Preview the Insertion

Once you preview the added video layer in the Mocha interface, access the “Insert” section to adjust like “Blend Mode” and “Opacity.”
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Explore what and how you can insert in a video while tracking motion by watching this informative video.

10.1	Chroma Key

Chroma Key is used to remove specific colors from overlay images and videos. For example, if you capture a subject against a "green screen" background or cover
part of the subject with green, you can use Chroma Key to remove the green.

You can then place the subject onto different virtual backgrounds and make some cool shots like creating a superhero flying through the sky.

Index

01Use Chroma Key to Make Selected Colors Transparent
02Creative Way to Use Chroma Key

Use Chroma Key to Make Selected Colors Transparent

Enable Chroma Key

Double-click on the clip in your timeline to open the editing panel, and check the box next to Chroma Key. You can also select the video in the timeline first and then
click on the Chroma Key icon on the toolbar to automatically enable the Chroma Key feature.

Select Color

Click on the eyedropper tool to pick a color in the image or video clip you want to make transparent in the Preview window.

  

 210/641

  

 

https://filmora.wondershare.com/basic-concept/what-is-chroma-key.html


Remove Selected Color

Adjust Settings

You can adjust the following settings to alter the video's borders, transparency, shadows, and much more.

Offset: adjusts the visibility of the backdrop
Tolerance: controls the width of the range of hues of the key color
Edge Feathering: softens the edges
Edge Thickness: adjusts the edges of the subject
Alpha Channel: turns anything keyed out appearing black and anything not keyed out appearing as white.

Creative Way to Use Chroma Key

The Chroma key makes a color range in the top layer of the clips transparent. Therefore, the background video clip or image behind the top layer could show
through. This way, you can add the green screen video as an overlay to composite a PIP video.

Import Videos to Media Library

Import both your background video and green screen clip to the media library.

Drag and Place Videos to the Timeline

Drag the background clip to the video track on the timeline, and green screen footage to the track above as shown below:
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Green Screen PiP Interface

Use Chroma Key to Remove Green Screen

Double-click the green screen clip, and then tick the Chroma Key option. By default, the green screen color will be picked and be removed automatically. You also
can refine video by adjusting the offset, tolerance, edge thickness, and edge feather settings to make the background video clearer.
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Chroma Key Settings

Preview PIP and Adjust

Check the result in the Preview window and adjust its size and position if needed.
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Chroma Key Settings

Note:

If you want to fine-tune how the green screen overlay blends with the background, you can adjust the settings on the Compositing tab.

10.2	Lens Correction

When you use the wide-angle lenses in the action camera to capture wide scenes, you may find the video clip is distorted. The Lens Correction has some presets for
action cameras such as GoPro models and Sonny that allow you to reduce distortion.

Index

01Apply Lens Correction to Remove Fisheye

Apply Lens Correction to Remove Fisheye

Enable Fisheye Lens Correction

Click on the video in the timeline to open the editing panel and then go to Lens Correction in the Video>AI Tools Tab. Click the tab to activate the fisheye
correction feature.
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Select Model

From the Select Profile drop-down list, select your camera model. Then, in the drop-down menu below, select the capture mode resolution your video was shot with.

Select Camera Model in Filmora Lens Correction

Note:

This menu will be empty until you choose the camera model.

📌Tip: The Lens Correction feature now includes presets for the GoPro Hero 9/10/11. You can find them in the device model list to easily correct distortion
from these popular action cameras with a single click.

Adjust Lens Correction Settings

Adjust the correction level by dragging the Adjust Level slide bar. Increasing the level will zoom out the video more. Check the results in the Preview window.
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Remove Lens Correction Settings

To remove the set feature, you can click the reset icon on the right side of the Lens Correction section title or its parameters. Then, the values will revert to the
default. Or click Reset at the bottom to remove all the settings you’ve made here.

10.3	Create with Instant Mode

No editing skill is needed for using an Instant Mode to create a video. Just add the media you want to show, and Filmora will make a video for you at once.

Index

01Create with Instant Mode
02Suitable User Groups
03Main Types of Templates
04Advantages of Instant Mode Compared with Timeline Editing

Instant Mode provides complete video templates. You can quickly get a nice video within your media.

Create with Instant Mode

Select Template

Find the option of Instant Mode from the startup window, click it, find the appropriate template from the right side, and the Use button will be displayed when the
mouse hovers.

  

 216/641

  

 



Select Template

Import Media and Auto Create

1Import all your media and click Auto Create.

2Add more than 5 media to unlock the Auto-Create.

Import Media and Auto Create

Quick Edit

1The left panel has three tabs, Title, Music, and Template to choose from.

2The lower panel has three setting options: Effect Control, Music Setting, and Global Setting. Click the corresponding setting option to edit it directly.

3In the Layer panel of the clip displayed on the right, select the corresponding layer to edit it directly.
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Quick Edit

Export

Export

After clicking Export, select the device to be exported in the upper part of the Export window, and then export.

For more information about exporting, see the following link:

Create Instant Mode on Filmora X
Workflow and Overview for Exporting
Export to Local
Export to Device
Export to Youtube
Export to Vimeo
Burn to DVD
Wondershare Drive

Suitable User Groups
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Editors who are not good at using the timeline mode;

B-end users who pursue efficiency.

Main Types of Templates

The main types of templates include Business, Travel, Education, Family, Holiday, Birthday, and Love with styles of Vlog, Cinematic, Slideshow, Intro, Fashion, and
Cute and Mood in Upbeat, Romantic and Happy, which individual uses, and B-end users can cover.

Advantages of Instant Mode Compared with Timeline Editing

Video generation with one click in minutes.

Easy storyboard editing.

AI automatically recognizes highlight clips.

Sample preview videos for professional designers to inspire users for clipping.

10.4	Auto Reframe

Powered by AI technology, Auto Reframe automatically detects the focal point of your video and crops it, always keeping it in the frame. This way the main action or
object of your video never goes out of sight.

You can opt to manually change the focal point of your video or choose an aspect ratio that fits your preference, depending on the social platform where you wish to
upload the video. We will show you how to use the Auto Reframe option in Filmora and manually adjust the video as you desire.

Index

01 Open Filmora and Select Auto Reframe
02 Adjust the Aspect Ratio and Motion Speed
03 Analyze and Auto Reframe the Video
04 Preview the Reframed Video
05 Export to MP4

Open Filmora and Select Auto Reframe

There are 4 ways to open the Auto Reframe feature in Filmora. You can choose to access it any way you prefer.

1 Once you open Filmora, the AI Toolbox will show the Auto Reframe option on the right side. Click to directly open the reframing feature.

Auto Reframe option

2 Import your media by clicking on File > Import Media Files and selecting the file. After your video is imported, right-click on it to select the Auto Reframe.
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Auto Reframe option

3 Another option is to click on Tools on the top menu bar and click on Auto Reframe.

  

 220/641

  

 



Auto Reframe option

4 After clicking export, you can enable Auto Reframe in the output panel.
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Auto Reframe option

Adjust the Aspect Ratio and Motion Speed

Once you have selected the Auto Reframe option, a separate dialogue box will open. If you haven’t imported your media, click on Import Media and select a single
video to import. You can change the imported video by clicking on Import at the top.

There are multiple aspect ratio templates available such as square (1:1), vertical (9:16)(4:5), standard (4:3), widescreen (16:9), and cinema (21:9). Choose the aspect
ratio depending on your preference and the platform where you will upload the video.
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Aspect Ratio

There are multiple options to adjust the speed of your video: keep it at Auto or make it Fast or Slow.

Motion Speed
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Analyze and Auto Reframe the Video

Once you adjust the settings, tap on the Analysis option. Filmora will take a few seconds to complete the analysis of your video.

Analyze Video

Then the video will be instantly and automatically reframed to your specified aspect ratio and speed. You can change or try out different aspect ratios and speed
options by adjusting Aspect Ratio and Motion Speed.

Preview the Reframed Video

After adjusting the settings and reframing, you can view the preview of your final video. In case the video needs more work, you can also play and pause it at the
point you want to adjust the frame and move the framing box to the position you desire. Do the same for the whole video just by dragging the frame window with
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your mouse. You can use tools such as Undo, Redo, Next Edit Point, and Previous Edit Point at the bottom menu. If you're using Filmora 9 or 10, please click to
learn how to reframe on the 2 versions.

Edit Options

Export to MP4

Finally, when you are satisfied with the reframed video, you can click on the Export or Add to Timeline tab.
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Export to MP4

10.5	Scene Detection

Scene Detection is an advanced editing feature offered in Filmora, which can be used to automatically split a film into basic temporal segments by detecting the
transitions between shots in a video. It will greatly facilitate your job if you don't want to edit your video frame by frame but would rather quickly edit some short
clips in a large piece of video. The steps below will show you how to do auto scene detection with Filmora.

Index

01 Open Scene Detection Window
02 Detect Scene Automatically

Open Scene Detection Window

Import media files to Filmora. You can either click the import button to bring up a pop-up window to choose files stored in your local computer, or you can just drag
and drop the files to the interface.

Once the video clip is imported, right-click the imported video and select the Scene Detection option. Or select the imported video, and then go to Tools>Scene
Detection.
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Scene Detection Option

Detect All the Scenes Automatically

In the pop-up window, simply click Detect, the original file will be separated into smaller segments in seconds. You can double-click on the segments to preview. If
you are satisfied, click Add to Timeline, all segments will then be moved to the video track on the timeline. Note: If you're using Filmora 9 or 10, click here to learn
how to do scene detection.

Detect Scenes

10.6	Motion Tracking

The Motion Tracker tool lets you track movement in your video and have objects like elements, videos, images, and text follow that movement.

Motion tracking generally requires specific hardware and software to capture and process the related data.

Index

01Apply Motion Tracking to a Video Clip
02Turn Off Motion Tracking
03Creative Ways to Utilize the Tool

Motion tracking can be used in animation. The feature allows you to break down a moving person or object into separate, identifiable parts.

  

 227/641

  

 

https://filmora.wondershare.com/guide-mac/filmora-scene-detection.html
https://filmora.wondershare.com/guide-mac/filmora-scene-detection.html


It helps to create a stored motion template. You can transfer that motion template to an animation. You can keep the elements you want and replace others with the
desired images.

Note:

Most people only need text to add details or even a touch of humor to their videos.

Apply Motion Tracking to a Video Clip

❶ Apply Motion Tracking

Click on the video clip in your timeline to open the editing menu, and you can find Motion Tracking under the AI Tools tab.

Move the tracker box over the moving object in the video you want to track and click Start Motion Track to render the effect.

The subject you want to track must be in the frame for the entire clip.
Trim the clip down and shorten it if not in the frame.
Use motion tracking to identify interruptions in their appearance in every clip.

Apply the Motion Tracking Effect

❷ Add the Object That Will Follow the Track and Adjust

Drag and drop texts, images, elements, or video clips to the track above the video, and adjust the position, size, and orientation if necessary.
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Add the Object That Will Follow the Track and Adjust

❸ Add an Object to Follow the Motion Tracking Movement

Click the motion tracking video clip in the timeline. Next, click the dropdown menu of Link Element under Motion Tracking and choose an object to follow the
tracked movement.
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Add an Object to Follow the Motion Tracking Movement

❹ Playback and Check the Tracking Result

Fine-tune the size and position of the object following the track in the Preview. You can also switch the follower at any time.

Turn Off Motion Tracking

Uncheck the Motion Tracking option in the AI Tools menu (click on your clip and go to the Video tab to access this menu).
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Turn off the Motion Tracking

Creative Ways to Utilize the Tool

❶ Censor objects in a Video with Motion-Tracked Elements

Whether it be a privacy, security, or copyright concern, every editor will eventually have to come across censoring. Filmora allows you to add custom elements to the
object.

❷ Enhance Real Estate Videos

You can modernize that pitch by doing the followings:

Attach tags, prices, and key facts to properties.

Highlight key property features by attaching motion-tracked markers.

Use virtual arrows & directions to guide viewers through the property.

Blur face, information, or ongoing construction work.

❸ Level Up Your Videos with Motion-Tracked Text

You can do the following to improve:

Make dynamic text and logo using motion-tracked callouts and elements.

Keep voiceovers concise and use motion-tracked captions to convey key pieces of information.

Visualize character thoughts, speech, attributes, etc.

Attach the names & titles of characters and objects for convenience

If you don't see this startup window, please upgrade to the latest version, and then go to File > Preferences > General tab to enable this startup window. It will show
when Filmora launches next time.

10.7	Stabilization for Windows

This guide will introduce how to use stabilization to smooth out shaky footage.

Index
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01How to Use Stabilization to Smooth out Shaky Footage

How to Use Stabilization to Smooth out Shaky Footage

Step 1: Add your videos

After launching the application, drag or drop your clip into the stock. Alternatively, you can directly drag it to the timeline.

Add your videos

Step 2: Activate the stabilization feature

Click the video in the timeline and find Video>AI Tools>Stabilization in the property panel on the right side of the interface. Click the button beside Stabilization to
activate it. Then, Filmora will analyze the video automatically.

  

 232/641

  

 



Windows activate the stabilization feature interface

Step 3: Adjust the settings

When the analysis finishes, you can change the smooth level by dragging the Smoothness.

Windows the stabilization feature settings

You can preview the result in the Player until satisfying. When you are not satisfied with the changes, drag the Smoothness again.

See how to stabilize videos on Filmora X

10.8	AI Smart Cutout

This guide helps you remove the background of an image or a video. The AI Smart Cutout is good at cutting an image out and performs well in identifying needed
sections in a continuous clip.
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01Apply AI Smart Cutout to Images on Windows
02Apply AI Smart Cutout to Videos on Windows

Apply AI Smart Cutout to Images on Windows

Here are the steps for processing images with smart cutout on Windows.

Step 1: Add the image to the processing interface

Launch Filmora on your computer. Then, drag your required image to the bottom of the interface or select it from the files.

Step 2: Launch the Smart Cutout event
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1Click the image on the timeline to launch the settings window.

2Click Image>AI Tools to start a new task.

3Then, click the button beside Smart Cutout to start the function.

4After it, you need to click the Click to start to analyze to process cutout.

Step 3: Draw the section you need

Use the Brush to draw the area to cut out. A simple line around the edge of the subject is enough for the tool to recognize where you need it.
If some unwanted areas are selected, you can click the icon, which is an Eraser with a minus to erase them.
If you have amplified the image and want to move the image for more detailed adjustments, use the Palm.

Step 4: Change the settings

Simple Mode Setting

On the right side of the interface, there are settings of Brush Size, Edge Thickness, and Edge Feather.

The Brush Size is used to draw more precisely, with the size ranging from 1 to 300; Edge Thickness is to modify the margin encircling the subject, ranging from -100
to 100; If you want to adjust harsh edges to blend images, you can change the figure of Edge Feather.
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Invert Mask

If you want to retain the background not chosen, you can click the Invert Foreground/Backg icon, as marked in the image below.

Preview Mode - Background

After confirming the selected area, you can set the background of the image. Click the bust icon in the upper right corner of the window and choose from Toggle
Alpha Overby, Toggle Transparency Grid, Toggle Transparency Black, or Toggle Alpha. Then, change the edge thickness or the edge feather on the left side of
the window if you need.
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Step 5: Save the changes

When you are done with the settings, click Save. Then, the effect will be applied to your image automatically.

Apply AI Smart Cutout to Videos on Windows

You can follow the procedures below to remove the background in a video on Windows.

Step 1: Launch the application and add a video to the prompted interface.

Step 2: Click the video in the processing section, and the video settings window will appear. You can click AI Tools in the Video tab, and after clicking the button to
launch Smart Cutout, click the bust icon.

Step 3: Use the brush icons to select your demanded area in the video. The brush with a plus is used to draw where to cut out, and the eraser with a minus is used to
erase. Flexibly apply features such as Edge Thickness and Edge Feather to increase the quality.

Step 4: Find Click to start the Smart Cutout icon in the Simple Mode section and click it. Then, Filmora will extract the selected subject from the whole video and
export the output in a short while.

Step 5: Change the background of the video by clicking the bust icon in the upper right corner. Also, you can change more advanced settings in the Advanced Mode
tab to decide which part of the video to process. You can set the mode from Track One Section Reverse, Track Reverse, Track Forward and Reverse, Track
Forward, and Track One Section Forward.

Step 6: Click Save when you finish editing. The interface will go back to the home editing page and apply your adjustment.

10.9	AI Image

ChatGPT, the popular chatbot from OpenAI, is widenly used and becoming increasingly popular. This also means that AI has become the demand of more creators.

To meet more creative needs of creators, Filmora has added ai content generator technology to the product. You can directly experience the function of generating
images from text through AIGC.

Index

01Start AI Image
02Describe the Image You Want to Generate
03Start Creating

AIGC has already implemented text and image generation in the Filmora web terminal. We will continue to expand image generation/ai intelligent editing in the
future.

Note:

If you feel the picture generation effect is unsatisfactory, you're more welcome to give us feedback through the Support Center. So let us hear your voice and
continue to optimize.

Start AI Image

Find AI Image next to the Import button in the media panel. Click and start your creative journey. The operation interface of AI Image will appear in the form of a
pop-up window.
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AI Image

Note:

Make sure your Filmora has been upgraded to the latest version before operation.

Describe the Image You Want to Generate

The operation steps are straightforward. You only need to enter the image description you want to generate in the input box, select the ideal resolution, and click Start
Creating to develop it with one click.

It helps to create a stored motion template. You can transfer that motion template to an animation. You can keep the elements you want and replace others with the
desired images.

Note:

A small print on the button Start Creating will remind you of the number of images left to create.
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Describe the Image You Want to Generate

Start Creating

The generated pictures can be directly added to your media panel by clicking the download icon in the lower right corner of the picture.

Download AI Image

Drag and drop the generated image into the timeline for direct and in-depth editing. Click to edit images on Filmora 9 and 10
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AI Image Folder

10.10	ChatGPT Plugin - AI Copywriting

Copywriting is a powerful tool for selling your products or services through a copy leveraging call-to-action text. Humans have been using this tool for a long time;
however, the introduction of AI Copywriting has just transformed the overall scenario with its quality and speed.

Similarly, the new version of Filmora on Windows now offers AI Copywriting to auto-generate your video scripts, captions, and more with ChatGPT. In this guide,
you’ll learn how to use AI Copywriting in Wondershare Filmora:
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01Before Video Creation
02During Video Editing
03After Video Editing

Before Video Creation

Step 1: Launch Wondershare Filmora and Access AI Copywriting

First, start Wondershare Filmora ( 12.1.8 above) on your Windows computer and proceed to the "Toolbox" category from the left panel. Then, continue to select the
"AI Copywriting" button on the available screen to open another window.
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choose ai copywriting feature

Step 2: Ask Questions to Generate Pre-Video Content

Select your content type, enter your video topic, choose the output language, generate the text, and then review and edit it as needed.

add the desired questions

During Video Editing

Step 1: Open Filmora and Create a Project

The first step involves launching Wondershare Filmora on your Windows device and continuing to select the "New Project" button in the "Create Project" section.
This will launch the editing interface of Wondershare Filmora, where you can apply necessary effects, elements, stickers, and transitions to your video, apart from
other numerical adjustments.
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create a filmora project

Step 2: Open AI Copywriting Alongside Filmora Project

Along with creating a new project, you have two options to access Filmora’s AI Copywriting. You can launch the "AI Copywriting" tool before creating a new
project or get access to it when you are editing the Text in the Timeline. Double click the Text element in the Timeline and a customization panel will pop up. You
can tap the AI icon in the top right corner of the Title tab.
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access ai copywriting tool

After Video Editing

Step 1: Create a Project and Export the Final Video

In another scenario, you can create an entire video on Wondershare Filmora and proceed to the "Export" window to save the edited file. For such cases, you can
make use of AI Copywriting for the optimization of the video name and generate social media titles for your created videos. Hence, after completing a video, click
the "Export" button to open a new window.

press the export button

Step 2: Open AI Copywriting Tool in Export Window

As you find yourselves in the “Export” window, click the “AI” button appearing adjacent to the “Name” option in the window. This will launch the AI Copywriting
tool where you can ask a question against the video title and click “Submit.”
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tap on ai tool

Step 3: Use AI Copywriting While Exporting Video

Even if you have tapped on the "Export" button and proceeded to conclude the creation of your video, you can still utilize the AI Copywriting tool for a title and
description for your social media. As you select the AI Copywriting option appearing on the video exporting screen, the window opens where you can ask the
respective questions.

select ai title and description option

10.11	AI Portrait Cutout

With the help of Artificial Intelligence technology, AI Portrait Cutout can automatically detect the portrait in video or image and remove the background directly. You
can remove the background easily without a green screen(chroma key) background. Moreover, we have 70+ body effects and sticker effects available, you can add
body effects to make your video stand out.

How to Use AI Portrait Cutout?
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02 Enable AI Portrait Cutout
03 Preview and Adjust the Footage
04 Add Body Effects
05 Export and Share

Step 1: Import and Add Media Files to the Timeline

If you have Filmora installed, open the program and create a new project. Import the background video and portrait footage onto the media library. Drag your
background video or image onto the first track of the timeline. then place your portrait video or image on the track above it.

Import Media Files

Add it to the Timeline

Step 2: Enable AI Portrait Cutout

Double-click on the clip in your timeline to open the editing panel, and check the box next to AI Portrait Cutout. You can also select the video in the timeline first
and then click on the AI Portrait Cutout icon on the toolbar to automatically enable the AI Portrait Cutout feature.

AI Portrait Cutout offers two modes:

Advanced Cutout Mode and Quick Cutout Mode

  

 244/641

  

 



Enable AI Portrait Cutout

Step 3: Preview and Adjust the Footage

Once you enable the AI Portrait Cutout feature, Filmora will automatically make the background of portrait footage transparent. You can preview the video, adjust
the portrait's position, and ensure it meets your needs.

Preview and Adjust the Footage

Step 4: Add Body Effects

These effects can be used to enhance, alter, or stylize the appearance of the subject.

Choose the Body Effects

Method 1: Select the Preset Body Effects in the AI Portrait Cutout panel, and then adjust the parameters as needed.

  

 245/641

  

 



Choose Body Effects from AI Portrait Cutout Panel

Adjust the Parameters

Method 2: Go to Effects>Body Effects on the top toolbar. You will see all the body effects here. Click the Body thumbnail and check it in the preview window. To
add the Body effects, drag the body effect to the timeline or click the Add icon on the Body Effects thumbnail.

Add Body Effects

Preview Body Effects

Elongate or shorten the effect to fit the video clip length. Play the video and check the results. Add multiple effects to the clip by dragging and dropping them to the
timeline.
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Preview Body Effects

Adjust Body Effects

Adjust the settings of the effect to get the best results. Different effects have different settings. Double-click the added effect in the timeline and scroll down to Video
Effects, check the settings of the portrait effect that you can change.

Body Effect Settings

If you are not satisfied with your settings, you can click on the Reset button next to the value boxes.

  

 247/641

  

 



Reset Body Settings

Delete Body Effects

To delete the Effects, you have three ways:

Select the unwanted Portrait Effects and tab the Delete .
To delete multiple Effects, click on Ctrl to select several Effects at one time, and then click Delete.
Right-click on the effect, and then select Delete.

Delete Body Effects

Step 5: Export and Share

Click Export when you finish editing and choose the format you want to save. Using Filmora 9 or 10? Click here to add AI portrait.

10.12	AI Smart Masking for Windows

Editing video elements independently is an important part of video creation, and Filmora's masking provides multiple options. However, with the V13 upgrade, users
can activate the AI Mask, and it will automatically detect objects that can be masked. To save yourself time and effort and enjoy this option,
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01How to Enable AI Smart Masking
02How to Disable AI Smart Masking

Free Download Free Download Free Download Find More Tutorial

How to Enable AI Smart Masking

Modern video editing requires modern tools, and here is a step-by-step guide to using Filmora's AI Smart Masking option for an up-to-date editing experience:

Step 1: Install Filmora and Initiate a New Project
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To start editing with Filmora, install and initiate the software on your desktop. Afterward, from the top of the main screen, log in to your account and navigate toward
the left panel. Select the "Create Project" option and choose "New Project" from the displayed options.

Click the new project option

Step 2: Import Media and Place it on Timeline

Creating a new project will lead you to the main editing interface of Wondershare Filmora. From the top toolbar, select "File", expand the "Import Media" option
from the dropdown menu, and choose a suitable method for import. After importing your media clip, pull this clip with the help of a mouse or trackpad and place it
on the timeline track.

Import media from files tab

Step 3: Activate AI Mask Option

To start masking, select your clip in the timeline and hover the mouse towards the settings panel. Under the "Video" tab, select the "Mask" option and choose the
"AI Mask" icon.
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Enable AI Mask option

Step 4: Choose the AI Mask Option

This expands the "AI Mask" section, where you have to select from the given options per your requirements. There are multiple options like the "Smart Brush",
"Select Character" or "Select Subject" to choose from. Select further from the given options and continue to choose the "Add Mask" button for detecting an
automatic mask on the video.

Select the type of mask

Step 5: Adjust the Relative Settings and Export

If you specifically go with the "Select Subject" option and select any detected object through AI, you will get the opportunity to adjust other mask settings such as
"Expand", "Blur Strength", and "Opacity". Furthermore, you can also enable motion tracking from the "Path" and "Invert Mask" options for your clip. Once
finished, click the "Export" button at the top right corner and save your video on your device.
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Adjust other mask settings

How to Disable AI Smart Masking

Way 1: From the Reset Button

Once you've enabled the AI Smart Masking and want to reset or delete it, navigate towards the bottom of the settings panel and click the "Reset" button.

Press reset button in settings panel

Way 2: From the Trash Icon

In the second method, select the clip and navigate towards the right side panel. Choose the "Mask" option in the "Video" tab and go to the "AI Mask" section. Click
on the "Bin" icon adjacent to it, and the mask will be deleted.
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Click bin icon to delete mask

10.13	AI Skin Tone Protection for Windows

Do you find it troublesome when skin tone becomes distorted after applying LUT? Filmora has come up with the perfect feature to fix this issue. The recently
launched version has a Skin Tone Protection feature that uses AI to analyze the tones and make them right. Follow this guide and know how to apply it.

How to Enhance Skin Tone Using Filmora’s New AI Feature

Step 1: Launch Filmora on your Desktop and Start a Project

If you have not downloaded Wondershare Filmora on your desktop, download it. Once you have it opened, log in or sign up and head towards the left side panel to
select "Create Project". Multiple tabs will display on the main screen, out of which you must select the "New Project" option.

Click the new project button

Step 2: Import Media and Drag it to the Timeline

After creating the new project successfully, you will be led to the main interface of Filmora. From the custom toolbar, select the "Media" tab and further select
"Project Media" from the categories available at the left panel. Select "Import" to upload your media files, and drag and drop these files onto the timeline.
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Import video clip into the timeline

Step 3: Access the AI Skin Tone Option

For the final step of getting skin tone protection, select the clip in the timeline, hover the mouse towards the right-side panel, and click the "Color" tab. Furthermore,
select the "Basic" option, and under the "LUT" section, you'll find the "Protect Skin Tones" slider. You can increase or decrease the level of skin tone protection
by adjusting the slider or entering a value in the box.

Enable protect skin tone functionality

Step 4: Export the Edited Video

Once you’ve edited your video and applied all the effects and filters, it is time for finalization. Click the "Play" button in the preview screen to see the final results,
and if you are satisfied, navigate towards the top right corner and click "Export". From the export window, name your video, make other adjustments, and tap on the
"Export" button to download it on your device.
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Click the export button

10.14	AI Text-Based Editing for Windows

Filmora now offers dedicated AI Text-Based Editing to make video editing easier. It is a progressive step in video editing because users can auto-remove the silent
clips from a video and trim or cut a video through text. To explore more about this function and its utility, check the detailed guide for it:
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How to Enable Text-Based Editing for Windows

There are several alternative approaches to enable text-based editing on Windows, and this guide is going to reveal all of them for you below:

Method 1: Using the AI Text Based Editing from the Main Menu

Step 1: Launch Filmora and Select AI Text Clipper

Before using this feature, download and install the Filmora V13 software on your PC. Once it is successfully downloaded, launch it and login or sign up accordingly.
Hover the mouse towards the settings panel and select "Create Project". Then, from the options appearing on the main screen, select "AI Text Based Editing".
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Click the ai text clipper tab

Step 2: Import Files and Enable Text-Based Editing

After selecting the AI Text Based Editing, your device's "File Explorer" will appear. Double-click on the clip you want to edit, leading to a mini-window. Select
"Text-based editing" from the available options and choose your preferred language. By clicking on the "OK" button, the video will start transcribing for editing
through texts, and you'll be able to see the conversion progress.
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Choose text based editing option

Step 3: Start Text-Based Editing

Once the conversion is complete, the editing window will appear. Users can eliminate a portion of the video by removing a text by utilizing the text box on the right
side. In addition, they can search for a particular word or phrase or apply the "Delete all silent clips" option for further optimization. Upon making the desired edits,
click the "Export to Timeline" button at the bottom right corner.

Edit your clip accordingly in textbox

Step 4: Additional Adjustments and Export

Now that your video is in the timeline panel, you can experiment with the visual and audio elements of the clip. Users can enhance audio quality, adjust color, and
add multiple effects or transitions. Once the desired settings are made, navigate towards the top right corner and tap on the "Export" button. From the export
window, adjust settings and click "Export" again to finalize.

Make adjustments in timeline and export

We will be looking into some techniques that can be used to access the similar AI text-based feature in Filmora:

Method 2: Using the Timeline Dropdown Menu

Another way of accessing this feature is from the timeline toolbar. After importing media into the timeline panel, select and right-click on it. A dropdown menu will
appear; scroll down and choose the "Smart Edit Tool" option from the available ones. Furthermore, select the "AI Text Based Editing" option. Furthermore, follow
the same process of editing and importing the video.
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Right click on timeline clip

Method 3: Using the Timeline Toolbar

Select the clip in the timeline, and navigate towards the timeline toolbar to select the "More" icon. Select the "AI Text Based Editing" option across the dropdown
menu. Continue to select "Text-based Editing", after selecting a language, click "OK". Afterward, the process of editing and importing this edited clip is the same as
before.

Tap more from timeline tool panel

Method 4: Using the Top Toolbar Option

Navigate towards the clip in the timeline, select it, hover the mouse towards the top toolbar, and select the "Tools" option. From the dropdown menu, select "Audio",
and from the further options, select "AI Text Based Editing".
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Choose file tab in top toolbar

10.15	Super Slow Motion with Optical Flow for Windows

With Filmora's new upgrade, users can add slow motion to their videos and optimize them. Moreover, the AI algorithms involved in this feature ensure a smooth
optical flow and maintain video quality. To make creative and trendy slo-mo with Filmora, keep reading the sections below:

Create a Super Slow-Motion with Optical Flow

With this new AI feature, users do not need assistance from an expert, as the AI can handle everything. Here is a step-by-step guide to using Wondershare Filmora for
creating slow-motion videos:
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01Method 1: Using the Settings Panel
02Method 2: Using the Timeline Options Menu
03Method 3: From the Top Toolbar

Method 1: Using the Settings Panel

Step 1: Log in to Filmora and Create a New Project

After successfully downloading the software on your device, move toward the bar at the top, select the "Profile" icon, and log in. Once logged in, click the "New
Project" button from the main menu.

Tap on the new project button

Step 2: Import Clip and Drop it to Timeline
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After reaching the main interface of Filmora, press the "Ctrl + I" key on your keyboard and import media from your PC's "File Explorer". Once the media files are
in the import section, drag and drop them to the timeline with the help of your cursor.

Import media to timeline

Step 3: Activate the Optical Flow

Select the video you just dropped into the timeline and navigate to the right settings panel. Then, select the "Speed" tab and choose "Uniform Speed" further.
Expand the "AI Frame Interpolation" and select "Optical Flow" from the given options.

Enable optical flow from settings panel

Step 4: Render Preview or Export for Results

To see the final results, go to the timeline toolbar and select "Render Preview". In addition, you can also export your video to see the outcome.
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Click export to see final results

Method 2: Using the Timeline Options Menu

After bringing media to the timeline, navigate your cursor toward the clip in the timeline track and right-click on it. From the options panel, choose "Uniform
Speed". Further, follow the same steps mentioned above.

Right click on the timeline

Method 3: From the Top Toolbar

Select your clip that is in the timeline track and navigate towards the top toolbar. From there, select "Tool", and expand the "Speed" option from the dropdown menu.
Furthermore, choose "Uniform Speed" from the given options. Afterward, follow the same process to move further.
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Press tool tab from top toolbar

10.16	AI Mate Editing for Windows

AI assistants play an essential role during editing, and with Filmora's new AI Mate Editing feature, users can ask for valuable insights about their videos. It does not
edit the video, which can be done using other AI and manual editing features. However, it tells you what is missing in a video to make it exceptional. Here is a guide
about accessing and enabling this AI guiding feature of Filmora:

Steps to Use AI Mate Editing in Filmora

01Step 1: Create a New Project to Start
02Step 2: Access the AI Mate Feature
03Step 3: Ask the AI Mate
04Step 4: Access Specific Functions From AI Mate Feature

How to Access AI Mate Editing?

There is one way of accessing this feature in Filmora, and this section will take you through a step-by-step procedure to use it.

Step 1: Create a New Project to Start

Download and launch Filmora on your desktop; then, navigate your cursor toward the "New Project" button and click it.

Create a new project on filmora

Step 2: Access the AI Mate Feature

Once you are in Filmora’s editing interface, locate the timeline toolbar and navigate towards it. From the given options, choose the "AI Mate" feature.
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Click the AI Mate button

Step 3: Ask the AI Mate

Doing this will enable AI Mate editing, and a new window named Filmora Copilot (Beta) will appear. It looks like a chatbot, and you will see several feature options
to choose from in this box:

Add Resources: Add transitions, text, effects, audio, or music.
Audio Adjustment: Extract background music or generate AI-powered music.
Picture Adjustment: Adjust video speed, apply blurred backgrounds, and more.
Format Adjustment: Quickly export videos to MP3, GIF, or other formats.
Timeline: Mark segments, clean up the timeline, and adjust clip duration.
Search: Quickly locate features or assets.

Choose the feature you need

Depending on your editing needs, select the appropriate feature. For instance, click on Add Resources. In the text input box, the AI Mate will provide predefined
templates for commands. You only need to fill in the required keywords in the placeholders. For example: I want to add a Transition at the Outro of the clip(s). The
style should be Smooth Transition. After typing your request, click the Send button, the AI Mate will analyze your input and generate tailored suggestions or
execute the task directly.
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Input your command

Once the AI Mate generates suggestions, click on Expand Info to view task details and the list of recommended transitions or resources. From the displayed resource
options (e.g., Dissolve 03, Fade), select your desired transition effect. The selected transition will be automatically applied to the outro section of your clip(s).

If you want to adjust or add other effects, continue entering new instructions in the text box. The AI Mate will handle additional tasks accordingly.

Ask the copilot for suggestions and handle tasks directly

Step 4: Access Specific Functions From AI Mate Feature

If you ask the AI Mate feature about a particular function in Filmora, it not only answers but also guide you to the exact functionality required to fulfill the task. After
the task is completed, you can either refine the results or ask Copilot additional questions to assist with other parts of your video editing project.
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Access features directly from AI Mate

10.17	AI Text-to-Video for Windows

Filmora for Windows offers a dedicated Text-to-Video feature, enabling users to convert written scripts and prompts into engaging videos. Users get the ability to
input text and select the video language according to their preferences. Moreover, they also get the ability to select the aspect ratio and duration for the video to be
generated. The negative prompt feature specifies things you do not want to include in your generated video.

The platform offers two modes of video generation using advanced AI. The normal mode creates videos across the prompts and other settings according to your
preferences. Whereas the Google Veo 3 mode offers high-quality video generation with relevant background music added. Read the steps mentioned below to learn
how to use different modes of Filmora AI Text to Video on your Windows:

Mode 1. Normal Mode

Step 1: Start By Opting For Text To Video

After launching the tool on your Windows, locate and press the Text to Video feature from the homepage.
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Access AI text-to-video homepage

Step 2: Choose the Normal Mode and Enter Prompt

Expand the Normal Mode drop-down menu within the Text-to-Video interface and input your prompt in the text field, mentioning the specifications.

Add prompt in normal mode
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Step 3: Configure Other Settings and Generate

Moving forward, type the negative prompt to avoid things you don’t want to include. Configure the video settings such as Resolution, Duration, and Aspect Ratio
from the options provided. Finally, hit the Generate button to execute the video creation process.

Define other generation settings

Step 4: Preview the Generated Video and Export

Once the video is generated as per your given prompts, drag it to the timeline and preview it by tapping on the Play button. Once you are satisfied with the results,
press the Export button to save the video to your device.
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Preview your video and export it

📌Note:

To ensure transparency and compliance when using Filmora's AI features, please be aware of the following:

The software interface will clearly identify all content created by AI.
For traceability, exported or downloaded AI-generated assets may include a visible or invisible watermark.

Mode 2. Google Veo 3

Step 1: Choose the Google Veo 3 Mode

After choosing AI Text to Video from the homepage of the tool, expand the Google Veo 3 mode using the drop-down menu in the following interface. Input the text
prompt and select the Mode from the options. Next, hit the Generate button to execute the video generation process across the input text provided.
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Select Google Veo 3 mode

Step 2: Play The Video and Save Once Satisfied

Expand the Normal Mode drop-down menu within the Text-to-Video interface and input your prompt in the text field, mentioning the specifications.

Export final veo 3 video

  

 268/641

  

 



10.18	Instant Cutter Tool for Windows

Filmora's Instant Cutter tool is designed for situations when immediate video trimming is necessary. It supports HEVC (H.265) videos and offers lossless editing,
allowing you to cut and trim your videos without losing quality. We have outlined the step-by-step procedure for accessing this tool:

Index

01Method 1: Using the Instant Cutter Tab in the Main Menu
02Method 2: Using the Top Toolbar
03Method 3: Using the Project Media Section

Importing Media with Instant Cutter Tool

In this section, you will learn about accessing and employing Filmora's Instant Cutter Tool in three different methods. This exists as an independent feature; however,
users can also access it indirectly using the methods discussed below:

Method 1: Using the Instant Cutter Tab in the Main Menu

Step 1: Launch Filmora and Access the Tool

After performing the compulsory task of installing Filmora, launch it on your PC. Upon accessing its main display, navigate towards the tabs featured there and click
the "┇ " symbol until you find the "Instant Cutter" tab and select it.

Click on the instant cutter tab

Step 2: Import Media in the Instant Cutter Window

Filmora's Instant Cutter window will appear once you employ this action. Under the "Trim" tab, click the "Open File" button to import a clip from your device.

Click the open file button
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Step 3: Trim the Media Clip and Export It

Once the clip has been imported into this window, change the slider's position to set your clip's starting and ending points. Once you have cut your clip, click the
"Play" button to check if the duration is correct and hit the "Export" button.

Trim media and click export

Step 4: Adjust Export Settings

Upon clicking the "Export" button, a small pop-up will appear. You can customize the export setting from there, like the file's location. After adjusting the desired
settings, click "OK", and the export progress will appear. Once the export procedure completes, you can access your file from the folder you saved it in.

Set file location and press ok

Method 2: Using the Top Toolbar

Create a new project in Filmora to access its main interface after launching it. Head in the direction of the top toolbar using your cursor and click the "File" tab.
Expand the "Import Media" option from the dropdown menu and choose "Import with Instant Cutter Tool".
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Access file tab to import media

Method 3: Using the Project Media Section

Upon reaching Filmora's editing interface after creating a new project, proceed toward the "Project Media" section and find the "Import" button. Click on it, and
select the "Import with Instant Cutter Tool" option from the expansion menu.

Access project media to import

10.19	AI Smart Search
 AI	smart	search	aims to improve editing efficiency for users who work on many videos. It will intelligently detect human faces from your video clips, and you can
also search for other visual objects from the videos such as text, lines, trees, sunsets, flowers, etc.

How to Use AI Smart Search?

Here are simple steps to activate and use AI Smart Search.

Step 1: Import Video Clips

Import the video clips to Wondershare Filmora.
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Step 2: Access to Smart Search

Go to Media > Project Media > Click on Default, under the droplist, you will see the option

of Smart, then click it to activate this feature.

Step 3: Start Searching

Whether you want to search the lines, visual elements, or people, type any words into the search box and then press Enter on the keyboard. It will search the element
from all the video clips and produce quick results.
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Step 4: Drag to the Timeline

Preview the results, and drag them to the timeline to edit.

10.20	AI Object Remover
 AI	object	remover	utilizes intelligent technology to remove any unwanted objects and elements from videos or photos easily, such as texts, emojis, watermarks,
logos, and passersby. It can not only process static images but also dynamically track the movements of the selected elements.
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How to Use AI Object Remover?

Index

01Import and Add Video/Photo Files to the Timeline
02Access to AI Object Remover
03Draw Out the Area by the Brush
04Preview and Apply the Results

Step 1：Import and Add Video/Photo Files to the Timeline.

Import the media file to Wondershare Filmora and add it to the timeline.

Step 2: Access to AI Object Remover

Select the Video clip or photo on the timeline, click the custom bar, navigate to AI Object Remover from the toolbox, and drag it to the toolbar so you can see it in
the editing area.

Step 3: Draw Out the Area by the Brush

Choose AI Object Remover, then draw out the area you want to remove using the smart brush on the window.
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Use the Eraser to adjust the area precisely.

Step 4：Preview and Apply the results

For the video object remover, you can preview the video by clicking the preview button. Then, click Remove to apply the results to the video clip or photos.
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Wait until the removal process finishes.

Finally, Export the video or photos.

10.21	AI Face Mosaic for Windows
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The AI Face Mosaic feature is an advanced tool designed to recognize and protect faces in videos or images automatically. Utilizing intelligent mosaic application
technology, this feature can track and cover faces in real-time, ensuring that privacy is safeguarded regardless of face movement within the frame.

Index

01Apply AI Face Mosaic
02Adjust AI Face Mosaic

Apply AI Face Mosaic

Here is the guide on how to apply AI Face Mosaic on Windows.

1. Open Filmora and Click More, then you can access Toolbox.

2. Click on AI Face Mosaic > Import a Video or a photo.

3. After importing the video, Filmora will automatically analyze the video, you can check the progress.
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4. When the video analysis is complete, each face in the video will be automatically mosaicked.

5. Open Invert to apply the mosaic effect to the screen except for faces.

Adjust AI Face Mosaic

You can choose which face need to be applied with mosaic effect and adjust the Strength, Feather and Opacity.

1. Deselect a face so that it will not be mosaicked.
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2. Adjust Strength, Feather, and Opacity to adjust the mosaic effect.

10.22	Video Denoise for Windows

Video Denoise is typically used to remove visual noise from video clips. With the magic of AI, Filmora's video denoise works great on clips that were shot in low
light and high ISO environments and supports customizing the smooth level from weak, normal to strong. Let's learn how to denoise video to enhance visual clarity
and quality now with a simple click today!

How to Denoise Videos in Filmora?

Index

01Import the Video to Wondershare Filmora
02Add the Uploaded Clip to the Timeline
03Navigate and Switch on Video Denoise
04Preview and Export the Denoised Video

Step 1：Import the Video to Wondershare Filmora

Go to Media > and click Import to upload videos to Wondershare Filmora.

Step 2: Add the Uploaded Clip to the Timeline

Click the "+" button to add the clip to the timeline, or simply drag and drop it to the timeline.
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Step 3: Navigate and Switch on Video Denoise

To denoise videos, select the video clip on the timeline, go to Video > AI Tools > Video Denoise, and switch on the option.

At the same time, you can move the slider to adjust the smooth level to enhance visual quality. Here, you can customize it from weak to normal to strong.
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Step 4：Preview and Export the Video

Wait until the process finishes. Then, preview and export it to save.

10.23	AI Video Enhancer

AI Video Enhancer is designed for videos that are unclear or lack detail due to being filmed with older, low-resolution equipment or having dirty lenses. Users can
improve the clarity of the original video with a single click, meeting their expectations for a simple and efficient way to enhance video quality.

Filmora now offers two powerful ways to use this feature: the standard Cloud-Based Enhancement and the new Local AI Enhancement, which removes all
duration limits for users with compatible hardware.

Upon reading this guide, you will learn about how to enhance your video quality:
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Introducing Local AI Enhancement: No More Limits

To overcome the duration limits of cloud processing, Filmora has introduced a powerful local processing mode for the AI Video Enhancer. By running the algorithm
directly on your computer's hardware, you can enhance videos of any length and resolution without waiting in a queue.

Key Benefits:

No Duration or Resolution Limits: Enhance long videos, full-length clips, or high-resolution footage without restrictions.
Zero Cost: Local processing does not consume credits or require additional payment.
Superior Quality: On-device processing can deliver more precise noise reduction and edge sharpening, resulting in improved detail and clarity compared to
the cloud version.
Streamlined Workflow: A one-time setup is all you need to unlock unlimited video enhancement.

Hardware Requirements:

To use Local AI Enhancement, your system must meet the following requirement:

Graphics Card: NVIDIA GeForce RTX 30 series or higher.

Filmora will automatically detect your hardware. If your system is compatible, you will be prompted to download the necessary local AI model.

Step 1: Import and Add Media Files to the Timeline
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Import your video clips into Wondershare Filmora and add them to the timeline.

Import Media Files

Add it to the Timeline

Step 2: Enable AI Video Enhancer

Double-click the clip on the timeline to open the editing panel. Navigate to Video > AI Tools. Here, your workflow will depend on your system's hardware.

For Users with Compatible Hardware (First-Time Setup):

1. If your NVIDIA RTX 30 series (or newer) GPU is detected, you will see an On-device generation button. Click it to download the local processing model.
This is a one-time download.

2. Once the download is complete, enable the toggle next to AI Video Enhancer.

Download local processing model

Note:

Filmora will also check your graphics driver version. If your driver is outdated, a pop-up will appear to guide you to the official download page to update it.
3. With the local model installed and the feature enabled, the enhancement will process on your device with no limits.

For All Other Users (Cloud-Based Enhancement):
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1. Enable the toggle next to AI Video Enhancer.
2. Click Generate to begin the analysis and processing via the cloud.

Enable AI Video Enhancer

Cloud Processing Limitations:

This standard method is subject to limitations based on media resolution and duration:

For media with a resolution greater than 1080P, the video clip's duration must be 1 minute or less.
For media with a resolution equal to or less than 1080P, the video clip's duration must be 3 minutes or less.

Step 3: Preview the Enhanced Video

Once the task is complete, the enhanced clip will be generated automatically in the media area.

Preview the Enhanced Video

The timeline will also be updated with the HD version. Click Play to review the results on the preview window.

  

 283/641

  

 



Preview the Enhanced Video

Step 4: Export and Share

When you finish editing, click Export and choose your desired format to save the final video.

10.24	Planar Tracking

Planar Tracking is a video editing and visual effects technique for tracking the movement of flat surfaces within a video. It precisely follows objects on a two-
dimensional plane, such as billboards or screens, and allows for advanced integration and manipulation of video elements. This tool is ideal for tasks such as license
plate obscuring or billboard replacement.

This guide explains how to use Planar Tracking in your videos on Windows:
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06 Export and Share

Step 1: Import and Add Media Files to the Timeline

Open the application on your computer, import your media files into Wondershare Filmora, and add them to the timeline.

Import Media Files

Step 2: Locate Planar Tracking

Method 1: Double-click the clip on the timeline to open the editing panel. Navigate to Video > AI Tools and click the button next to Planar Tracking to activate the
feature.
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Locate Planar Tracking from Editing Panel

Method 2: Click the tracking icon on the toolbar below the timeline, then select Planar Tracking.

Locate Planar Tracking from Toolbar

Method 3: Click Tools in the top menu bar, then choose Video > Planar Tracking.

Locate Planar Tracking from Tools

Step 3: Select a Planar Tracker
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There are two Planar Tracker modes available, allowing you to choose the one that best fits your needs:

Planar Tracker Modes

Auto Planar Tracker Mode

Select and Adjust Tracking Points

Click "Auto mode" on the panel. In the preview window, select the target you want to track and adjust the four tracking points accordingly.

Select and Adjust Tracking Points

Start Tracking

Click Start to begin tracking once you adjusted the tracking points.
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Start Tracking

This will enter rendering mode, which only supports rendering a single clip on the timeline.

Render Mode

Note:

During this process, the clip on the timeline will be grayed out and will not be selectable or movable.

Preview Tracking Points

After tracking is complete, play the video on the timeline to ensure the four tracking points follow the target object correctly. You can make single-frame adjustments
to some inaccurate results.
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Preview Tracking Points

You can choose to hide or show the tracker in the settings panel.

Hide or Show the Tracker

Advanced Planar Tracker Mode

Select and Adjust Tracking Points

Click Advanced mode on the panel. In the preview window, select the target you want to track and adjust the four tracking points.
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Select and Adjust Tracking Points

You can also adjust the accuracy level in the panel.

Note:

The higher the precision, the longer the processing time.

Adjust the Accuracy Level

Start Tracking

You have four options to choose from. Select the one that best suits your video clips to start tracking. For footage with significant shaking, it is recommended to use
frame-by-frame analysis. You can click anywhere in the software to stop the tracking process.

Start Tracking

Note:

During this process, only the tracked clip and tracking box will be displayed in the player. The timeline will be greyed out, highlighting only the tracked clip.
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Render Mode

Preview Tracking Points

After tracking is complete, play the video on the timeline to verify that the four tracking points are correctly following the target object. You can choose to hide or
show the tracker in the panel.

Preview Tracking Points

For any unsatisfactory parts of the tracking results, you can adjust and re-analyze starting from the frame where the error first appeared. For videos with significant
shaking, you can even use the frame-by-frame analysis method, adjusting one frame at a time, to ensure perfect tracking results.
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Adjust the Tracking Results

Step 4: Select Linked Elements

You can link elements by importing media from computer, selecting timeline clips, or applying mosaics.

Timeline Clip: After adding videos or images to the timeline, use the dropdown menu to select the clip above the current one.

Import from Timeline Clip

Import Media: Click "Import from Computer" to add local videos and images.

Import from Computer

Mosaic: Click "Add a mosaic" and apply it.
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Add a mosaic

Once an element is linked, it will be marked with a “link” icon. Add “Corner Pin” properties to the linked clip.

Select Linked Elements

Step 5: Adjust Linked Element Parameters

Select the linked elements and adjust the transformation parameters to achieve the desired size and relative position on the tracking plane (e.g., Scale, Position).

Adjust Linked Element Parameters
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Step 6: Export and Share

Click Export when you finish editing and choose the format you want to save.

10.25	Smart Scene Cut for Windows

Smart Scene Cut is a video editing technology used to capture the highlights of a video. It is primarily used in the rough-cut stage to intelligently identify, segment,
and extract key moments, elements, and objects from long videos. The extracted clips can then be selected and added to the main timeline for editing, helping users
quickly create short videos.
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Step 1: Download and Select the Appropriate Size

Launch Filmora on your computer. On the launch page, select the aspect ratio specification for the video you will import.

Import Media Files

Step 2: Locate Smart Scene Cut

Method 1: On the startup page, there are two selection windows for the Smart Scene Cut feature. Clicking on them takes you directly to the Smart Scene Cut
interface.

Locate Smart Scene Cut from the Startup Page

Method 2: Import your video clips and click the "Smart Scene Cut" option on the video thumbnail.
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Locate Smart Scene Cut from the Video Thumbnail

Method 3: Right-click on a video. Select "Smart Scene Cut" to access the interface of the unique operation.

Locate Smart Scene Cut from the Video Project

Step 3: Enter the Smart Scene Cut Feature Page

After clicking to enter the Smart Scene Cut operation page, you can select ten objects for recognition. Subsequently, highlight clips will be extracted based on the
objects you choose. Once you've made your selection, you can click "Start."

Select the Objects to Identify
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Note:

You can only select a maximum of 10 objects yet.

Smart Scene Cut Uploading

Step 4: View Progress and Edit Entry

You can click "Hide" to hide the window, and in the "Task List > AI Creations Tasks" window, you can see the task progress.

View Progress in the Task List

In the "Media Folder", there is a folder button in the top left corner of the video. Clicking it allows you to view the completed results.

  

 295/641

  

 



Find Completed Results in Media Folder

Double-click the video with your mouse to enter the edit page.

Enter the Edit Page

Note:

If you don't click "Hide" during the generation process, the result preview page mentioned below will appear directly.

Step 5: View the Completed Results

On the smart scene cut results page, you can see three selection categories: "Highlight Scene," "Character Scene," and "Custom Object".

Highlight Scene

This can help intelligently capture highlight scenes. You can select the segments you find impressive and add them to the timeline for further editing on the main
track.
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Highlight Scene

Character Scene

This can smartly extract highlights based on character scenes, emphasizing key segments.

Character Scene

Custom Object

You can also capture custom elements you want in the video. Filmora will track the relevant fragments from the entire video.
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Custom Object

Edit in the Main Timeline

After selecting all your scenes, click "Edit in the Main Timeline".

Edit in the Main Timeline

Step 6: Edit in the Main Timeline

With your highlight clips in the main timeline, you can edit them as per requirement. For example, you can add text, sound effects, transitions, etc.
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Edit the Video on Timeline

Step 7: Export and Share

Choose a destination and set the format to "MP4" or another video format. Edit other export settings as needed and then click "Export".

Export the Video To Local Storage

You can also choose to import directly to social media platforms, where you can customize the video's thumbnail, title, description, etc.

Export the Video To Social Media
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10.26	Smart Short Clips for Windows

Are you looking for a tool to transform long videos into engaging, social media-ready clips effortlessly? Look at Filmora's Smart Short Clips feature! This powerful
tool streamlines the editing process and automatically identifies key moments in your footage, allowing you to create captivating shorts in just a few clicks. Explore
this guide to discover more!

Index

01Access Smart Short Clips Feature
02Steps to Use Smart Short Clips
03Check Social Media Data to Get Insights

Access Smart Short Clips Feature

Entry 1: Access from the Home Page

When you open Filmora, you can find the entrance of the Smart Short Clips in the list of features under New Project.

Separate Functional Entry

Entry 2: Access from the Filmora Cloud

You can click on Filmora Cloud and find the entry in the Cloud Space general buttons.
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Entry on Filmora Cloud

Entry 3: Access from the Toolbox

You can click on Toolbox and find the Smart Short Clips entry in the function card, or you can check the latest new features.

Entry on Toolbox
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Steps to Use Smart Short Clips

Step 1: Upload Your Videos

Simply paste a link to a YouTube video, upload a video file, or directly choose a file from Filmora Cloud into Filmora.

Note: Remember to use your own YouTube videos if you are choosing to paste a YouTube URL.

Upload Your Videos

When uploading a video, you need to select the video source language manually. You can also adjust the Duration and Themes yourself if you don't want to accept
the default settings.

Fill Project Information

You can access the Advanced menu to choose the Aspect ratio and activate Smart BGM Generation to auto-generate music that fits your content.
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Tip: You can enter a few keywords about your content in the Main Topic box to help the AI generate relevant animations.

Access Advanced Settings

Rich templates are available under different themes. You can scroll down to find various high-quality short video templates. Select the one that catches your eye and
click on Generate to continue.

Rich Templates

You will need to wait a short time for the software to detect the video source language and upload the video.
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Wait for the Completion

Tip: During the generation process, you can click Generate Offline to close the current page and edit your other videos. Moreover, an email will be delivered for
notification when it is generated.

Step 2: Choose Your Shorts

Based on the uploaded video and the selected settings, the system will generate several results and will give a rating based on the platform rules.

Generate Different Videos

Tips:

You can also click Reset to regenerate it.
You can choose AI Speech Enhancement to improve the quality of your voice recordings beyond just denoising.
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Choose your favorite video clips which can be exported directly or refined.

Choose Your Favorite Clip

Step 3: Edit Your Video

After clicking Edit you will enter the editing panel of Smart Short Clips. You can choose to use or hide specific captions in Select Mode or view the script by
timecode for easier editing in Time Code Mode.
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Choose Time Code Mode

Tip: You can also generate Thumbnails and edit them by selecting the appropriate location.
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Edit Your Thumbnail

You can also change the font style to better fit your video's theme by selecting the clip and navigating to the Text tab. Then click Apply to All to apply it to the whole
video.
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Choose Text Template

In the top toolbar, there are many other templates and resources for titles, transitions, effects, filters, and stickers that you can choose to add to your video.

To modify the text, go to the Basic option under the Text tab. You can adjust the text, merge, or emphasize certain words as needed.
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Edit Video Text Script

If you're not satisfied with the existing speech or want to add more dialogue to the video, you can use the Text-to-Speech feature to generate new voiceovers from
the text.
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Text to Speech

You can also adjust the stickers etc. in the generated video by deleting them, zooming in or out.

Edit Stickers in Video

AI will intelligently recognize characters according to specific scenarios and place them in the middle with a reasonable split-screen layout.
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Split Screen

Step 4: Export Your Shorts

Finally, open the Export window, select the social media platform (YouTube, TikTok, Instagram, Facebook, Vimeo) for your video upload, and customize settings
such as the title, description, category, resolution, and more.
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Export Your Video

If you want to schedule your post, enable the Schedule option and set the desired date and time.

Schedule Your Videos

Check Social Media Data to Get Insights

The Analysis feature in Wondershare Filmora's Smart Short Clips tool provides comprehensive insights into your video performance across multiple platforms. After
creating a short video and uploading it to your social media platform, this feature allows you to view detailed statistics like account views, likes, and comments. You
can toggle between 7-day and 30-day analytics, conveniently accessing all your social media stats in one place. Let's get into further details:

Step 1: Access the Analysis tool
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Access the Analysis Tool using one of the two methods. Either click the Analysis section directly from the Home Screen or navigate to Smart Short Clips and click
the Analysis button.

Entry 1: Access from the Home Screen

Launch Wondershare Filmora. From the home screen, locate the Publish Tasks section on the right panel. Click on More to directly open the feature and view
your stats.

Access Analysis Tool

Entry 2: Access from Smart Short Clips

Look for the Analysis button within the Smart Short Clips interface (near the upload section). Click on Analysis to access the statistics and analytics feature
for your content.
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Access Analysis Tool

Step 2: Choose the Desired Platform

Choose the desired platform (YouTube, Facebook, or Instagram) for which you want to view stats.

Select Platform

Choose between 7 days and 30 days to filter the data.
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Set Time Duration

Step 3: View Social Media Data

The tool will display social media data, such as:

Account Views
Account Likes
Account Comments

View Social Media Data

Below the data, there are some tips for short video creation to help improve your video performance.

10.27	Image to Video for Windows

  

 315/641

  

 



Filmora’s Image to Video feature lets you effortlessly convert your style photos into captivating video content. With the wide selection of creative templates, you can
bring static images to life in just a few clicks. Enhanced with the newly introduced Veo 3 model, Filmora takes image-to-video generation to the next level.

It offers smoother transitions, realistic animation, and advanced customization for visually stunning results. Veo 3 is the latest AI video generation model introduced
by Google to convert images and text prompts into high-quality videos with native audio integration.

How to Use Filmora’s Image to Video Feature

Entry 1. Access the Video Generation Section
Entry 2. Acquire the Video Inspiration Section

Entry 1. Access the Video Generation Section

Mode 1. Image to Video - Veo 3

Step 1. Select Image to Video - Veo 3

Once you enter Filmora’s main interface, enable the Image to Video - Veo 3 section under Video Generation and insert your reference image. Next, enter the text
prompt and select Veo 3 Quality by expanding the drop-down menu. Execute the process by pressing the Generate button.

Step 2. Review the Generated Video and Export

The video, along with audio that meets your requirements, will be generated within the preview window. Review it by hitting the Play icon, and save the results
successfully to your device by clicking on the Export button.
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Mode 2. Start/End Frame to Video

Step 1. Enter Start And End Frames And Generate

After enabling the Start/End Frame to Video section, insert the images for the start and end frames in the designated fields. Next, enter your text prompt and
expand the Settings option to select the Resolution and Duration for the video. Press the Generate button located within the interface to begin the process.
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Step 2. Make Edits if Required and Save the Video

When the video is created within the interface, edit it according to your requirements using the various functions offered by Filmora. Finally, press the Export button
to export the generated video to your PC.

Mode 3. Reference to Video

Step 1. Add Reference Images and Start Generation

To begin the process, add your reference images within the Reference to Video section and input your text requirement. Define the Duration and Resolution, and
click on the Generate button to start generating the video.
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Step 2. Modify the Generated Video and Export

Once the video is generated, add effects and other elements and save it to your device using the Export button located at the top-right corner.

Mode 4. Video Editing Element
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This utility allows you to blend the picture and video to generate a video with various modifications. You can add a certain element or remove a specific element by
adding its picture.

Add Element

For this option, you can import the image of the element you want to insert in the video and specify the details in the form of a text prompt. To learn how to use this
mode, read the steps mentioned below:

Step 1. Select Video Element Editing and Add Element

After accessing the Video Element Editing section from the Image to Video tab, enable the Add Element section and import the video.

Step 2. Add Image After Cropping

Insert the image you want to add as an element in the video and select the Picture Mode. Now, choose the Aspect Ratio and hit the Submit button to import the
picture.
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Step 3. Add Prompt and Configure Settings

Once the media is added, input the text prompt and expand the Settings option to specify the Duration and Resolution. Finally, hit the Generate button to execute
the process.

Step 4. Edit the Video and Export
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Once the video is generated, drag it to the editing timeline to apply further enhancements. Finally, head to the top right corner of the interface and press Export to
save the video.

Replace Element

This utility allows you to select an element that you want to remove from the video and lets you add a picture of another element. Let us have a look at the steps for
replacing an element in a video in the section below:

Step 1. Access Replace Element and Add Video

To begin the process, acquire the Replace Element section and add the video in which you want to replace the element. Now, press the Select the Area to be
Swapped option to proceed to the next window.
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Step 2. Select the Area to be Replaced

In the following interface, select the element you want to remove from the video and press the Submit button.

Step 3. Add an Image of the Element to be Added

Use the designated option to import the picture of the element to be added. Now select the Picture Mode and Aspect Ratio and hit the Submit button.
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Step 4. Input Text Prompt and Generate Video

Add the text prompt specifying your requirements and select duration and resolution. Press the Generate button to begin the lament swapping process.

Step 5. Modify Video and Save

Once the results are generated, add it to the timeline and edit them using Filmora’s different features. Finally, hit the Export button to save the results to your device.
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Delete Element

If you do not like a specific element in your video, you can remove it by precisely selecting it within the tool’s interface. Here is how you can seamlessly remove any
object from the video using the Video editing Element feature by Filmora:

Step 1. Start By Accessing Delete Element Mode

Initiate by acquiring the Delete Element feature under the Video Editing Element section and add the video in which you want to remove the element.
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Step 2. Select the Element To Be Removed

Next, select the element you want to delete in the following window and press the Submit button.

Step 3. Add Text Requirement and Generate

Once the selection is made, input the text prompt for the requirements and press the Generate button to start the process.
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Step 4. Review and Edit the Generated Video

After the process is successfully complete, drag video to editing interface and edit it of required. Press the Export button to successfully save the video to your
device.

Entry 2. Acquire the Video Inspiration Section
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Step 1. Choose the Desired Template in Filmora

After accessing the Video Inspiration section, scroll through the categories provided and choose the template of your choice by clicking on it.

Step 2. Add Image and Crop It

Next, choose your preferred Aspect Ratio in the next window according to your preferences and click the Submit button.
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Step 3. Start the Inspiration Video Generation

Once the image is added, locate and click the Generate button to start the video generation process.

Step 4. Have a Look at the Video Inspiration and Save

When the video is successfully generated, play it within the preview window and save it to your computer using the Export button.
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10.28	AI Idea to Video for Windows

Do you often have great video creation ideas in your mind? Filmora's AI Idea to Video feature allows you to maximize the value of your inspiration, helping you
turn your video ideas into short story clips. If you're not satisfied, you can keep generating until you are happy with the result. If you're interested, please check out
the upcoming tutorial!

Index

01How to Use Filmora's AI Idea to Video Feature?

How to Use Filmora's AI Idea to Video Feature?

To get a better understanding of how to utilize the AI Idea to Video feature, follow the simple guide below:

Step 1: Enter the "AI Idea to Video" Interface from the Startup Page.

On the startup page, find the "AI Idea to Video" feature box and click to enter.

Enter the AI Idea to Video Interface

Step 2: Enter Your Story Script.

After entering the "AI Idea to Video" feature interface, you can input your story idea and customize the video length, language, and style. Once the settings are
complete, click "Launch AI Script."
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Launch AI Script

Step 3: Customize the Generated Scene Content.

Filmora will generate several scene descriptions based on your input script, and display task settings and video scene configurations. You can manually edit the
content to let Filmora regenerate it. Additionally, for each scene, you can upload images to generate videos from images. Once you confirm that the scene
descriptions and related settings are satisfactory, click "Generate" to create the short video.
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Check the Generated Scene Content
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Change the Generated Character/Setting Content

Step 4: Wait for the Video to Generate.

It will take a few minutes to generate the short video. You can click "Hide" to conceal the process.
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Wait for the Video to Generate

You don't need to worry about where to check the progress. By clicking the launch page or the project progress button at the top of the interface, you can view the
video generation progress.
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View the Video Generation Progress

Once the video has been generated, you can click the "Locate" button next to the video process flow in the task list to enter the video panel page.
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Locate to the Video Panel Page

Step 5: Enter the Storyboard Page to Edit the Video.

After entering the Storyboard page, you can view the generated results for each scene. If you added subtitles or transition effects during the initial setup process, they
will appear on the timeline. You can also use the features in the Filmora toolbar to edit the video, such as changing fonts, adding audio, adjusting transitions and
filters, and more.
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Enter the Storyboard Page

Step 6: Edit the Generated Results.

If you're not satisfied with the generated scene results, you can modify the scenes, tasks, or other settings and regenerate them.

That's how you can easily turn your ideas into short videos using Filmora's AI Idea to Video feature on Windows. Whether you're creating content for social media,
storytelling, or just for fun, this feature helps you get started quickly and customize every step of the process. Try it now and bring your imagination to life!
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10.29 Filmora	AI	Script	to	Video	on	Windows

Filmora	AI	Script	to	Video	on	Windows	is	a	powerful	feature	that	transforms	written	scripts	directly	into	engaging	video	content.	This	tool	leverages	advanced	AI	
technology	to	automatically	generate	videos	complete	with	animations,	transitions,	and	customizable	elements	based	on	your	textual	input.	The	feature	is	
integrated	with	the	latest	Google	Veo-3	technology	that	adds	relevant	background	score	to	your	videos	automatically.

Index

01Acquire	the	AI	Script	to	Video	Feature
02Input	Script	and	Generate	Video
03Review	the	Generated	Video	and	Export

1. Acquire	the	AI	Script	to	Video	Feature

After	launching	Filmora,	click	on	the	AI	Script	to	Video	feature	located	on	the	homepage	or	the	Toolbox	on	the	left.

As	a	new	window	opens	on	selection,	add	your	script	as	text	in	the	designated	field.	You	can	also	generate	a	script	using	the	Generate	by	AI	option.	Moving	
forward,	select	the	voice	language	and	choose	a	voice	for	voiceover.	The	platform	allows	you	to	instantly	clone	your	voice	using	the	AI	Modeling	option	as	well.	
After	selecting	the	Video	Ratio,	hit	the	Script	to	Video	button	to	execute	the	process.

2.	Input	Script	and	Generate	Video
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Learn how to add, adjust, remove, and favorite audio.

Index
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1. Types of Audio

Filmora has 1000+ audio resources to help you edit your videos better.

Where  to  Find  Audio?

Double-click on Filmora's desktop icon, and once the welcome window pops up on the screen, click on the New Project option.

In the upper corner of the editor's main window, you can see a number of tabs, like Audio, Titles, or Effects. Click on the Audio tab.
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Remove Audio
Favorite Audio

Adjust Audio
Add Audio
Types of Audio

3.	Review	the	Generated	Video	and	Export	Video

Once	the	video	across	your	script	is	generated	in	the	following	interface,	review	it.	Apply	further	enhancements	if	required	using	Filmora’s	extensive	
functionalities.	When	you	are	satisfied	with	the	results,	hit	the	Export	button	located	at	the	top-right	corner	to	save	the	video.



Filmora Audio

Types of Filmora Audio

Exclusive Music
Sound Effect
Intro
Happy
Young & Bright
Tender & Sentimental
Rock

2. Add Audio

Adding audio can drastically change the tone of your video. Filmora provides a royalty-free music library you can access within the program or import your own
music.

Here are two ways to add audio to your videos:

Note:

The music and sound effects found within Filmora are for personal and NON-COMMERCIAL use only. Learn More

1 Import Audio from your Computer

Select an audio file stored on your PC and bring it into Filmora.
Click the "Import Media" button above the Media Library panel, then browse the audio files on your computer.
When you find the song or other audio file you want, please select it and import it into the Media Library.
You can also drag and drop audio files into the Media Library.
From there, you can drag and drop your audio into an Audio Track in the timeline.
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Import the audio

2 Using Audio from Filmora

The audio library has 200+ songs divided into five categories: YOUNG & BRIGHT, TENDER & SENTIMENTAL, ROCK, FOLK, and ELECTRONIC. There are
also sound effects available under SOUND EFFECT. Explore more audio effects to add fun and variety to your video, and turn your audio into a robot, child, diving
sounds etc., with the new audio effects.

Here are still two ways you can add music from the audio library to your video:

Select audio, right-click, and choose to Apply
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Apply the audio

Drag and drop the audio into the Timeline.
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Drag and Drop the audio

3. Adjust Audio

Once you've added your music, double-click on the music in the timeline to bring up the Audio window. In this window, you can adjust the volume and pitch of the
music. You can also make audio keyframing(fade in and fade out) for your music.

Enable the Solo Feature and Adjust Audio

After multiple audio tracks are successfully imported to the timeline, click on your desired audio track and press the "Enable Solo" icon on the left side of the track.
This will disable the audio of other tracks on the timeline automatically. You can access the "Audio" panel and adjust parameters like "Volume," "Sound Balance,"
and "Fade."
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Use solo track and adjust audio

Note:

The Solo Track feature by Filmora allows users to control and isolate audio tracks on the timeline. It lets users play the specific track in isolation for precise
adjustment while getting the option to mute other tracks. Moreover, the utility ensures enhanced editing control by offering seamless synchronization between audio
and video.

4. Remove Audio

Select the audio you want to remove from the timeline and hit Delete on your keyboard.

Or right-click on the audio in the timeline and select DELETE from the menu.

5. Favorite Audio

Right-click on the audio in the Audio menu and choose to Add to Favorites.
Or choose the audio you like. You will see a "heart" shape on the top right; click the "heart" in red.
You can check your favorite audio on the left - Favorites.

11.2	Adjust Audio

Index

01Access the Adjust Audio Interface in Filmora
02Adjust the Parameters
03Use AI Voice Enhancer
03Use Denoise and Drop It Down

How to Access the Adjust Audio Interface in Filmora?

To adjust your audio clip, you can try the following three ways:

Step 1 Double-click on the audio clip.

Step 2 Right-click on the audio clip, then select Audio>Adjust Audio
Step 3 In the top navigation bar, tab on Tools> Audio>Adjust Audio.

Absolutely, the first method is more accessible than the other two. After your operation, the audio adjusting interface will be aroused.

How to Adjust the Parameters?

In the audio adjusting window, from top to bottom, you can see three choices: Adjustment, AI Voice Enhancer, and Denoise. Click the icon to drop down and have
advanced options:
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Adjust Audio

When you click Adjustment and drop it down, you will see:

1. Zoom

Zoom means the magnification of the audio. If you move the pan from the right to the left, you can magnify the soundtrack and edit your audio more precisely.

Adjust Audio

2. Auto Normalization

Auto Normalization feature analyzes the volume of all selected clips and automatically adjusts the volume to the standard loudness level of European audio programs
at 23.0LUFS (deviation range: ±1LU).

Adjust Audio

3. Volume Control

By dragging the bar on the volume slider, you can easily heighten or lower the average volume of the audio.

4. Sound Balance

In Sound Balance, the pan controls how each track is balanced between the right (R) and left (L) sides of where the audio is being heard from. For example, if you
move it all the way to the right, you can hear the audio showing only on the right side of your headphones.
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Adjust Audio

5. Fade in

Fade-in means that the volume gradually increases from zero at the beginning of the audio.

6. Fade out

Fade-in means that the volume gradually decreases to zero at the end of the audio.

7. Pitch

Pitch controls the highness or lowness of a tone. By dragging the slider from left to right, you can hear the audio changing from thick voice to shrill voice. It is
usually used to change the human voice to make a funny effect.

8. Audio Ducking

Audio Ducking means decreasing the volume level of specified audio when a second specified audio is present. In video editing software, audio ducking is usually
used to lower background music anytime a person speaks. When the person finishes speaking, the background music rises again. This technique can be used in any
scenario where you want to be heard clearly.

Adjust Audio

9. Equalizer

You can use a Filmora equalizer to manipulate the mix's frequency so that everything is balanced and clear. Here you have some popular preset equalizations, such as
classic, dance, pop, country, folk, etc. You can also customize your equalizer.
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Adjust Audio

Knowledge Class:

EQ (equalization) changes the balance of different frequency components in an audio signal. Our ears can detect a vast range of frequencies-roughly 20 Hz to 20
kHz. Each element of the mix has energy in different parts of that range.

How to Use Use AI Voice Enhancer?

Once you activate the AI Voice Enhancer button, you can enhance and clarify the sound, improving the audio quality of your videos.

AI Voice Enhancer

How to Use Denoise and Drop It Down?

When you click Denoise and drop it down, you will see the following:

1. Wind Removal

Wind Removal specializes in removing the noise of the wind. It estimates the reverberation profile and works out a way to change the amount of reverberation. You
can choose whether to turn on or turn off the function.

Adjust Audio
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2. Normal Denoise

Denoise enables you to remove background noise automatically and intelligently in one click. There are three options for your choice: weak, medium, strong.

Adjust Audio

3. DeReverb

DeReverb is to reduce hiss and background noise. You can easily heighten or lower the average dereverberation effect by dragging the bar.

Adjust Audio

4. Hum Removal

Hum noise refers to the humming sound. Hum Removal removes narrow frequency bands and their harmonics. You can reduce the extent of noise with the range
from -60 to 0 db.
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Adjust Audio

5. Hiss Removal

Hiss noise refers to the hissing sound. You can adjust the hiss noise volume from -100 to 10.

Adjust Audio

6. Denoise Level

Denoise Level below Hiss Removal means you can control the Hiss Denoise effect from levels 1 to 6.

11.3	Detach Audio

Index

01Detach Audio from One Video
02Detach Audio from Multiple Video
03Extract multiple audio tracks from Video

Detach Audio from One Video

To separate your audio from video, there are three paths:

1 Hotkey: Ctrl+Alt+D

2 Right-click on the video clip, then go to Detach Audio.

3 In the top navigation bar, tap on Tools> Audio> Detach Audio.

Absolutely, the hotkey is easier than the other two. After clicking on the Detach Audio option, the video clip will be separated into 2 parts: a video and audio.
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Detach Audio from One Video

Detach Audio from Multiple Video Clips

To detach audio from multiple video clips at once, choose all of the video clips from which you want to extract audio. Then follow the above-mentioned paths to
access Detach Audio button.

Detach Audio from Multiple Video Clips

Extract multiple audio tracks from Video

1 Click manage tracks to add audio tracks.

add audio tracks

2 Click Audio Track to view the number of audio tracks in this video, then select the first track.
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click audio track

3 To extract the first audio track, drag the video to the timeline and click Detach Audio. The first audio track will then appear in the timeline.
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detach audio

4 To extract the second audio track, you need to delete the video from the timeline first.

  

 351/641

  

 



delete audio

5 Click Audio Track again and select the second audio track.
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the number two track

6 Drag the video to the timeline again and click Detach Audio.The second audio track will then appear in the timeline.
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detach the audio

If you have a third, fourth, or more audio tracks, please repeat the above steps.

11.4	Mute

Index

01Mute the Whole Audio
02Mute a Small Piece of Audio
03Turn off Mute Feature

Mute the Whole Audio

To mute the entire audio, you have three ways:

1 Hotkey: Click the speaker icon on the left side of the timeline to mute.

2 Right-click on the video clip, then choose Mute.

3 In the top navigation bar, select Tools> Audio> Mute.

After the audio gets muted, you will see a volume bar with lower brightness.
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Mute the Whole Audio

Mute a Small Piece of Audio

1 Split the audio by tapping the scissors icon on the toolbar.

2 Select the audio you want to mute, and you can use the three methods mentioned above to mute it.

Once you mute the little clip, you can find its volume bar looks less bright than the rest. This muted word feature is often used when you want to remove sections
with bad words in a video. Then it’s time to apply the Mute feature.

Mute a Small Piece of Audio

Once you finish the process, you can see a small piece of the audio become gray. The function is usually used when bad words are found in a small segment. Then
you can apply the Mute feature.

Turn off Mute Feature

If you want to cancel the Mute option, kindly select the muted parts. Then right-click to select the Mute tab again. The check mark will be removed, that means you
have turned it off.

11.5	Trim/Split/Cut Audio

Index

01Split Audio
02Trim Audio

Split Audio

Cutting audio clips is an easy thing. First, you need to put the playhead to the point in your audio clip where you want to split it. Second, select the audio clip. After
that, there are several ways that you can cut the audio:

1 Hotkey: Ctrl+B

2 Click on the Scissors icon on the playhead.

3 Tab on the Scissors icon on the toolbar.

4 Right-click on the audio clip and select Split.
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Split Audio

Trim Audio

Here are two methods to trim audios:

1 Trim start to playhead. The matching hotkey is Alt+[.

2 Trim end to playhead. The matching hotkey is Alt+].

To trim your videos, you need to first select the audio clip. Right-click to choose Trim start to playhead or Trim or Trim end to playhead.
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Trim

11.6	Audio Fade In and Fade Out

Fading is commonly used in audio transitions. With Fade In, the sound begins with silence and increases to the full volume gradually. With Fade Out, the audio
begins at full volume and decreases to silence gradually.

Index

01Add Fade In and Fade Out in Audio Pane
02Set Fade In and Fade Out Effects with Markers in Timeline

Add Fade In and Fade Out in Audio Pane

1. After adding the audio to the timeline, click on it to open the Audio edit panel.

2. Set fade-in and fade-out effects by dragging the sliders or by entering how many seconds a fade effect should last.
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Add Fade In and Fade Out In Audio Pane

Add Fade In and Fade Out in Audio Pane

You can also use the fade icons at the left and right edges of the audio waveform areas to quickly fade in and out.

1. At the beginning of the audio clip, drag the fade-in maker to the right to apply a fade-in audio effect.

2. Go to the end of the audio clip and drag the fade-out maker to the left to add a fade-out audio effect.

Add Fade In and Fade Out Markers

Note:

The further you drag, the longer the fade effect will last.

Pitch

Changing pitch in audio will make the voice be higher when sped up or lower when slowed down.

Index

01Change Audio Pitch
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11.7	Change Audio Pitch

1. Double click the audio file in the timeline. In the popping-up window and under Volume, drag the pitch slider right to set the pitch up, and drag the slider left to set
the pitch down.

2. Click the Play button in the Preview window to check what the audio sounds like. Click the Reset icon to restore the pitch settings.

3. Click OK to save the pitch changes in audio.

Change Audio Pitch

Note:

Adding a semitone is equivalent to changing the overall pitch by one note in a 12-tone scale. For example, C to C# (Sharp). The same to removing a semitone.

Note:

Modifying audio speed by adjusting the pitch will not change the audio length.

12.1	Beat Detection

Index

01Creating Markers with Beat Detection
02Beat Options Setting
03Adding Additional Beat Markers
04Removing Beat Markers

Filmora's Beat Detection function will automatically mark audio beats and make matching your video easier. Here are the steps to use Beat Detection.

Create Markers with Beat Detection

Right-click on a music file that you want to detect the beats for. You can choose from the built-in music or your imported audio files. Select Beat Detection in the
context menu. When the analysis is finished, a Beat icon will appear on the music’s thumbnail.
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Beat Detection

To see the beat markers, drag and drop your analyzed music file into your timeline. Filmora will display highlight beat markers in red every four beats by default, but
this setting can be changed.

Add to Timeline

Beat Options Setting

You can change the beat detection settings by right-clicking the music file in the library. Then select Beat Options. Here you can change the Beat Model, Highlight
Frequency, Highlight Offset, or Mark highlight beats only to display every beat marker.
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Beat Options

Beat Model: Beat Model allows you to choose the highlight beat. There may be different important drumbeats. You can choose the highlight beat as you like.

Highlight Frequency: A piece of music is composed with rhythm. When you find the highlight beat, you can calculate how many beats are followed by a
highlight beat.
Highlight Offset: Highlight offset enables the highlight beat to shift from beat 1 to beat 2, or from beat 1 to beat 4. You can set the preference as you like..
Mark Highlight Beats Only: If you don’t tick the option, all the beats will appear in the audio track..

Add Additional Beat Markers

Select your audio file in the timeline and place the playhead where you want to add a marker. Then, click the marker icon or press M on your keyboard.

Add Beat Marker

Remove Beat Markers

Choose a marker and press Delete on the keyboard, or right-click on the marker and choose Delete. To remove all markers, choose Delete All Markers.

In addition, by double-clicking the tag button, you can also edit the name and color of your tags. Commenting on tags can further help you understand their usage
better.

Marker Editor

12.2	Audio Mixer

An audio mixer can also be known as a mixing console. This is a tool in Filmora used for mixing, balancing, and combining different sounds, and audio signals,
sources like microphones, instruments, and synthesizers, or previously recorded audio.

Index
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01 Open the Audio Mixer Panel
02 Adjust the Audio

You can use the Audio Mixer to fine-tune the audio of your projects. To use the Audio Mixer, please follow these instructions:

Open the Audio Mixer Panel

Select the Audio Mixer icon in the toolbar to open the Audio Mixer panel.

Audio Mixer icon

Adjust the Audio

You can switch the sound between left and right by dragging the knob in the Pan/Balance Control. You can see your changes clearly in the channel control panel to
the right.

There are two modes: Stereo and Surround. In Surround mode, you can pan from left to right as well as front to back, which gives you full control of the audio
position all around. While in Stereo mode, you can only pan left or right.

You can also go to the master section and drag the Master volume slider upward or downward to adjust the Master volume higher or lower.

Audio Mixer

After your adjustments, click the Play button to hear the results. Select Apply to save the settings.

12.3	Auto Normalization

The new Auto Normalization feature analyzes the volume of all selected clips and adjusts the volume to the standard loudness level of European audio programs at
23.0LUFS (deviation range: ±1LU) automatically.

Index
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01 Goto Auto Normalization Option
02 Reset Auto Normalization

Goto Auto Normalization Option

1 Double click on the video or audio clips you want to normalize in the timeline. In the Audio editing panel, you will see the Auto Normalization option.

2 Right-click on the video or audio clip, choose Audio>Adjust Audio to open the Audio editing panel.

3 Select the video or audio clip, tab on Tools>Audio>Adjust Audio to access the Audio editing panel.

Auto Normalization Option

After finding the Auto Normalization option, you can press the button to enable it. Filmora will analyze and normalize the volume of the clip(s) automatically.

Normalizing Audio

Reset Auto Normalization

If you are not satisfied with the normalized volume, you can press the button again to reset. Or you can click on the recheck icon.

  

 363/641

  

 



Reset Auto Normalization

Note:

Clicking the RESET button in the Audio editing panel will reset all audio editing settings.

12.4	Ducking

Index

01 Audio Ducking
02 Duck Audio in Filmora
03 Cancel the Ducking Option

Audio ducking

Audio Ducking means to decrease the volume level of specified audio when second specified audio is present. In video editing software, audio ducking is usually
used to lower background music anytime a person speaks. When the person finishes speaking, the background music raises again. This technique can be used in any
scenario where you want to be heard clearly.

Duck Audio in Filmora

Locate Ducking Function in Filmora

Note:

In Filmora audio ducking feature, you do not lower the volume of the clips that you choose. On the contrary, the volume of the other clips is decreased. Kindly
choose the one that needs to be heard clearly.

There are three methods that you can access Filmora ducking features.

1 Click the clip that you want the voice to be heard clearly.

2 Right-click on video or audio clip and select Adjust Audio.

3 Select the video or audio clip, then click Audio > Basic.

In the above three paths, the first one is the easiest way to duck your clips.

Audio Ducking
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The default ducking value is 50%. You can also adjust the volume of the other clips by dragging the slider.

You can also adjust the Fade Position and Fade Duration. This lets you control where the ducking effect begins and how long the fades last, making your audio
transitions sound more natural and pleasant.

Cancel the Ducking Option

There are two ways to turn off the audio ducking:

1 Click on the reset logo.

2 Click on the check box.

12.5	Audio Equalizer

The Audio Equalizer (EQ) enables you to raise and lower the loudness of an audio frequency (i.e. bass or treble). You can choose one equalizer preset and add it to
the audio or customize it from scratch with sliders.

Index

01Adjust Audio Equalizer

Adjust Audio Equalizer

1. Double click the video or audio file in the timeline and then go to the Audio tab.

2. Go to Equalizer option and select one preset from the drop-down list, including Default, Classic, Low Bass, Sparkle, Pop, Rock' n' Roll, Soft, Techno, Hard Rock,
Ska, Country, Acoustic, Folk, Blues, and Custom. You can choose a preset based on the type of audio or the genre of the music.

Select Equalizer Preset

3. Click the Setting button and access the Custom Equalizer window to modify the gain by dragging the sliders up or down.
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Customize Equalizer

4. Click the play button in the Preview window to check the result. Click OK to apply the equalizer effect to the audio.

Note:

You can also click the Customize button before applying a preset to make the equalizer effect from scratch.

12.6	Audio Meter in Windows

There is a certain level of sound that humans can bear and even lower that they can enjoy; hence, Filmora has a feature to take care of your content's audio level. The
Audio Meter is an independent functionality in Filmora, and users can enable it during or after editing. Following this guide, users will find the step-by-step
instructions to access the audio meter:

Accessing the Audio Meter

If you wish to display the audio meter while editing in Filmora, keep following the given directions to enable it:

Step 1: Import Media and Bring it to the Timeline

Once Filmora is installed on your PC, initiate a new and import your media using the "Ctrl + I" shortcuts. Then, drop your media to the timeline panel while making
sure that your media contains audio.

Place imported media to timeline

Step 2: Enable the Audio Meter

Choose the clip and activate this function by clicking the "Audio Meter" icon on the right side of the timeline toolbar.
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Access the audio meter

Step 3: See the Audio Meter's Statistics

The audio meter will be shown on the right side of the timeline panel, providing the audio statistics for your media.

Analyze the audio statistics

13.1	Auto Beat Sync

Auto Beat Sync will take small parts from the same video or different videos, and then combine them into one personalized and stylized video.

Index

01 Open Auto Beat Sync
02 Adjust the Settings
03 Analyze
04 Preview the Generated Video

Open Auto Beat Sync

To open Auto Beat Sync panel, you have the following three ways:

1 OpenFilmora video editing software, you can easily see Auto Beat Sync option in the startup window.
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Auto Beat Sync Option

2 If you have already been in the editing interface, you can also access the function by right clicking the files imported in the Project Media, then selecting Auto
Beat Sync.

Auto Beat Sync Option

3 After selecting the imported files in the Project Media, you can also find Auto Beat Sync by clicking Tools>Auto Beat Sync in the navigation bar.
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Auto Beat Sync Option

Adjust the Settings

From the pop-up Auto Montage Panel, you can clearly see three main adjustable parameters: Auto Highlight, Auto Beat Sync, and Video Effect.

Auto Beat Sync

Auto Highlight

In the Auto Highlight segment, you can choose to add more video or audio clips. You can also adjust the order or delete the imported video or audio clips. At the
same time, you can adjust the length of the generated video or audio clip.

Note:

The maximum duration of final video should be shorter than BGM and longer than 1/3 of total duration of all imported clips combined.
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Auto Highlight

Auto Beat Sync

In the Auto Beat Sync interface, you can import background music, and set BGM start time. Surely, you can preview the background music to choose the start time.
In addition, you can also choose the beat cut speed whether it is fast or slow.

Auto Beat Sync

Video Effect

In the Video Effect segment, you can set the appearing frequency of RGB, Glow, Video Wall, Blur video effects.

Video Effect

Analyze

Once you finish all the settings, you can click on Analyze button to initiate the automatic analyzing process. Usually, it will take two steps to finish the analysis
process. Please wait patiently.

Step 1. Analyze the beats and rhythm of the background music.
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Step 1

Step 2. Automatically highlights and chooses the best moments from the footage and mix them according to the beats of the background music.

Step 2

Preview the Generated Video

You can preview the video by clicking on the Blank button. Or you can click on the Play icon. If you are satisfied with the result, you can Export to Timeline.
Otherwise, you can adjust the settings again and Analyze.
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Export to Timeline

13.2	Silence Detection

Index

01 Silence Detection
02 Apply Silence Detection in Filmora
03 Turn off Silence Detection Function

Silence Detection

Silence Detection can scan and remove silent pauses from your videos automatically, saving you editing time and keeping your viewers engaged.

Apply Silence Detection in Filmora

Silence Detection only works with clips that have audio. To automatically detect and delete silent pauses in a clip, you need to:

Step 1. Find the Silence Detection Feature

1 Tap on the Silence Detection button on the toolbar.

2 Right-click on the video in the Media and select Silence Detection.

3 Click the video in the Media and choose Tools > Silence Detection.

4 Select the video clip or audio clip in the timeline and choose Tools > Audio> Silence Detection in the top navigation bar.

After tapping the Silence Detection option, the window of Silence Detection will pop up.

Tips: Silence Detection also supports detecting silence in multiple videos simultaneously. You just need to select all the videos you want to process at once.
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Silence Detection Button

Step 2. Adjust the Parameters of the Silence Detection

In the Silence Detection window, you can adjust three parameters for Silence Detection.
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Silence Detection Settings

1 Volume Threshold: The Volume Threshold setting helps the algorithm to know your silence threshold value. The default volume threshold is 25%. It means if the
volume threshold value of segments is under 25%, the segments will automatically be considered silent.

2 Minimum Duration: The Minimum Duration setting helps Filmora to know the silence duration and low-sounding parts. The default minimum duration is 0.5s. It
means the silence should last over 0.5 seconds to be defined as silence.

3 Softening Buffer: The Softening Buffer option provides buffering time for the start and end of audible segments. The default softening buffer is 0.1s. It means that
the audible segments can get 0.1 second buffering time at the start and end separately.

Step 3. Start the Automatic Silence Detection Process

After setting the detection parameters, click Analyze to initiate the automatic silence detection sequence. You will see two different things in the timeline:

1 The black parts show the silent segments.

2 The highlight parts show the audible segments.

Silent and Audible Segments
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Step 4. Preview the Video

You can play the video to check whether all silent parts are removed perfectly or not. If you are not satisfied with the result, you can adjust the three audio parameters
above. Then click Analyze to delete the silent parts.

Preview the Video

5. Export to Timeline

Once your clip is ready, you can press Finish and Replace to Filmora Timeline to continue editing.

Finish and Replace

Turn off Silence Detection Function

You can also abandon the Silence Detection process by closing the window.
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Note:

Once you exit the Silence Detection window, the changes cannot be saved.

13.3	Auto Synchronization

This guide helps you match your audio with your video and make the sound clear.

This function could quickly replace the recorded audio with the audio in the video when shooting with a camera/video and using a microphone. It can also
automatically align the audio and video clips in the project without manual alignment.
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Feature Usage Scenarios

You can use this feature in the following two scenarios:

❶ Prepare the material to be synchronized:

Use different shooting equipment to record and shoot multiple pieces of material in the same scene.

For example, the photographer uses a mobile phone or SLR to shoot distant pictures, while the other device is closer to the sound source, and the recording gets
better audio.

❷ The user creates a project and imports multiple pieces of material to be synchronized into different timeline tracks.

How to Use the Feature

You can click the function entry in the following ways:

Method 1

Select the video + audio with audio track on the timeline simultaneously. The Auto Synchronization button will appear on the toolbar. Hover the mouse over the icon,
and it will show tooltips to remind you of the function summary.

Auto Synchronization On The Toolbar

Method 2

Select the video + audio with audio track simultaneously on the timeline, right-click and select Auto Synchronization.
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Auto Synchronization On The Timeline

Method 3

Select the video + audio with audio track simultaneously on the timeline, click Tools on the top menu bar and select Auto Synchronization.
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Auto Synchronization on the Tools

Note:

If the selected clips cannot be synchronized, a pop-up window will prompt, "The selected clips cannot be synchronized, please reselect the clip." Click "OK" to close
the popup window.

Clips Cannot Be Synchronized

Method 4

If you click the "Cancel" button, the audio and video will automatically stop analyzing, and the pop-up window will be closed.
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Syncing In Process

Note:

When more than two video and audio clips are selected, the button will be grayed out and cannot be clicked.

Syncing Button Grayed Out

13.4	AI Audio Stretch for Windows

This guide helps you simply set the length of the audio, and there's no need to cut, ripple, or add fades.

AI Audio Stretch is a useful tool to remix music automatically. It allows you to retime the audio clip easily to match the duration of the video. The beginning and end
of the material remain the same in the remix, and the middle will be edited.
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Usage Scenarios

Here are two examples to stimulate your creativity in using this tool:

A vlog with multiple scenes and different music clips. Music is always a solution to link clips, showing the feeling of each scene you want to present.
However, the length of each clip may not be satisfied.
A vlog with the same music, but the music time doesn't match the video time. You might be frustrated over the complexity of rearranging the beats of music.
AI Audio Stretch gives you an answer to stretch the audio instantly and lengthens it to the time matching the video.

Apply AI Audio Stretch on Windows

You can follow the steps below to change the duration of the audio efficiently.
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Step 1: Open the stretch function

After launching the Filmora application and adding audio, you can click the stretch icon on the toolbar.

Alternatively, you can select the detached audio clip in the timeline and click the "S" key from the keyboard to activate Audio Stretch.

Step 2: Set the time of the audio clip

Select the audio clip you want to modify first. Then, drag the music clip in the Timeline forward or backward to the point you want to start or stop it.

Re-edit Audio Stretch

You can follow the steps below to reset the length of the audio.

Step 1: Re-edit the length if you need

If you want to delete the effect, you can right-click the clip and choose Delete Audio Stretch to remove the stretch effect. Alternatively, click one more time the
stretch icon to set the duration again.

Note:

1Time limit: Filmora AI Audio Stretch only supports audio clips from 10s up to 10h.
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2The use of audio stretch will automatically remove the reverse effect used before for your clip.

13.5	AI Audio Denoise for Windows

This guide shows how to denoise the audio without worrying about losing important sounds.

AI approach is trained by deep learning model with a great amount of data. It performs better in removing the noise, generating a new clear audio signal with
distortion at the minimum.
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Usage Scenarios

Audio Denoise is crucial in scenarios. A variety of jobs rely on this function to enhance the quality of each video and audio.

As for journalists, cleaning up the background noise in the audio recordings is very helpful. It allows you to clarify what interviewees say or listen clearly about a fast
speech.

As for vloggers, reducing the background sound can let the audience hear your words even at a low and comfortable volume. It will result in more fans liking and
following your account.

Apply AI Audio Denoise on Windows

Here is the guide on how to launch this tool on Windows.

Step 1: Select the audio you want to process

After launching the Filmora application and adding video or audio to the timeline, you need to click the clip you want to remove noises. Then, the audio settings
window will appear on the right side of the interface.

Step 2: Make detailed adjustments

Slide the window to the bottom and click the button beside Denoise first to activate the function. Then, click the button on the right side of each tool to open the
function and make precise adjustments.

Adjust This Feature

There are 6 modes: AI Speech Enhancement,Wind Removal,Normal Denoise,DeReverb,Hum Removal, and Hiss Removal.

1 AI Speech Enhancement
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AI speech enhancement refers to the use of artificial intelligence (AI) algorithms and techniques to improve the quality of speech signals in various environments.
These algorithms are designed to reduce or eliminate unwanted background noise, reverberation, and distortion, making the speech signal more intelligible and easier
to understand. AI speech enhancement can be applied in various applications, such as telecommunications, hearing aids, voice assistants, and audio recordings.

2 Wind Removal

Wind Removal specializes in removing the noise of the wind. It estimates the reverberation profile and works out a way to change the amount of reverberation. You
can choose whether to turn on or turn off the function.

3 Normal Denoise

Normal noise is any usual noise that appears in the audio. There are three setting options, Low, Mid, and Strong. You need to decide to which extent you want to
remove noise. Lower settings apply less processing, retaining more audio in the original input.

4 DeReverb

Wind Removal specializes in removing the noise of the wind. It estimates the reverberation profile and works out a way to change the amount of reverberation. You
can choose whether to turn on or turn off the function.

5 Hum Removal

Hum noise refers to the hum or hiss sound. Hum Removal plays a significant role in removing narrow frequency bands as well as their harmonics. You can control
the amount of noise you want to reduce, with the range from -60 to 0.

6 Hiss Removal

Hiss Removal is a technique used to reduce or eliminate hissing noise in audio recordings. Hissing noise, or hiss, is a high-frequency noise that often results from the
recording equipment or environmental noise. This noise can be persistent and can detract from the overall quality of the audio. Hiss Removal technology works by
detecting and filtering out these high-frequency noises, resulting in a clearer and more professional-sounding recording.

Re-edit AI Audio Denoise

To reset all changes, you can click Reset at the bottom of the window or the refresh icon on the right side of the Denoise bar.

13.6	AI Music Generator for Windows

Filmora’s AI Music feature has been upgraded with a new integration tied to the Tianmu 2.0 music and sound effect API, alongside an AI-backed Advanced Mode.
Users can now benefit from flexible model mode switching, choosing between Normal and the more enhanced Advanced mode. The system supports creative
prompt input with an AI prompt extension and tag system, including sensitive word detection and multi-language input capabilities.
Furthermore, a feedback mechanism allows users to like, or dislike generated outputs, enhancing iterative improvements. These features combine to empower
creators to generate high-quality, professional soundtracks or effects effortlessly with global accessibility in mind. Here is how you can use this utility to craft
compelling music through AI:
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04Configure Other Music Generation Settings
05Review the Generated Outputs
06Generate Music With Normal Mode
07Set up Other Requirements and Generate Music
08Review the Music and Export
09Save the Generated Music As MP3

1. Start By Accessing the AI Music Feature

Launch the Filmora tool on your device and access its homepage. Next, locate the AI Music feature from there and click on it.

2. Create Music With Text Prompt

Access the Advanced section and input your text descriptions with a character limit of 100 for English-based prompts and 50 characters for prompts in Simplified or
Traditional Chinese. You can give a text prompt in other languages as well, as the tool offers multiple language support. If you cannot find the right words for the
prompt, you can use the Generate with AI button.

3. Add Creative Customization

Acquire the tag library from the bottom of the text field to select options across Genres, Moods, and Instruments. For genre tag, you can choose from Pop, Rock,
EDM, and other options. Mood tags allow classification based on the emotional tone or atmosphere, like happy or sad. Instrumental tags identify key instruments in
the track, such as guitar, piano, and drums.
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4. Configure Other Music Generation Settings

Expand the Settings option and select the Music Duration ranging from 1 to 90 seconds by dragging its slider. You can also keep the default duration for the audio,
which is 60 seconds. Once all the requirements are specified, hit the Generate button to execute the process.

5. Review the Generated Outputs

In Advanced mode, 3 results will always be generated according to your provided specifications within the interface. You can Like, Unlike, or listen to it by
selecting the desired option. Now choose your favorite results and press the + icon to add it to the editing timeline.

6. Generate Music With Normal Mode

Alternatively, you can access the Normal mode and select your music specifications, such as Mood, Genre, and Theme, by pressing the + button.
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7. Set up Other Requirements and Generate Music

Now expand the Setting option and select the Tempo from Low, Normal, or High levels. Next, choose the Music Duration up to 5 minutes by dragging the slider.
Finally, select the Generated Music Count by dragging the slider. You can generate up to 6 music outputs in one go. Hit the Generate button to successfully
execute the process.

8. Review the Music and Export

Once the audio is generated, drag it to the editing timeline and apply any enhancements using the Audio panel on the right. Once done, hit the Export button
located on the top-right to save the results.

9. Save the Generated Music As MP3

In the export window, choose the Format as MP3 and configure other settings. Finally, press the Export button to save the generated audio to your device.
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13.7	AI Vocal Remover for Windows

Song covers, remixes, and remakes have been in trend for decades, and the audience's love for them never dies. Keeping in view the interest of the audience and
editors' needs, Filmora added the Vocal Remover tool. Users can separate vocals from instrumentals and use them to generate content further. Here is a
comprehensive guide on incorporating the Filmora AI Vocal Remover tool:

Tip: Starting from Filmora version V14.9.0, it supports free voice separation for videos up to 1 hour in length.

Index
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02Method 2: Using the Timeline Option Panel

Remove Vocals From an Audio

If you want to diversify your music experience and create unlimited entertainment pieces through it, keep reading this step-by-step guide.

Method 1: Using the Top Toolbar

Step 1: Start Filmora and Create a New Project

Begin by downloading Filmora for your desktop and then click to start it. Next, proceed to log in or sign up through the "Profile" icon at the top. Afterward, navigate
to the control panel on the left-hand side and choose the "Create Project" option. From the various tabs visible in the main menu, click the "New Project" tab.
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Login and create a new project

Step 2: Import Files and Add to Timeline

Once you reach the main interface of Filmora, select "Media" from the custom toolbar and click on the "Files" icon to import your files in Filmora. Now, select the
imported files drag and drop them to the timeline panel.

Import media and place on track

Step 3: Enable the AI Vocal Removal Functionality

Next, select this music clip in the timeline, navigate toward the "Tools" tab at the top toolbar, and click it. From the dropdown menu, choose the "Audio" option and
select "AI Vocal Remover".
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Access vocal remover from tools

Method 2: Using the Timeline Option Panel

After bringing media to the timeline, select this video on the timeline panel and right-click it. From the options panel, find and select the "AI Vocal Remover."

Right click on clip in timeline

Filmora has come up with a cohesive inclusion of AI Voice Cloning, a dedicated functionality in Text-to-Speech which creates a realistic clone of your voice with a
few seconds of recorded audio. This feature is a game-changer in the video creation, which not only offers unique personalization, but also focuses on presenting a
precise result.

13.8	How To Execute AI Voice Cloning in Wondershare Filmora

The voice cloning feature believes in promoting personalized voice editing, which can be understood with the help of the step-by-step guide presented below:

Step 1. Accessing AI Voice Cloning in Filmora.

Upon launching Wondershare Filmora on your Windows device, select the "New Project" button to set up a new project. Import your editable media into Filmora
using the "Import" button. After dragging the video to the timeline, add your text preset using the options provided in the "Text" tab. Make essential edits and
navigate into the "Text to Speech" panel from the right-sided settings panel.
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You can take another navigation when looking for the "AI Voice Cloning" feature in Filmora. On launching Filmora, select "AI Text to Video" from the options
available on the homepage. As a window opens, provide the required text for the video, along with other settings. However, to clone your voice, tap the "Clone
Voice" button and continue the process.

Step 2. Start Recording Your Voice for Cloning

After you've selected the "Clone Voice" button, you will be prompted to accept the terms of use for this feature. Select "Record consent audio" to proceed to the
next page to record your voice. You have to choose the "Device" for recording the audio and then read out the paragraph provided on the window with proper
emotion and accent. To record, tap the "Red" button to start your voice recording.

  

 389/641

  

 



Step 3. Confirm Recording and Execute Cloning

You will have to read a total of two paragraphs for voice cloning. Once done, provide the name of your voice and click the "Clone Voice" button to process it
accordingly. If you have to record the voice again, select "Record Again" and repeat the process.

Step 4. Apply Clone Voice From the TTS Panel
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The platform will process and clone the voice successfully. As it appears on the right panel, select the cloned voice and click "Generate" to apply TTS settings to
your video with your cloned voice.

13.9	AI Sound Effect

AI Sound Effect, powered by the advanced Tianmu 2.0 model, aims to automate and simplify the process of creating personalized video audio. By inputting
descriptive keywords, you can generate high-quality, customized sound effects with a single click. This technology allows video creators to quickly and easily add
suitable audio effects to your video clips.

For a complete overview of this feature, explore the details in the guide:

How to Generate Customized Sound Effects with Filmora

Here is a step-by-step guide for you:

Step 1: Launch Filmora and Create a New Project

After downloading Filmora, open the program and log in or sign up from the main menu. Next, go to the control panel on the left and click "Create Project." Then,
choose the "New Project" tab from the menu that appears.

Click new project to start editing
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Step 2: Access the AI Sound Effect window

After selecting a new project, you'll be directed towards Filmora's main editing interface. From there, navigate towards the "Audio" tab in the top custom toolbar.
Following that, hover towards the panel at the left, select "AI Sound Effect."

Go to the audio tab

Step 3: Craft Your Prompt and Generate

The new interface provides powerful tools to help you create the perfect sound effect. You can either type your own description or use AI to get inspiration.

1. Describe Your Sound Effect

In the "Prompt" box, describe the sound effect you want to generate. Be as specific as you like. The prompt supports multiple languages and has a limit of 100
characters (or 50 Chinese characters).

Enter your description or use the new AI tools

If you need some creative help, use one of the new features:

Use Creative Tags: Click on tags like Object, Abstract, Animal, Environment, or Human to get ideas and add relevant keywords directly into the prompt
box.
Generate with AI: If you're not sure what to write, click the "Generate with AI" button. The AI will suggest a creative and detailed prompt for you, which
you can then use or edit.

2. Adjust Settings and Generate

Set the desired duration of sound effects you want to create. Once you are ready, click “Generate.”
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Adjust settings and click generate

Note:

All prompts are automatically checked for sensitive content to ensure a safe creative environment.

Step 4: Obtain Results

You can preview, download, and apply the generated sound effects to the timeline.

obtain results

You can view the downloaded sound effects in the "Downloads."
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view the downloaded sound effects

Note: The generated sound effect records can only be saved for 30 days. Therefore, if you are satisfied with the generated sound effects, please ensure you download
and save them promptly.

save the downloaded sound effects
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13.10	AI Voice Enhancer

This tool uses advanced AI technology to improve the quality of your voice recordings. Whether you’re a podcaster, video creator, or professional, this guide will
help you enhance clarity, reduce noise, and optimize audio for a polished, professional sound.
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01Apply AI Voice Enhancer
02Adjust Voice Enhancer

Apply AI Voice Enhancer

Here is the guide on how to launch this tool on Windows.

1. Click Create Project > New Project, then you can access the main interface.

create project in filmora

2. Add video or audio to the timeline.
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add video or audio

3. Click Audio > Basic > AI Voice Enhancer to activate the AI Voice Enhancer.
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activate the ai voice enhancer

Adjust Voice Enhancer

You can change the level by dragging the slider for Voice Clarity and Voice Beautification.

Note:
Voice Clarity: Reduce background noise and lower the volume of ambient sounds and background music to make the voice clearer.
Voice Beautification: Enhance the thickness and loudness of the voice to make it sound louder and more resonant.
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adjust voice enhancer

You can llisten the result until satisfying. When you are not satisfied with the changes, click the revert icon and then all the values will revert to the default.
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reset settings

13.11	Smart BGM Generation

Filmora offers intelligent background music integration to simplify video editing. This innovative feature automatically analyzes video content and adds fitting
music, enhancing the overall experience. To learn more about this function and its benefits, check the detailed guide!

How to automatically add suitable background music with Filmora

Here is a step-by-step guide for you:

Step 1: Launch Filmora and Create a New Project

After downloading Filmora, open the program and log in or sign up. Next, click "Create Project" in the left control panel and select "New Project" from the menu.
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Click new project to start editing.

Step 2: Import Files and drag to the timeline

Import videos or images and drag them onto the timeline.
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Import files

Step 3：Enable Smart BGM Generation

Kindly tab on the Smart BGM Generation icon on the toolbar and click "Create".

Enable Smart BGM Generation
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Click create

Note: If you don't see the Smart BGM Generation in the toolbar, click "Custom Toolbar" and drag Smart BGM Generation into the toolbar.
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Drag into the toolbar.

Step4: Start Generating BGM

After you click "Create," the program will begin analyzing the video content and matching the smart bgm.
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Analyze content
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Match the bgm

Once Smart BGM Generation is done, you will see the suitable BGM appear on the timeline.

BGM appear on the timeline

📌Note:

To ensure transparency and compliance when using Filmora's AI features, please be aware of the following:

The software interface will clearly identify all content created by AI.
For traceability, exported or downloaded AI-generated assets may include a visible or invisible watermark.

13.12	Audio To Video
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Audio To Video is a technology where users upload audio, and AI automatically generates matching video content. The AI analyzes the audio and creates visuals that
align with its tone and message, simplifying the process of creating synchronized audio-visual content.

For a complete overview of this feature, explore the details in the guide:

How to Generate Video Content

Here is a step-by-step guide for you:

Step 1: Launch Filmora and Click Audio To Video

Launch Filmora on your computer. On the launch page, select the Audio To Video.

launch filmora

Step 2: Upload Audio Files

After clicking Audio To Video, you can upload or drag and drop your audio files.
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upload audio files

Step 3: Start Generating Video Content

When uploading a video, you need to manually select the video source language. You can select the type of content in your video and set the Ratio, Duration, and
Number of generated. And also adjust the screen settings.
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Set Audio To Video settings

When you have everything set up, you can click Generate.

Tips: You can click on Generate offline to have the video content generated in the background.

generate offline

Step 4: Choose Your Video

Based on the uploaded audio and selected settings, the system will generate multiple results and assign a rating according to the platform's rules.
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obtain results

Tips:

You can also click "Reset" to regenerate it.
You can retitle the generated video.
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retitle the generated video

Step 5: Edit Your Video

Clicking "Edit" will take you to the editing panel, where you can either use or hide specific captions in Select Mode or view the script by timecode for more precise
editing in Time Code Mode.
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edit the generated video

You can edit text and video and If you're not happy with the current speech or want to add more dialogue, you can use the Text-to-Speech feature to create new
voiceovers from the text.

  

 411/641

  

 



edit text and video

📌Note:

To ensure transparency and compliance when using Filmora's AI features, please be aware of the following:

The software interface will clearly identify all content created by AI.
For traceability, exported or downloaded AI-generated assets may include a visible or invisible watermark.

Step 6: Export Your Shorts

Finally, open the Export window, select the social media platform (YouTube, Vimeo, TikTok) for your video upload, and customize settings such as the title,
description, category, resolution, and more.
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Export Your Video

14.1	Add, Edit, and Customize Texts

Learn how to add, edit, and customize texts, making it easy to create the text & titles that match your style.

Index
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04Remove Texts
05Favorite Texts

1. Types of Titles

Filmora makes it easy to create text & titles that match your style.

You will learn how to find titles and the types of titles.

How to Find Titles in Filmora?

1. Open Filmora at first, and once the welcome window pops up on the screen. Click on the New Project option.
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Open Filmora
2. In the upper corner of the editor's main window, you'll be able to see several tabs, like Audio, Titles, or Effects. Click on the Titles tab.

Click Title's Tab
3. Now, you can try to use the titles.

Filmora Titles

Upgrade to the Newest Filmora Unleash Your Freedom to Creativity
Free Download
For Win 7 or later (64-bit)
Free Download
For macOS 10.14 or later
Free Download

Types of Filmora Titles

Filmora has more than 1000 types of titles. You can see them on the left, choosing and downloading your desired titles.
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Filmora has especially provided a new type of title – 3D title. With stunning 3D text animations, you can bring your video to the next level. From metallic,
nature, to festival, you can get inspired and create with more than 40 3D text effects. Moreover, 3D text effects can be edited in batch to increase your editing
efficiency.

Filmora 3D Titles

3D Titles
Vertical
Plain Text
Word Art
Openers
Lower Thirds

Note:Click the inverted triangle to filter Titles to check if they are available for commercial use.

2. Edit Texts

Change the Duration

The default duration of a text effect is 5 seconds. There are two ways to change the duration of a text effect.

Drag the text on the timeline directly.
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Drag the text on timeline

Select the text in the timeline and click the "Duration" icon to set a new duration.
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Click the "Duration" icon

Drag the Title to the Timeline

You can drag it from the Titles library and drop it into the timeline. You can also right-click on the title effect you want and select "Apply" to add it to the timeline.
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Drag Title to the Timeline

Edit Text Effects

Right-click the font on the timeline, and the font editing panel will appear on the right. You can perform basic and dynamic editing on the font.

Edit text effects

Edit a Title with the Title Group Controller.

Double click the title in the track and the Title Group Controller will appear.
Enter values into the X and Y boxes to adjust the position.
Drag the scale slider to adjust the size of the title template.
Drag the rotate slider to change the orientation of the template.
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Title Group Controller

Advanced Text Editing

To edit your text in even more ways, click the Advanced button to enter the Advanced Text Edit panel.

Advanced text editing

In the Advanced Text Edit panel, you can add more elements to a premade title effect such as new text boxes, shapes, or images.
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You can customize your text effects in the Advanced Text Edit panel in the following ways: font, color, animation, opacity, fill, border (color and size), and shadow
(style, color, and size).

Advanced text edit panel

Curved Text

While you perform the basic edits across the added text, look for the "Shape" toggle in the "Basic" section after expanding the settings using "More Text Options."
On turning on the toggle, you will be able to see different curved text options that you can select according to your video aesthetics.

On enabling the option, select any curved option available and set its "Strength" to control the curvature of the text. If you want to change the curvature, manually
switch between the presets and override the previous edits. On disabling the "Shape" toggle, the curve effect will be reverted, and the text will return to its original
state.
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Curved Text

Add a Glow Effect

To make your titles stand out and grab the viewer's attention, you can add a vibrant glow effect. This feature is perfect for creating cinematic titles, highlighting key
information, or simply adding a stylish flair to your text.

Here’s how to apply and customize the Glow effect:

1. Double-click your text clip in the timeline to open the Text editing panel on the right.
2. Under the Basic tab, find the Glow option and enable the toggle switch next to it.

Enable the Glow Effect
3. Once enabled, you can customize the following parameters to achieve the perfect look:

Type: Choose the style of your glow. Filmora offers two types:
Glowing Edges: Applies a glow just to the outline of your text for a crisp, defined look.
Glowing Ray: Creates a softer, more diffused glow that radiates from the text, giving it a luminous feel.

Color: Click the color box to select a pre-made color, or use the eyedropper tool to pick a color directly from your video preview.
Intensity: This slider controls how bright and strong the glow effect is. A higher value creates a more prominent glow.
Range: Adjusts how far the glow spreads from the text. Increase the range for a wider, softer effect.
Horizontal Angle: This slider adjusts the horizontal direction of the glow, creating an offset effect. Drag it to the left or right to change the angle from
which the light appears to shine.
Vertical Angle: This slider adjusts the vertical direction of the glow. Use it to move the glow effect up or down, giving you precise control over the
light's position.

You can fine-tune these settings until your text has the exact visual impact you desire.
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Glow Effect Parameters

3. Text Presets

Filmora allows you to save customized text effects as presets for quick use in the future from both the Text Edit panel and the Advanced Text Edit panel.

In the Text Edit panel, after customizing your text (changing the font, size, color, position, or animation), click Save as Preset.

Find your custom presets

In the pop-up Preset Dialog window, enter a name for your new preset and click OK to save it.
The preset will be saved in the Custom folder under Titles.
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Find your presets

While in the Advanced Text Edit panel, you can save presets the same way: by clicking the Save as Preset button.

4. Remove Texts

There are two ways to remove tests from your video:

Select the text that you want to remove and hit "Delete" on your keyboard.
Right click on the text in the timeline and select "DELETE" from the menu.

5. Favorite Texts

Right click on the text in the Titles menu, and choose the text you like to add to favorites.
Or choose the text you like, you will see a "star"shape on the top right, click the "star" into green.
You can check your favorite texts on the left Mine- Favorites.

14.2	Text Animation

There are 80+ animation presets available in Filmora. Try to create your video!

Choose an ideal text effect and drag it to the timeline. Double-click it to have the advanced editing options
Switch to the Animation tab in the Text Editing panel

Switch to Animation Tab

Double click on the animation you want to try, and watch the Preview window to see what it looks like
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Preview the animation

Click OK to apply the animation to your title.

15.1	Advanced Text Edit for Windows

In Filmora, users can edit their text better than usual through its Advanced Text Editing feature. Commencing this functionality will allow users to apply different
animations and presets to their text. In addition, users can customize other elements such as "Fill," "Outline," "Shadow," and "Background." To learn how you can
enable and apply all these enhancements in your text, find the guide below:

Index

01Method 1: From the Timeline Toolbar
02Method 2: Using the Custom Toolbar

Accessing the Advanced Text Edit Option

Now that you are familiar with this feature, it is time to learn how to operate it by following the steps given below:

Method 1: From the Timeline Toolbar

Step 1: Launch Filmora and Create a New Project

Start by downloading this software on your device and launch it to access its main menu. Use your mouse to reach the "New Project" option and click it.

Start with creating a new project

Step 2: Access the Quick Text Option

Upon reaching Filmora's editing interface, use your mouse to locate the "Quick Text" option in the timeline toolbar and click any options from the dropdown menu.
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Click the quick text option

Step 3: Activate Advanced Text Option

Once you enable "Quick Text", a title will appear on the timeline. Select this title, hover towards the settings panel on the right side, and click the "Advanced"
option.

Click the advanced button

Step 4: Start Editing by Accessing the Presets Tab

Following that, the "Advanced Text Edit" window will appear, where you can see many editing options. Add any text, and from its right-side panel, click on the
"Presets" tab and apply a suitable preset to your text.

Add a preset

Step 5: Make Customizations in the Added Text

After adding a preset, navigate towards the right-side panel again and click the "Customize" tab. Under this tab, you can make a diverse range of changes in your
text color, gradient, opacity, and more.
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Customize the text settings

Step 6: Add Animations to Your Text

Accessing the "Animation" tab in this window allows users to download and apply different types of animations in the text to make it appealing. Define its
"Duration" according to the applied animation to make the content engaging.

Apply animations to text

Step 7: Finalize the Changes

Once you are done, click the "Apply" button to finalize and add these edits to the timeline. Afterwards, you can apply other effects or enhancements to it.
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Click apply to finalize the settings

Method 2: Using the Custom Toolbar

In Filmora's window, navigate towards the "Title" tab in the custom toolbar and select any of the titles. Afterward, drag and drop the title to the timeline panel and
select it. From the settings panel at the left, click the "Advanced" option to proceed.

Access the title tab to initiate

If you wish to improve the outlook of your video, you can include effects into it. Filmora extends this feature by providing different directories and categories of
effects for impressive editing. One of its newly added directories include the Audio Driven Text category, which has been added into the resources. With defining
settings, you can make your video professionally proactive with these effects.

15.2	How to Use Audio-Driven Text Effects in Wondershare Filmora
To understand the simple process of using Audio Driven Text effects in Wondershare Filmora, follow the stepwise guide provided below:

Step 1. Access Audio Driven Text Category

After launching Wondershare Filmora on your Windows computer, proceed to add the video file using the "Import" button. On adding the video, continue to drag it
onto the timeline and redirect it to the "Titles” tab. Continue into the “Title Templates” section and look for the “Audio Driven Text” category.
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Access Influence Kit Section on Filmora

Step 2. Change Properties of Audio-Driven Text

To make changes to your added title effect, lead into the "Titles" section and look for the "Effects" sub-section. With the sliders, change the "Sensitivity" and
"Strength" of your added titles to change the emphasis of the added titles.
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Access Influence Kit Section on Filmora

Titles have always been a unique way of communicating with the viewers across a video. Video editors consistently look for text presets that can look attractive on
their video. Filmora has introduced the feature of Curved Text, which allows users to shape their text according to their video requirement.

15.3	How To Utilize Curved Text Feature in Wondershare Filmora

To understand how editors can enjoy this highly attractive addition to the text editing system, look across the steps provided below:

Step 1. Access the Titles Tab in Filmora

After creating a new project in Filmora, access the "Titles" tab from the top toolbar and add your favorite text preset onto the timeline.

Step 2. Apply Curved Text and Adjust

While you perform the basic edits across the added text, look for the "Shape" toggle in the "Basic" section after expanding the settings using "More Text Options."
On turning on the toggle, you will be able to see different curved text options that you can select according to your video aesthetics.

On enabling the option, select any curved option available and set its "Strength" to control the curvature of the text. If you want to change the curvature, manually
switch between the presets and override the previous edits. On disabling the "Shape" toggle, the curve effect will be reverted, and the text will return to its original
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state.

15.4	Text Animation Path for Windows

Filmora V14.2 introduces an exciting new feature—Text Path Animation. This feature allows creators to animate text along a customizable path, making highlighting
key phrases, titles, or special effects in your videos easier. Here's everything you need to know to use this feature and elevate your video content.

Here is the step-by-step guide: How to Use Text Path Animation

Step 1: Add Text to Your Video

Open your project in Filmora, then Go to the Titles menu and drag a text preset onto your timeline. Double-click the text to open the Text - Basic panel.

Step 2: Enable Text Animation Path

In the Text Basic Properties panel, locate and open the Bezier Path settings.

Step 3: Customize the Text Animation Path

Click on any position of the bottom line of this text, then create a new point.
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Drag points to customize the shape of the text path.

Click on a point, then drag the endpoints on either side of the point to reorient the text.
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Then you can adjust the text path to any shape according to your needs.

If you want to delete the unwanted points, just choose it and enter 'delete':

You can also adjust the Path Offset and Animation Duration, choose Animation Loop.

Conclusion

Filmora V14.2’s Text Path Animation feature is a game-changer for video creators. Its customizable paths, user-friendly interface, and diverse animation styles open
up new possibilities for creative expression. Whether you're a beginner or a seasoned editor, this tool empowers you to create stunning text animations effortlessly.
Start experimenting with Text Animation Path today and bring your video ideas to life with Filmora!

16.1	Speech to Text/Text to Speech/SRT for Windows
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These features enhance the dubbing and subtitle editing experience and improve editing efficiency.

Index

01Speech to Text (STT)
02Text to Speech (TTS)
03SRT
04Operating Tips

Speech to Text (STT)

Product Usage Scenarios

Vlog bloggers can convert the video to text after recording the speech video and add subtitles quickly.
Teachers can convert the course into text and add it to the video after recording.
Podcasters can convert the audio into text for listeners after recording.
Journalists can convert interviews into text for easy reference and quoting in articles after recording.
Business professionals can transcribe meetings into text to ensure accurate records and share notes with team members.

Function Entry

Method 1 - Select the audio asset in the timeline, click Tools on the top menu bar, and click Audio > Speech to Text.

Speech to Text

Method 2 - Select the audio asset in the timeline, and click the Speech to Text icon in the toolbar; if there is no supported file type on the timeline, it will not
be displayed.

Toolbar Speech-to-Text

Method 3 - Select the audio asset on the timeline, right-click and select Speech to Text.

Timeline Speech to Text
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Method 4 - Similarly, select the audio asset in the project media, right-click and select Speech to Text.

Project Speech to Text

Method 5 - Select the audio asset in the project media, and click Titles on the top menu bar, and click AI Captions > Speech to Text.

Titles Speech to Text

Parameter Settings

In the STT parameter setting bar, select the language of the audio to be transcribed and files to be converted and check automatically match to the timeline.
Now, the feature supports direct transcription of bilingual subtitles.
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Speech to Text Parameter Settings

Note:

In the language option, you need to select the language of clip transcription.

Task List

The task list will display the file's transcoding and transcription completion.
The list is displayed from top to bottom, with the first imported file shown in the top position. It supports sliding up and down.

Speech to Text Parameter Settings

File Generation

The generated file will be displayed in SRT format.

Text to Speech (TTS)

Product Usage Scenarios

This function satisfies the needs of people who cannot dub and are unwilling to expose their voices to dub voiceovers for videos—E.g., news presentations.
Game developers can use TTS to provide dialogue for characters, allowing for quick testing and iteration.
Content creators can use TTS to translate videos into multiple languages and generate corresponding voiceovers.
Teachers can use TTS to generate voiceovers for online courses without recording their own voices.

Function Entry

Method 1 - Select title assets in the timeline, click Tools on the top menu bar and click Text to Speech.
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Text to Speech

Method 2 - Select the title asset in the timeline, and click the Text to Speech icon in the toolbar; if there is no supported file type on the timeline, it will not be
displayed.

Toolbar Text to Speech

Method 3 - Select the title asset on the timeline, right-click and select Text to Speech.

Timeline Text to Speech

Method 4 - Cick Audio on the top menu bar, and click Text to Speech.
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Audio Text to Speech

Split Paragragph Intelligently- Enter a long paragraph of text, and Filmora will split it intelligently.

Split Paragragph Intelligently

Parameter Settings

Select the language this title is in and the voice name in the TTS parameter setting bar. You can click "Filters" to select and customize your preferred tones.
You can also adjust Speed and Pitch by moving the left and suitable scroll bars.
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Text to Speech Parameter Settings

Choose different moods to express yourself, such as angry, shouting, hopeful, etc.

Choose Different Moods

Note:

Remember to tick "Transcriptions are automatically matched to the timeline" if you need.

Task List

Double click on the completed list and the generated file will be highlighted.

File Generation
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The generated voice format is MP3, the file is automatically stored in Media, and the local location is the same as the default storage location of the existing
Filmora file.

SRT

Product Usage Scenarios

SRT files exported by other tools can be imported into Filmora for editing, which provides more convenient subtitle editing.

Operating Procedures

Import SRT subtitle files directly from the Media resource area.
Right-click on the timeline and select Advanced Edit or double-click the selected SRT file to clip.

Select SRT Clip

You can do the following editing operations:
❶ Edit Time code.
❷ Change subtitles.
❸ Add/remove/merge subtitle strips.
❹ Change subtitle styles (same as Filmora Advanced Edit Text)

SRT Subtitle Editing

Select the SRT file on the timeline, right-click and select Export Subtitle File.
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Export Subtitle File

Support SRT Files

If you don’t like the voice on your video, Filmora can help you to convert the SRT files into various voices in one click.

Select the SRT file from the timeline, and then right-click on it to choose Text-to-Speech.

A new window will appear, select your desired voice name and adjust the audio settings, click OK to start conversion.
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📌Note:

To ensure transparency and compliance when using Filmora's AI features, please be aware of the following:

The software interface will clearly identify all content created by AI.
For traceability, exported or downloaded AI-generated assets may include a visible or invisible watermark.

Operating Tips

❶ Are the STT/TTS licenses the same as Win and Mac versions?

No. Like the Filmora license, the configuration is differentiated according to Win and Mac.

❷ Will the authorization be repeated after STT/TTS recharge multiple times?

Yes. Different from the extension of the expiration time after multiple purchases of Filmora, the unit of STT/TTS is the number of hours/characters, and multiple
purchases automatically accumulate numerous hours/characters.

❸ What if I want more STT/TTS character packs?

You can contact customer service directly on the purchasing page.

❹ If upload/transcription fails, will the STT/TTS character balance be deducted?

No.

❺ If the file format is not supported, will the STT/TTS character balance be deducted?

No.

❻ If a task is removed during the upload/transcription process, will the STT/TTS character balance be deducted?

If the task fails, it will not be deducted; if it is successful, it will be deducted.

16.2	AI Translation for Windows

Wondershare Filmora's AI translation feature can effectively translate multiple sources of languages into your desired one. Following are the proper directions to
access and use the AI translation option of Filmora Windows:

How to Translate Videos in Filmora?

01Launch Filmora and Initiate a New Project
02Add Video To Timeline and Access AI Translation Feature
03Set Parameters for Translation
04Start Translating Videos
05Wait and Export the Final Results

Step 1: Launch Filmora and Initiate a New Project
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To start, launch Filmora on your desktop and continue to select the "New Project" button from the homepage. When directed to the editing window, select the
"Import" button in the media panel and import your required video content.

Step 2: Add Video To Timeline and Access AI Translation Feature

As you drag and drop the video content into the timeline, navigate to the toolbox and find AI translation, then drag and move it above the timeline.

Alternatively, you can expand the editing box and click the AI Translation icon.

In addition, you can right-click on the video in the timeline and choose the "AI Translation" option from the dropdown menu.
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Note: For the combined voice and text translation, Filmora can recognize 23 source languages, such as Spanish, German, or Italian. While translating, it can only
translate your content into 14 target languages. However, when it comes to text translation, it supports translating all 23 languages it recognizes.

Step 3: Set Parameters for Translation

Once you choose AI Translation, a dialogue box will appear.

Translation Type: Choose "Translate voice and text" or "Only translate text."
Source Language: choose the video language from the dropdown lists.
Target Language: select from 14 different languages.
Auto match: match the transcription to the timeline. (This option is on by default)

Note: Lip Sync is a new feature that synchronizes the audio with the speaker's lips. If you want to try this feature, just check the little box. It is unchecked by default.
It only appears when you click "translate voice and caption" under the translation type. And this feature is only available for videos that are 5 minutes or shorter;
videos longer than 5 minutes will be grayed out.

Step 4: Start Translating Videos

After all settings are done, click translate to start translating videos.
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Step 5: Wait and Export the Final Results

A pop-up screen will appear showing the translation processes. Wait until you get the "Completed" status, which means the translation is done. Finally, you can close
this dialogue box and play your media to see results. Later, proceed to the top-right side and use the "Export" button to save the media on your device.

📌Note:

To ensure transparency and compliance when using Filmora's AI features, please be aware of the following:

The software interface will clearly identify all content created by AI.
For traceability, exported or downloaded AI-generated assets may include a visible or invisible watermark.

Wondershare Filmora previously offered a Speech-to-Text feature that helped users convert their video's speech into captions or subtitles. Filmora recently released
the Auto Caption feature, which automatically includes dynamic subtitle effects after STT transcription. This feature allows users to develop more interactive content
with automatic highlighting.

16.3	How To Use Auto Caption Feature in STT of Wondershare Filmora?
While looking for more interactive options to make your subtitles and captions better, have a look into how Filmora has made it effective with the Auto Caption
feature:

Step 1. Launch Filmora and Access the Speech-to-Text Feature

Start by launching Wondershare Filmora on your Windows device and continue by selecting the "New Project" button. Continue to add your video by using the
"Import" option and drag it onto the timeline. Once you've successfully added it to the timeline, right-click to open a drop-down menu and select "Speech-to-Text”
from the options.
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Step 2. Enable the Auto Caption Feature and Execute

As you are directed onto a new pop-up window, make sure to enable the “Add automatical active words” option along with other settings. This enables the Auto
Caption feature in STT, which is executed by clicking the “OK” button on the bottom.

  

 445/641

  

 



Step 3. Change the Style of Added Captions With Templates

Once the video is successfully transcribed, the converted speech is displayed as text across the timeline. Dynamic subtitles are successfully added as captions to the
video with proper accuracy. To change the style of your added subtitles, go to the "Titles" section and find a variety across the "Templates" sub-section. Select and
choose "Apply to All" to change all the video captions.
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Step 4. Change Font Properties and Export

For bringing changes to the font style, size, and color scheme to match your video branding, lead to the "Basic" sub-section and make necessary changes. If you wish
to apply this to all captions, use the "Apply to All" button. Simply lead to the "Export" button for saving the transcribed video to your computer.

Access Influence Kit Section on Filmora

Bonus: Check here to learn more about how to use AI Caption on Mobile.

You can click to see more details about Best 6 Video Dubbing Apps >>

17.1	Filmstock Asset

When you edit your video with Filmora, you may see some effects and resources from Filmstock. And you will feel confused about that.Read this guide and you will
find the answers.

Index

01What is Filmstock
02What does Filmstock Have
03How to Use Filmstock

What is Filmstock

Filmstock is a video asset designed for Filmora, including video templates, elements, transitions, titles, video clips, music, sound effects, and high-resolution images.

You can visit Filmstock for more information.

What does Filmstock Have:

Over 400 effect packs for all types of videos, and always keeps updating.
Various video clips like nature, lifestyle, business, animals, food, and more. You can try them in Filmora video editor.
Unlimited downloads of 70K+ high-quality images.
1700+ music and audio effects for transitions, gaming, intro, social media, movie, birthday, or blockbuster.

How to Use Filmstock

There are two methods to help you.

Method 1: Download and Use Filmstock Resources from Filmora.
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1 When you use Filmora, you will notice that some resources have a “diamond” shape on the top left. These are resources from Filmstock.

Find Filmstock resources

2 Download the resources and drag it to the timeline. Try it free.

3 If you want to use and download your video with these Filmstock effects, you can click to purchase for more service.

Method 2: Download Filmstock Resources from Filmstock Official Website and Use it in Filmora.

1 Login Filmstock by using the same account of Filmora.

Note:

The resources of Filmostock can’t be used if you don’t download Filmora.

2 Choose the resources in Filmstock to download and use in Filmora.

3 Find the Filmstock you downloaded under the folder “Filmstock” - Effect on Filmora.

  

 448/641

  

 



Find Filmstock on Filmora

17.2	Body Effects

Filmora comes with a library of Body effects that can be used to enhance emotions, emphasize reactions, and add personality to your video. The face-tracking mask
effects are image-based effects, with cute and fun elements such as cats, bears, pandas, koalas, bunnies, glasses, and much more.

Note:

Mask effects work best when applied to a person facing the camera. If there is more than one person in the frame, the mask effects will be applied to whichever face
it detects.

Index

01 Add the Mask Effects
02 Customize the Mask Effects
03 Adjust the Mask Effects
04 Remove the Mask Effects

Add Mask Effects

There are three ways to add mask effects to a video:

Method 1: Open your project, go to Effects >Body Effects, and then select the effect that you want and add it to your project.

Add Mask Effects

Method 2: Hover your mouse over the effect you want. When you see a Plus icon in the middle, click it. Then the effect will be added to the timeline.
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Add Mask Effects

Method 3: Drag it the track above the video in the Timeline.
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Add Mask Effects

Customize Mask Effects

Double-click on the effect in the timeline to customize its position and other settings. Then, you preview how your clip looks with the effect applied to it in the
Preview Window.
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Customize Mask Effects

Adjust Mask Effects

If you only want to add the mask effect to a small part, you can drag the edge of the effects to adjust the duration.

Adjust Mask Effects

Now, you can play the video and you will see the mask effect. You can repeat the steps above to add multiple Mask Effects to your video.

Remove Mask Effects

To remove the applied mask effects, right-click the Effect in the Timeline and select Delete.
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Delete Mask Effects

Or press the Delete button on your keyboard when you have chosen the Effect.

Delete Mask Effects

17.3	Different Types of Video Effects
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Filmora is a powerful video editing software with thousands of video effects, which can help to make your videos or audios more creative and brilliant.

Upon reading this guide, users will learn about how to commence the step-by-step action of adding different effects:

Index

01Mosaic Blur Effects
02Face-Off Effects
03Mask Effects
04Countdown Effects
05Overlay Effects

Mosaic Blur Effects

The mosaic effect allows you to blur a specific area in the video or the whole video.

Step 1: Adding Mosaic Effect to Blur Objects in Video

Click the Effects tab at the top, find Video Effects, and click Trending. Find and drag the Mosaic effect to the track above the video.

You can move it to the required timing in the timeline and adjust its duration. In the Preview window, drag the handles of the mosaic effect to adjust its size and
position to get the results you want.

Add Mosaic Effect

Step 2: Adjust Mosaic Effect

Click on the mosaic effect in the timeline to enter the Effects editing panel. You can choose the blur type from the presets, drag the slider to adjust the Blur Amount
and Opacity.
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Adjust Mosaic Effect

Step 3: Adding Mosaic Effect to Whole Video

In the Effects tab, scroll down to the Video Effects category, and type "Mosaic" in the search box. Then a bunch of related effects will appear. Choose the "Pixelate
Store" or the "Pixelate 2" effect.
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Add Pixelate Mosaic Effect

Step 4: Adjust Pixelate Mosaic Effect

Drag one of the pixelate effects to the track above the video. Click the pixelate effect in the timeline to adjust its SquareSize and Opacity.
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Adjust Pixelate Mosaic Effect

Face-Off Effects

The difference between Mosaic effect and Face-off effect is that, with Mosaic, you can blur any area in the video and the area won't move around while your video
plays, whereas, with Face-off, you can cover moving faces.

Step 1: Find Face-Off Effect

Go to the Effects tab at the top and scroll down to the Video Effects. You can find the Face-Off Effects here.
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Find Face-Off Effect

Step 2: Apply Face-off Effect

Select Face-off effect and drag it to the track above the video. By default, the face will be blurred with mosaic.
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Apply Face-off Effect

Step 3: Change Face-off Preset

Double-click the face-off effect in the timeline to enter the Effects editing panel. There are many face presets you can use for fun, choose one and click OK to save
changes.
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Change Face-off Preset

Mask Effects

Filmora's masking feature is a professional-grade and efficient technique to hide an object while editing the other. Users can apply different effects, transitions, and
much more on a single object in a video through it. However, sometimes, you need more time for the precision masking.

Step 1: Access the Mask Effects

Click the clip in the timeline and navigate towards the "Effects" tab, and go the "Basic" category under "Video Effects".
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Access the Mask Effects

Step 2: Drag and Drop the Desired Mask Effects

Once you have selected a desired mask, use the drag-and-drop functionality to bring this mask to the timeline track above the media clip. On clicking the "Play"
button on the preview window, check the results of the application.
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Apply the mask on the clip

Timer Effects

Timer effects are widely used in exercise videos, ecommerce videos and travel vlogs. Filmora now provides you with various dynamic Timer effects that will help
you make the video more impressive.

Run Filmora and then go to "Effects" from the navigation bar and find the category "Timer" under Video Effects. You'll see s list of Timer effects.
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Drag your desired one and add it to your videos in a suitable position.

  

 463/641

  

 



Overlay Effects

Step 1: Add Overlays Effects

Wondershare Filmora enables you to add as many overlays as you want. There are two ways to add overlays to a video.

Method 1: Open your project, go to the Effects tab, and then select the overlay you want and drag it to the timeline. The overlay will be applied to the whole video
clip this way.

Drag Overlay to Timeline

Method 2: Hover your mouse over the overlay effect you want. Click the plus icon. Then the overlay will be added to the timeline.
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Add Overlay Effects to Timeline

Note:

If you are editing a "portrait" (9:16) clip in a 16:9 video, you can add background blur filters to replace the black bars.

Step 2: Customize Overlays Effects

To change the duration, the default length is five seconds, but you can drag the edge of the overlay effect in your timeline to change its duration.

Change Duration of Overlay Effects

Step 3: Change the Opacity of Overlay Effects

The opacity (transparency) property can have a value of 0-100. A lower value makes the overlay effect more transparent.

Double click on the filter in the timeline to customize its opacity. Then, you preview how your clip looks with the overlay effect applied to it in the Preview Window.
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Change Opacity of Overlay Effects

Step 4: Remove Overlay Effects

There are two ways to remove overlays from your project.

Method 1: Select the overlay in the timeline and hit Delete on toolbar.

Delete the Overlay Effects

Method 2: Right click on the overlay in the timeline and select Delete from the menu.
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Delete the Overlay Effects

Step 5: Favorite Overlay Effects

Right click on a overlay effect in the Effects menu and select Add to Favorites. Or you can click the Star icon on the Effect cover. Then, go to the Favorite category
to find it again quickly.
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Favorite Overlay Effects
We have more! Check Filmora Effect Store to learn more. Or want to create a sand dissolve effect, we also prepare the guide for you.

17.4	Boris FX Effects

Filmora now supports Continuum, professional-quality effects plugins from award-winning developer, Boris FX. 7 Continuum Units have been customized for
Filmora users, unleashing amazing creative visual effects and graphics potential. Each Continuum unit contains multiple filters with complementary creative presets
designed by Boris FX. Browse from the unique effects and thousands of presets.

Index

01Find Boris FX effects
02Download and Install Boris FX Effects
03Add Boris FX Effects
04Modify Boris FX Effects
05Remove Boris FX Effects

Find Boris FX effects

Launch Filmora on your device and import the video files. After importing the files, go to Effects>Boris FX. You can also click "Learn More" to get more
information about Boris FX effects before downloading the plugin.

Find Boris FX effects
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Download and Install Boris FX

To use the Boris FX plugin, you need to download and install the Boris FX effect plugin. Since the plugin effect package is about 500M, it will take time to
download the package. Please wait patiently.

Downloading Boris FX Plugin

After the download process is finished, follow the guide to click "Restart Now".

Restart Filmora

Add Boris FX Effects

Go to Effects>Boris FX to add and preview the Preset effects.

You can see the Boris FX effects, such as BCC Plus Streaks, BCC Plus Relight, BCC Plus Reflector, BCC Plus Rays, BCC Plus Overexpose, BCC Plus Lights, BCC
Plus Lens Flare and so on.

  

 469/641

  

 



Preview Boris FX Effects

You can click "Add to Project" to try to add the effects to your videos.

Add to Project

Or you can choose to drag and drop the desired audio effect on the timeline track above your video and play to see the results.

  

 470/641

  

 



Add Boris FX Effects to the Timeline

Modify Boris FX Effects

Double-click on the effect in the timeline to customize its settings, for example, Light/Shadow/Transform and so on. Then, preview how your clip looks with the
effect applied to it in the Preview Window.
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Modify Boris FX Effects

Remove Boris FX Effects

There are two ways to remove Boris FX Effect from your project.

Method 1: Select the Boris FX Effect in the timeline and hit Delete on the toolbar area.

Remove Boris FX Effects

Method 2: Right click on the Boris FX Effect in the timeline and select Delete.
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Delete Boris FX Effects

17.5	NewBlue FX Effects

You can now use the following NewBlue effect collections that have been customized specifically for use in Filmora: Stylizer, Essentials, Filters, Elements, and
Titler Pro. Each collection contains a set of factory-installed, professionally designed presets. These five collections include 100+ unique effects and 500+
professionally designed custom title presets.

Index

01Find NewBlue FX Effects
02Download and Install NewBlue FX Effects
03Add NewBlue FX Effects
04Modify NewBlue FX Effects
05Remove NewBlue FX Effects

Find NewBlue FX effects

Install and Launch Filmora on your device. After importing the files, go to Effects> NewBlue FX.
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Find NewBlue FX

You can choose to learn about NewBlue FX effects before downloading the plugin.

Find NewBlue FX effects

Download and Install NewBlue FX Effects

To use the NewBlue FX plugin, you need to download and install the NewBlue FX effect plugin.
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Download NewBlue FX Effects

Since the plugin effect package is about 600M, it will take time to download the package. Please wait patiently.

Downloading NewBlue FX Effects

After the download process is finished, restart Filmora to load NewBlue FX effects.

Restart Filmora

Add NewBlue FX Effects

Go to Effects>NewBlue FX to add and preview the Preset effects.

You can see the NewBlue FX effects, such as Stylizer, Essentials, Filters, Elements, and Titler Pro.
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Preview NewBlue FX Effects

You can click "Add to Project" to try to add the effects to your videos.

Add to Project

Or you can drag and drop a desired audio effect on the timeline track above your video and play to see the results.
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Add NewBlue FX Effects to the Timeline

Modify NewBlue FX Effects

Double-click on the NewBlue FX effect in the timeline to customize its settings. Then, you preview how your clip looks with the effect applied to it in the Preview
Window.
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Modify NewBlue FX Effects

Remove NewBlue FX Effects

There are two ways to remove NewBlue FX Effect from your project.

Method 1: Select the effect in the timeline and hit Delete.

Remove NewBlue FX Effects

Method 2: Right click on the effect in the timeline and select Delete from the menu.

  

 478/641

  

 



Delete NewBlue FX Effects

18.1	Audio Visualizer Effects

The function of the Audio Visualizer solves the problem that single audio cannot be distributed as a video on the video platform and can improve the video quality at
the same time.

This section includes an in-depth overview of Audio Visualizer in Filmora:

Index

01Target Users
02How to Use
03Tips to Use More Efficiently

Target Users

For Podcast Users

You can use this function to play your insights and stories. In addition, you can add pictures, text, and vibration waveforms to the speech.

For Music Video Lovers

Make one or more songs into a video and post it on YouTube, FB, Ins, Twitter, and other platforms to get attention and share your mood.
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How to Use Audio Visualizer

Start Filmora and Click Open Project

Upon successfully downloading Filmora, open it and log in or sign up from the main menu. Afterward, direct the cursor towards the control panel at the left and
select "Create Project". From the numerous tabs appearing on the main menu, tap on the "New Project" tab.

Start Filmora and Click Open Project

Import your audio assets and add it the timeline.
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Import Audio Assets

Locate Audio Visualizer

Afterward, navigate towards the "Effects" tab, and from the left side panel, expand the "Audio Effects". Further, under the "Audio Visualizer", you'll find a
collection of audio visualizer effects.
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Locate Audio Visualizer

Add Audio Visualizer

Select the audio visualizer particle you like, drag it to the timeline, and place it on the track above audio.
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Add Audio Visualizer

Note:

You can also select the particle, right-click and select Apply, and then place it on the track above audio.

Adjust Audio Visualizer

After dragging the audio effect to the timeline, you can double-click the effect to adjust the properties. Pull the left and right scroll bars of Intensity, Opacity, Radius,
Position X and Position Y to adjust the corresponding values.
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Adjust Audio Visualizer

Preview the results

Click Play from the Preview Window in the upper right corner to view the effect.
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Preview the results

Remove Audio Visualizer

If you want to remove all applied effects from the clip, right-click it in the timeline, and select Delete. The applied audio effects and other video effects such as filters
or overlays will be removed altogether.
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Remove Audio Effects

Tips to Use More Efficiently

Audio visualization particles only support dragging to the track and temporarily do not support dragging and dropping to other clips to become their Effect
properties.
Audio visualization particles temporarily do not support player visualization editing.
The 5 audio visualization particles combined with keying may have the same problems as the AI Portrait function: The display effect of the screen without
characters is not perfect enough.
Audio visualization particles may freeze without pre-rendering, but it does not affect the presentation effect.

18.2	Audio-Driven Effects

In Filmora, users can employ different audio-driven effects to add a touch of music and dramatic effects to their videos. In its effects library, there are multiple audio-
driven effects according to video contexts that you can apply. In this guide, we’ll talk you through the procedure of accessing and applying audio-driven effects.

This section includes an in-depth look into starting and utilizing audio-driven effects in Filmora:

Index

01Start Filmora and Click Open Project
02Add Audio-Driven Effects
03Apply an Effect from the Collection
04Adjust Audio-Driven Effects
05Remove Audio-Driven Effects
06Favorite Audio-Driven Effects

Start Filmora and Click Open Project

Upon successfully downloading Filmora, open it and log in or sign up from the main menu. Afterward, direct the cursor towards the control panel at the left and
select "Create Project". From the numerous tabs appearing on the main menu, tap on the "New Project" tab.
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Start Filmora and Click Open Project

Add Audio-Driven Effects

Afterward, navigate towards the "Effects" tab, and from the left side panel, expand the "Audio Effects". Further, under the "Audio Driven Effect", you'll find a
collection of pre-built relevant effects.

Add Audio-Driven Effects

Drag and drop a desired audio effect on the timeline track above your video and play to see the results.
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Add Audio-Driven Effects

Or you can click the "+" on the effect template to apply it to the project.
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Drag Audio-Driven Effects to Timeline

Apply an Effect from the Collection

Upon selecting an effect, drag and drop it on the timeline track above your video and navigate toward the preview window to play and see the results.
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Apply an Effect from the Collection

Adjust Audio-Driven Effects

After dragging the effect to the timeline, you can double-click the effect to adjust the sensitivity.
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Adjust the Sensitivity

Remove Audio-Driven Effects

Select the effect you want to remove from the timeline and hit the "Delete" button.

Remove Audio-Driven Effects

Or right-click on the effect in the timeline and select the "Delete" option from the menu.
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Delete Audio-Driven Effects

Favorite Audio-Driven Effects

Right-click on the audio-driven effect in the effects menu and choose to Add to Favorites.
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Select “Add to favorites”

Or you can also choose the effect as your requirement. You will see a "Star" shape on the top right. Click the "Star" into the green.

Click on the Green Star

You can check your favorite audio-driven effects from the left drop-down list - Favorites.
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Find the Favorite Effects

18.3	Voice Changer Effects

Filmora's voice changer feature offers a quick option to change the overall voice and sound of the video. With a dedicated Voice Filters and Voice Characters option,
you can make immediate and effective changes to the voice and sound. Along with a variety of options, Filmora provides a quick and interactive system for editing
your video's sound.

For a better understanding of how users can access the voice changer feature in Wondershare Filmora, have a look at the detailed steps:

How to Use the Voice Changer Feature in Wondershare Filmora

Index

01Start Filmora and Click Open Project
02Add Voice Changer Effects
03Apply an Effect from the Collection
04Adjust Voice Changer Effects
05Remove Voice Changer Effects
06Favorite Voice Changer Effects

Start Filmora and Click Open Project

Upon successfully downloading Filmora, open it and log in or sign up from the main menu. Afterward, direct the cursor towards the control panel at the left and
select "Create Project". From the numerous tabs appearing on the main menu, tap on the "New Project" tab.
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Start Filmora and Click Open Project

Add Voice Changer Effects

Afterward, navigate towards the "Effects" tab, and from the left side panel, expand the "Audio Effects". Further, under the "Voice Changer", you'll find a collection
of pre-built relevant effects.

Add Voice Changer Effects

You can click the "+" on the effect template to apply it to the project.
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Drag Voice Changer Effects to Timeline

Apply an Effect from the Collection

Upon selecting an effect, drag any particular voice filter or character filter to the timeline to make changes to your video's audio and navigate toward the preview
window to play and hear the results.
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Apply an Effect from the Collection

Adjust Voice Changer Effects

After dragging the effect to the timeline, you can double-click the effect to adjust the strength.
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Adjust the Strength

Conversely, you can access this particular feature by selecting the video and navigating into the "Audio" settings. Look for the "Voice Changer" section to lead to the
respective settings. When in the "Voice Filters" section, click any particular effect to make changes to your video's sound. You can also set the "level_Strength" and
"level_noise" settings with the sliders.
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Voice Filters

On leading into the "Voice Characters" section, choose any effect to change the voice of the video.

Voice Characters

Remove Voice Changer Effects

Select the video and navigating into the "Audio" settings. Look for the "Voice Changer" section and choose None to remove the voice changer effect.
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Remove Voice Changer Effects

Favorite Voice Changer Effects

Right-click on the audio-driven effect in the effects menu and choose to Add to Favorites.
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Select "Add to favorites"

Or you can also choose the effect as your requirement. You will see a "Star" shape on the top right. Click the "Star" into the green.

Click on the Green Star

You can check your favorite Voice Changer effects from the left drop-down list: Mine - Favorites.
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Find the Voice Changer Effects

19.1	Transitions

Transitions can tie the shots and clips together into a cohesive, polished video. Filmora has more than 500+ transitions to help you edit your videos better.

In this guide, you will learn how to find, add, adjust, remove, and favorite Filmora Transitions.
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01Find Transition
02Add Transitions
03Adjust Transitions
04Remove Transitions
05Favorite Transitions
06Batch Apply Transitions
07Apply Selected Transitions Randomly Across Clips

Find Transition

Double-click on the app's desktop icon, and once the welcome window pops up on the screen click on the New Project option.

In the upper left corner of the editor's main window, you'll be able to see a few tabs, like Audio, Titles and Effects. Click on the Transitions tab.
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Filmora Transitions

Add Transitions

Method 1: Choose and Download the Transitions

Click the download button to download the transitions, it will cost you a seconds.

Download Transitions

Method 2: Drag the Transition to the Timeline

Drag it to the beginning or end of a video clip or image in the timeline. You can also place the transition between the two videos.
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Drag Transition to Timeline

Note:

In versions of Filmora 8 there is only one video track which you can use transitions on. In Filmora and above you can apply transitions to any video track.

Adjust Transitions

After dragging the transition to the timeline, you can double-click the transition to adjust the duration and the position. Usually, the default duration is 2 seconds.

2 Ways to Adjust the duration of the transition:

Method 1: Double-click the transition in the timeline and then enter a new duration.
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Adjust transition duration

Method 2: You can also click and drag the starting or ending point of the transition forwards or backwards within the video clip or image.

Drag starting or ending point

Note:

Trimming frames will make the transition work by default when a media piece is not long enough to accommodate a transition. If you don't want this to happen,
double-click the transition in the timeline and un-tick the "Include Trimmed Frames" option.
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Choose to "Include Trimmed Frames"

To apply the same transition through your entire project:

Right-click on the transition you want to use and select "APPLY TO ALL". But note that this transition can only be applied for the duration which is mentioned
adjacent to it.

Apply to All

Remove Transitions

Method 1: Select the transition you want to remove from the timeline and hit the "Delete" button.
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Remove Transitions

Method 2: Or right-click on the transition in the timeline and select the "Delete" option from the menu.

Remove Transitions

Favorite Transitions
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Right-click on the transition in the Transitions menu and choose to Add to Favorites. Or you can also choose the transition as your requirement. You will see a
"Star" shape on the top right. Click the "Star" into the red.

Select "Add to favorites"

You can check your favorite transitions from the left drop-down list Mine- Favorites.

Click on the star

Batch Apply Transitions

Once you've added a transition to your video clip within the timeline, you can now batch apply a single transition to the video with a define duration. After adding
one transition across the timeline, set the "Transition Mode" and "Duration" before selecting "Apply to All" button.

  

 508/641

  

 



Click on "Apply to All"

Apply Selected Transitions Randomly Across Clips

Wondershare Filmora now allows you to randomly apply a selected set of transitions to your video clips. For that, select the video clips across which you wish to
apply the transitions and navigate to the "Downloads" sub-section in the "Mine" category of the "Transitions" tab. With the selected clips, press the "CTRL" button
on your keyboard and select the transitions you want to apply. Right-click after the selection and press the "Random to Selected Clips" button to apply the
transitions.

Click on "Random to Selected Clips"

20.1	Stickers
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Stickers can make your video more interesting, Filmora has more than 1000 stickers to help you edit your videos with ease. You can see all kinds of Filmora stickers
on the left, choosing and downloading the stickers you want.

Learn how to find, add, adjust, remove, and favorite Filmora stickers.

Index

01Find Stickers
02Add Stickers
03Adjust Stickers
04Remove Stickers
05Favorite Stickers

Find Stickers

In the upper corner of the main window, you'll be able to see a few tabs, like Audio, Titles, and Transitions. Click on the Stickers tab, select and download the
wanted stickers.

Find Stickers

In addition to regular stickers, there are also Audio Stickers that automatically sync their content with corresponding sound effects. You can identify these audio
stickers by the audio+sticker logo located in the bottom left corner.
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Find Audio Stickers

If you are not satisfied with the sound effects of the audio sticker, you can locate the sticker on the timeline, right-click on it, and select "Disable Sound Effects" to
turn off the sound effects.
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Disable Sound Effects

Add Stickers

There are three ways to add filters to a video:

Method 1: Open your project, go to the Stickers tab, and then select the sticker that you want and add it to your project.
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Add Stickers

Method 2: Hover your mouse over the sticker you want. When you see a Plus icon in the middle, click it. Then the sticker will be added to the timeline.

Add Stickers

Method 3: Go to the Stickers tab, then select the sticker you want to add to your project. Drag the sticker into the timeline directly.
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Add Stickers

Adjust Stickers

Double-click the sticker on the timeline, and you will see four options for adjustment: Basic, Mask, AI Tools, and Animation. Choose the one you want to adjust, you
can click OK to apply the video when you finish adjusting.
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Adjust Stickers

Remove Stickers

There are two ways to remove the sticker from your video:

Method 1: Select the sticker that you want to remove and hit Delete on your toolbox.
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Remove Stickers

Method 2: Right-click on the sticker in the timeline and select Delete from the menu.

Delete Stickers

Favorite Stickers
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Right-click on the sticker in the Stickers menu and choose Add to Favorites. Or choose the sticker you like, you will see a "Star" shape on the top right, and click
the "Star" into the light green.

Favorite Stickers

You can check your favorite stickers on the left- Mine > Favorites.

Choose Favorite Stickers

20.2	AI Sticker Generator

Wondershare Filmora is an AI-driven video editor that provides excessive features that make user personalization effective. The AI Sticker feature in Filmora brings
new bounds to video editing, allowing users to create their own stickers and utilize them without any issues with copyright or monotony. Under a simple prompt,
the AI Sticker feature provides effective results, which can then be used in video editing.

If you are looking to create a dedicated sticker for your video with AI, look ahead to the step-by-step guidelines:

Index

01 Launch Filmora and Create a New Project
02 Access the AI Music Window
03 Generate AI Stickers
04 Apply the AI Stickers
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05 Adjust the AI Stickers

Launch Filmora and Create a New Project

Upon successfully downloading Filmora, open it and log in or sign up from the main menu. Afterward, direct the cursor towards the control panel at the left and
select "Create Project". From the numerous tabs appearing on the main menu, tap on the "New Project" tab.

Click new project to start editing

Access the AI Sticker Window

After accessing the interface, look into the "Stickers" tab from the top toolbar and lead into the "AI Sticker" tab to reach out to the feature.

Access the AI Sticker

Generate AI Stickers

Provide the prompt for the sticker you wish to generate and select the appropriate style of the sticker from the options available below.
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Generate AI Stickers

Once you've added a prompt within 500 characters, click "Generate" to create 4 different versions of the sticker.

Generate AI Stickers

Apply the AI Stickers

With the sticker generated, you can view it. Click the "Download" arrowhead to download the generated stickers.
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Apply the AI Stickers

Adjust the AI Stickers

Double-click the sticker on the timeline, and you will see four options for adjustment: Basic, Mask, AI Tools, and Animation. Choose the one you want to adjust, you
can click OK to apply the video when you finish adjusting. For stickers on Filmora 9 and 10, please visit this guide page.
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Adjust the AI Stickers

21.1	Filters

Wondershare Filmora enables you to add as many filters as you want. You can add or customize the filters to create a brilliant video. Learn how to add, remove,
customize, and favorite Filmora Filters.

Index

01Add Filters
02Customize Filters
03Favorite Filters
04Remove Filters

Add Filters

There are three ways to add filters to a video:

Method 1: Open your project, go to the Filters tab, and then select the filter that you want and add it to your project.
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Add Filters

Method 2: Hover your mouse over the filter you want. When you see a Plus icon in the middle, click it. Then the filter will be added to the timeline.

Add Filters

Method 3: Drag the filter and drop it directly onto the video clip in your timeline that you want to add it to. Filters will be applied to the whole video clip this way.
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Add Filters

Note:

If you are editing a portrait (9:16) clip in a 16:9 video, you can add background blur filters to replace the black bars.

Customize Filters

Wondershare Filmora enables you to change the duration or opacity of filters.

To change the duration

The default length is five seconds, but you can drag the edge of the effect in your timeline to change its duration.
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Change the Duration

To Change the Alpha Opacity of a Filter

The alpha opacity (transparency) property can have a value of 0-100. A lower value makes the filter more transparent. Double-click on the filter in the timeline to
customize its opacity. Then, you preview how your clip looks with the filter applied to it in the Preview Window.

Enable Protect skin tones and adjust the settings in the property panel if there are people in the video.
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Customize Filters

Favorite Filters

Click on the favorite filter and find the Star icon, click on it and turn the star to green.
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Add to Favorites

Then, go to the Mine-Favorite category to find it again quickly.

Add to Favorites

Remove Filters

There are two ways to remove filters from your project:

Method 1: Select the filter in the timeline and hit Delete on the toolbox.
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Delete Filters

Method 2: Right-click on the filter in the timeline and select Delete from the menu. Note: If you're using Filmora 9 or 10, click here to learn how to add filters and
overlays.
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Delete Filters

22.1	Preset Color Adjustment

When using Filmora, you can harness the power of many options to enhance its color tones. Applying the tone adjustments can set the video to meet your ideal color,
be brighter, lighter, darker, or gray. This function grants users easy access to tweak color tones by adjusting sliders or modifying the color element values. In this
guide, you'll discover the built-in presets and other color tone adjustment features:

Following the previous step, proceed to the left-side panel and access the "Color > Basic" tab. Here, you'll find a variety of color tone adjustment elements, including
"Presets", "LUT", "Color", "Light", and more.
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01LUT
02Color
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04Adjust
05Vignette

LUT

Step 1: Open Color Settings

After adding the video to the timeline, double-click on it to open the color settings.
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Access Settings of Color

Step 2: Access LUT Settings

Navigate through the "Color" tab and select the "Basic" sub-tab from the available options. Continue to scroll down and turn on the "LUT" section if needed.
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Enable LUTs from Settings

Step 3: Add LUT and Set Its Parameters

Once done, select the respective LUT from the available list that you want to add. You can also browse the LUT using the "Load new LUT…" option available in the
drop-down menu.
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Adjust LUT Settings

Set the "Strength" of the added LUT with the available slider and click "OK" to conclude the process. Click "Protect Skin Tones" if there are any human in your
video.
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Adjust LUT Settings

Step 4: Remove LUTs from the Video

For those who have added the LUTs from the "Video" settings in the "Color" tab, proceed to the drop-down menu against the "LUT" section. Select "None" from the
menu and remove the LUT successfully.
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Remove LUT from Settings

Adjust Color

Color eliminates color casts to restore the natural color temperature of a video. It is widely used to make the white objects in a video look white. Also, with the
settings of color, you can create an atmosphere of your preference, ranging from cold to warm.

Step 1: Add your required video

Launch the application on your computer. Import media or select your needed one from the stock, then drag it to the bottom processing interface.
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Adjust White Balance Settings

Step 2: Open the Color Feature

Click the video in the timeline and then switch to the Color tab. Turn on the Color feature by clicking the button beside it.
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White Balance for Windows Interface

Step 3: Adjust the settings

Navigating to the editing panel, if you want to apply the function automatically, you can click Auto or the eyedropper tool to set the color instantly.
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White Balance for Windows Interface

For more precise adjustments, Temperature and Tint settings are available:

Drag the Temperature slider to modify the color of the video. A lower value means a colder color temperature, and a higher value will be a warmer color
temperature.
Then, drag the Tint slider to change the color level of the video.

  

 536/641

  

 



Adjust White Balance Settings

Step 4: Remove Color

To remove the set feature, you can click the reset icon on the right side of the Color section title. Then, the values will revert to the default 0.

White Balance Reset Icon

Step 5: Keyframes on Color

When you only want to apply white balance for a short period of the video or set different color effects at several points, you need to set keyframes in the timeline.
Drag the playhead to where you need it, set the color adjustments, and click the keyframe icon.
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Color Reset Icon

You can add as many keyframes as you need. The system can analyze the differences between two close keyframes, and export natural changes from one point to
another. To delete the keyframe features, you can right-click the specific keyframe in the timeline, and select Clear All Keyframes.
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Edit Keyframes

Adjust Light

Step 1: Add the needed clip

After launching the application, you can import the media from your computer. Or you can drag the clip directly to the bottom processing interface.

Step 2: Activate the color feature

Click the video in the timeline. In the property panel on the right side of the interface, select Color > Basic > Light. Click the button beside Light to change the
settings.
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Light Settings Interface

Step 3: Change precise settings

Adjust the effects of the video based on your needs from five aspects: Exposure, Brightness, Contrast, Highlight, and Shadow. Click OK when you have set the
values.

Light Settings Interface

Step 4: Remove Light Settings

You can click the Return icon beside the corresponding feature to remove the specific adjustment. If you want to delete all Light settings, you can click the return
icon beside the Light tab.
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Remove the Tone Scale Settings Icon

Step 5: Keyframes on Tone

Filmora enables you to create color changes with keyframes.

If you want to change the color at one or several points during a single video, you need to click the keyframe icon beside the return icon and change the color settings
in the property panel. Once added several keyframes, the system will export the outcome with natural changes of light.
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Create Color Grading with Keyframes

Adjust

Filmora's sharpness feature empowers users to bring clarity to their content and enhance the definition of objects. While it's not an independent function, accessing it
is straightforward.

Step 1: Locating and Enabling the Sharpen Option

Select the timeline clip and access the "Color" settings in the editing panel. Here, scroll until you find the "Adjust" slider, and enable it. Then, expand it to reveal the
"Sharpen" slider. By adjusting the slider forwards and backward, you can control the intensity of this effect.
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Access Sharpen Settings

Step 2: Saving or Re-Adjusting Settings

To preserve these settings for future use, click the "Save as custom" button or press the "Reset" button to return to the editing process from the start.

Reset or Save Settings

Vignette Effect

Vignette Effect is a widely-used effect, mainly known for adding a touch of nostalgia or past to your images and videos, and you can achieve this effortlessly with
Wondershare Filmora. This effect allows users to edit their media and capture viewers' attention with its outlook.

Step 1: Enable the Vignette Effect

Import your media on the timeline and select it, a customization panel will appear. Using your cursor, navigate towards this panel, and under the "Color > Basic" tab,
scroll down to locate the "Vignette" effect. Once found, enable it and adjust the settings below as per your video requirements. Users also have the flexibility to
customize the parameters under the vignette.
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Apply Vignette Effect

Step 2: Save the Vignette Settings

To re-adjust the vignette parameters, click the "Reset" button to revert the changes. After completing your editing, save your customized settings by clicking the
"Save as custom" button at the bottom of the customization panel.

Reset and Save Vignette Settings

22.2	AI Color Palette (Color Match)

The Color Match feature has been upgraded to AI Color Palette. This new tool utilizes advanced AI algorithms to more accurately extract and apply color palettes
from videos or images. AI Color Palette is widely used to match the color between different shots to create a consistent look across your videos. It is designed for
users who need color correction but may not have expertise in detailed color adjustments. It can improve the efficiency of color-correcting clips as a batch.

This guide will show you how to apply AI Color Palette to your videos or images on Windows:

Index

01 Import and Add Media Files to the Timeline
02 Enable AI Color Palette
03 Choose the Reference Frame
04 Preview the Color Palette
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05 Save and Apply the Color Palette
06 Remove Color Palette Adjustment
07 Export and Share

Step 1: Import and Add Media Files to the Timeline

If you have Filmora installed, open the program and create a new project. Import the color reference video or image and the footage you want to adjust from your
computer, then add them to the timeline.

Import Media Files

Add it to the Timeline

Step 2: Enable AI Color Palette

Double-click the clip on the timeline that you want to adjust the color for, opening the editing panel. Then, navigate to Color > Basic and click the button next to AI
Color Palette to activate the feature.

  

 545/641

  

 



Enable AI Color Palette

Step 3: Choose the Reference Frame

Method 1: From Project
Click the "Timeline" button, select an imported media file, move the cursor to choose the reference frame, and click "Generate".

Choose the Reference Frame from Project

Method 2: From Local
Click the "Local Files" button to import a local file. If you want to select a different file, click the "Replace" button above. Move the cursor to choose the reference
frame and click "Generate".
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Choose the Reference Frame from Local

Step 4: Preview and Adjust the Setting

View the video on the right side of the preview panel. Adjust the strength in the property panel, drag the slider in the property panel to change the strength of
matching colors. The range of settings is from 0 to 100. When you finish adjusting the strength, click OK.

Preview and Adjust the Setting

Enable Protect skin tones and adjust the settings in the property panel if there are people in the video.

Enable Protect Skin Tones
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Step 5: Save and Apply the Color Palette

After completing the color adjustments, click Save and Apply to exit the color palette mode.

Save the Color Palette Result

Customized color palette templates will be generated automatically in the properties panel. You can also click the cloud button above to store it in the cloud.

Upload it to Cloud

When importing new media files, click on the saved palette template in the AI Color Palette section to apply it with a single click.
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Apply the Saved Palette Template

Step 6: Remove Color Palette Adjustment

If you want to remove the adjustments, navigate to Color > Basic and click the button next to AI Color Palette to deactivate the feature. Then, the changes would be
removed.

Delete the Color Palette Template

Step 7: Export and Share

Click Export when you finish editing and choose the format you want to save. Using Filmora 9 or 10? Click here to learn how to do color match.

22.3	Pro Video Scopes

Video Scopes is like a track of color elements during color correction and enhancement, and Filmora's new upgrades include pro video scopes for a professional
editing experience. Users can use four video scopes: Parade, Waveform, Vectorscope, and Histogram. Filmora maintains the seamless flow of work with its
Histogram feature. These histograms help keep track of color corrections to retain the graphical quality of the video. To utilize this functionality in Filmora, keep
reading the details below:

With the help of this guide, users are going to learn how they can access the video scope functionality in Wondershare Filmora:

Step 1: Login to Start a New Project

After installing this software, navigate towards the "Profile" icon at the top and log in or sign up accordingly. To start editing, go to the left side panel of Filmora's
main menu and select the "Create Project" option. Afterward, hover towards the center of this screen and click the "New Project" button.

Create a new project

Step 2: Access Video Scopes

Once you are in the main interface of Filmora, navigate towards the top right corner of the preview screen and select the "Video Scope" icon. By selecting this
button, the four video scopes mentioned above will appear.
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Access the video scope option

Step 3: Customize the Video Scopes

Users can also customize these video scopes as per their preferences. They can change the layout options from the available list to see selected video scopes at a time.
Moreover, they can expand the button showing the name of the video scope and change display options for these video scopes.

Change video scope layout

Step 4: Manage Parade Video Scope

There are a variety of video scopes made available across Filmora. Starting from managing the colors of the video, the "Parade" video scope can be used to change
the color channel from RGB to YRGB or YCbCr.
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Change colors through parade scope

Step 5: Personalize the Histogram Options

The "Histogram" video scope displays the multiple color adjustments in a graphical way, with adjustments of color channels. Personalize the video scope layout to a
single view from the top right corner and expand the "Type" button. From the expansion menu, opt for "Histogram" to begin editing. Additionally, you can switch
between histogram channels like "RGB and "YRGB" options. Users can also switch the video scopes from the given options.

Customize histogram layout

Step 6: Change Other Video Scopes

Conversely, the "Waveform" video scope can be used to adjust the color channels in a different way. The "Vectorscope" scope helps in identifying the skin tone.
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Manage other video scopes

22.4	Color Comparison View

While maintaining your content's integrity, Filmora offers dedicated color comparison functionality for clip editing. With the help of this feature, users can see a
comparison between "before" and "after" editing views of videos.

You can use three methods to observe the difference between your clips. Find those methods below and use your preferred one:

Index

01Method 1: Using the Upper Toolbar
02Method 2: Using the Settings Panel
03Method 3: Using the Timeline Toolbar

Method 1: Using the Upper Toolbar

Step 1: Place Your Media in Timeline Track

Once you have created a "New Project" after opening Filmora, import your files and continue in the editing window. Use your cursor to select and bring the
imported media to the timeline.

Drag and drop media to timeline

Step 2: Access the Color Comparison Option

After selecting the clip in the timeline, navigate towards the toolbar at the top of the editing window and click the "View" tab. From the dropdown menu, select
"Color Comparison Before/After". From the expansion menu, choose your preferred layout out of "Side-by-Side View", "Split View Left/Right", and "Split View
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Top/Bottom".

Choose comparison layout and see results

Step 3: Edit in the Color Comparison Mode

Once you have selected a layout option, a window will appear where you can see the color comparisons and edit accordingly.

Start editing in a new window

Method 2: Using the Settings Panel

After importing and bringing your clip into the timeline, select it and navigate towards the right-side panel. From the "Color" tab, locate and select the "Color
Match" icon.
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Navigate to right panel and choose

Method 3: Using the Timeline Toolbar

After dropping media to the timeline, click the "Color Palette" icon and navigate towards the preview window to see the results.

Choose the relevant option in timeline

22.5	Color Wheels for Windows

Users can enhance the task using color wheels when performing video editing or graphic designing in Filmora. They can employ Filmora's color wheel technique to
upgrade their editing and enhance the visuals of their content. In this guide, users will have extensive knowledge of accessing the Color Wheels in this editing
software:

Accessing the Color Wheels

Here is a step-by-step insight into accessing this feature from Filmora’s main interface:

Step 1: Import Media into the Media Library

Upon accessing this software on your desktop, initiate it, and from the main menu, select the "Open Project" option. Doing this will directly import your media into
the "Media Library". Afterward, bring this media to the timeline.

Step 2: Access with Color Wheels
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After selecting the clip you just brought to the timeline, hover towards the settings panel at the right.

Left mouse click on the video on the timeline and the tabs will appear on the right side. You will find "Color Wheels under "Color" tab, and then make sure the
"Color Wheels" switch is on.

Step 3: Adjust the Color Wheels Depending on Your Preference

There are a total of three buttons for Highlights, Midtones, and Shadows, and each adjustment option has sliders that allow you to customize the parameter settings,
so you can change them according to your prefer, and there are also specific numbers displayed below.

Step 3: Reset or Preserve the Settings

Upon finalizing, use the "Save as Custom" button to preserve the color wheel settings. If you want to re-adjust the settings, press the "Reset" button.

22.6	Advanced Color Adjustment

The primary focus of this guide is to provide instructions on how to access and enable the Advanced Color Adjustment feature in just a few clicks:

Index

01HSL
02RGB Curve

HSL

Amongst Filmora's many features for color correcting and adjustment, one is HSL. This function adjusts colors based on three components, including "Hue,"
"Saturation," and "Luminance."
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Step 1: Bring Media to Timeline for Editing

Once you have reached Filmora's main display after opening it, click the "New Project" button and select files from your device's File Manager. After that, drag-
and-drop the imported files into the timeline.

Bring the Media into the Timeline

Step 2: Activate and Open HSL Settings

Next, select the video you brought to the timeline, direct it toward the editing panel "Color > Basic", and click on the "HSL" tab.

Access the HSL option

Once you reach there, modify the settings of the "Hue", "Saturation", and "Luminance" sliders.
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Access the HSL option

Step 3: Reverse or Save the Custom Settings

After making the desired changes, click the "Save as custom" button at the end of this panel to save these adjustments for future use.
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Save as Custom

If you want to re-adjust the settings, click the "Reset" button.

  

 558/641

  

 



Reset the Adjustment

RGB Curve

To improve the quality of the video, adjust the color and light is the common way most people know. Filmora now support customize RGB curve to make the
adjustment easier.

Step 1: Import and Add it to the timeline

Import your video into Filmora and drag it to the timeline. Select the video from the timeline.
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Import and Add it to the timeline

Step 2: Enable Curves feature

Then, select the "Color > Basic" tab in the editing panel. Click "Curves" to enable the feature in the panel, scroll down the interface and you'll see the RGB curve.
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Enable Curves feature

Step 3: Adjust and Preview

Now you can adjust the RGB curves and preview the video from this window.
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Adjust and Preview

22.7	Custom Color Layer for Windows

If you want to set a unique mood for your video montage while enhancing the color tone across all clips, this new feature in Filmora is for you. The custom color
layer feature allows you to create and apply your own solid or gradient color layers over your video clips for creative effects and color grading. You can generate
your own solid overlays and save them as custom to apply instantly in future videos.

The feature is ideal for mood settling, creating brand consistency, and stylization across clips. To learn how to use this feature, read the steps mentioned below:

Step 1: Launch Filmora and Create a New Project

To begin the process, launch Wondershare Filmora on your device and press the New Project option from the homepage. Next, import the videos of your choice on
which you want to apply color grading.
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Step 2: Access the Custom Color Layer Option

In the editing interface of Filmora, head to the Media section from the top toolbar and enable the Editing Presets section. Next, click on the Custom Color Layer
option to enable the customization window.
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Step 3: Customize the Color Layer and Save

Name the layer and expand the Fill Type to choose your desired filling style. Next, select the shade by accessing the Color option. Once the color for the layers is
selected, tap on the Save as Custom option. Rename the custom layer and press the OK button to save the changes.

Step 4: Apply The Custom Color Layer to the Clips

To apply the layer, drag it to the editing timeline in the area of the video or press the + icon to apply it. Head to the Layer panel on the right side and choose the
Blend Mode by expanding its drop-down menu.

Step 5: Apply Color Layer as Mask

Lead into the Layer panel on the right and enable the Mask section. Choose the shape of the mask and adjust different attributes like Blur Strength.

  

 564/641

  

 



Step 6: Add Animation to the Layer

Access the Animation section from the Layer panel after applying the layer to a specific segment of the video. Now select the preset for animation to apply to the
layer, preview the results in the preview window and finally press the Export button to save the final results.
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23.1	Animation

This guide introduces how to apply preset animations or preset motions to your video. Animation makes the clips in your video connect with each other more
naturally and attractively. Plus, your video could be more creative and unique.

Here is how to activate the Animation feature and how to apply your ideal preset to the video.

Index

01Import your needed clip
02Activate Animation
03Apply Animation Templates to Videos on Windows
04Customize the Preset Animation
05Remove Preset Animation or Preset Motions

Step 1: Import your needed clip

Launch Filmora on the computer first. Drag the clip you need from the files to the processing interface.

Step 2: Activate Animation

Move the progress bar to where you want to edit the animation. Click the video once, and in the property panel on the right side of the screen, find Video >
Animation. Then, in the Drop Down List below, choose Preset Animation or Preset Motions.
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launch customized animation feature on windows

Preset Animation: Filmora offers nine types of preset animations, including Fade in, Fade out, Pause, Slide Right, Slide Up, Vortex In, Vortex Out, Zoom
In, and Zoom Out.
Preset Motions: The Preset Motions offers more than 70 templates. You can explore and discover the feature you like.

Note:

Hover the pointer on the animation effects and stay there for a while, and you can preview the effect in the little windows where it is located.

Step 3: Apply Animation Templates to Videos on Windows

Drag or double-click the effect to apply. After double-clicking the effect, the player on the right side will show you a short preview of it. You can consider whether it
is suitable for your video.

Apply Presets

Step 4: Customize the Preset Animation

You can edit or delete the preset animation by clicking the keyframe on the video clip, and customizing the rotate, scale, position, and opacity values you want.
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Customize the Preset Animation

Step 5: Remove Preset Animation or Preset Motions

The following operations explain how to remove the two features:

Preset Animation
To remove the Preset Animation adjustment, go back to the property panel and click Video > Animation > Preset Animation again. Then, click Reset to
revert to the default effect.

reset preset animation feature on windows

Preset Motions

To remove the Preset Motions adjustment, you need to return to Video > Animation > Preset Motions in the property panel first. Then, click Reset at the bottom of
the tab or click No Animation at the position of the first choice.
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choose no motion on windows

Note:

Filmora not only provides Preset Animation and Preset Motions to videos but also the text inserted in the video. You can double-click the text to launch the text
animation feature, and the steps are similar to the above-mentioned ones.

24.1	Split Screen Template

Reimagine your stories by using multiple screens with Filmora Split Screen video tool. You can level up your editing with different angled shots, side-by-side
comparisons, or capturing gameplay in high quality by reading this guide below.

Index

01Choose Split Screen Preset
02Import Clips to Split Screen Video
03Edit Split Screen Video
04Color Correction for Split Screen
05Animating Your Split Screen
06Adjust Single Video in Split Screen Preset

Choose Split Screen Preset

Transforming multiple videos into a piece of art using split screens is now easy with Filmora The simple drag & drop interface and powerful editing tools make it
possible to multiply your fun for a unique blend to your stories. To start splicing your clips with split screens, follow the steps below.

Step 1: Launch a new project

Launch Filmora and create a New Project and import your videos.

Step 2: Choose the right preset for your split screen

Click Templates > Split Screen to enter your layout library. Choose from 86+ split-screen preset templates and up to 6 clips for simultaneous playback.
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use split screen Filmora

Step 3: Preview Layouts

To preview the layouts, double-click the preset thumbnails. Then drag your chosen layout to your timeline panel to select it.

Note:

The default duration of the split screen is 5 seconds. It can be extended or shortened by dragging the edges forward or backward on the timeline. You could scroll up
and down on the thumbnail view area with your mouse wheel, for example, from "Basic" to "Social Media", you only need to scroll horizontally.

scroll up and down

Import Clips to a Split Screen Layout

The latest version is made even better, with more presets and layouts to choose from. Here's how to import clips to a Split Screen layout.

Step 1: Import your Clips on Split Screen

Launch Filmora and create a New Project. Click Import to add media files to your library.

Step 2: Place your Clips on different Split Screen Windows
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Drag the imported videos one by one to the split screen preview window.

import clips to split screen

Edit Split Screen Video

Editing your split screen videos allows you to make photo and video collages, intro and outros, reaction videos, and comparisons with a few clicks. Here's how to
edit your split-screen videos for a unique way to tell your stories.

Method 1: Add Borders

Under the Video tab on your Property Panel, enable Border to customize the color and size of the borders between the clips in split screen.
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adjust border between clips

Method 2: Change Size and Position

Under the Video Tab, enable Transform to give you options to Rotate, Scale, as well as change the size of the split-screen videos.

Change Size and Position

Color Correction for Split Screen

The Color Correction feature for split screen works the same as when editing non-split screen videos. Simply click on Color > Basic on your Property Panel to
adjust everything from:

• Color: Choose the right tone depending on the scene

• Light: Calculate the correction of the colors on your video.

• Vignette: Darken the edges of the frame on your video.

• AI Color Palette: Create a consistent look across your video.
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color correction split screen

Animating Your Split Screen

Your videos can be customized by using different split-screen effects whenever possible. Simply switch to the Animation tab and choose from animation or motion
presets by twice clicking the effect you want. The results will be displayed in the Preview Panel; then, you can save the new animation effects on your video.

animate your split screen

Or you can simply highlight the Diamond icon to set keyframes located beside the properties or parameters and then adjust the values as you prefer. The Changes
will be applied to all the clips in the split-screen video.

Note:

You can animate any single clip in the split-screen video. Just go to the Advance Edit panel. If you're using Filmora 9 or 10, click here to learn how to split videos.

Adjusting Single Clip in Split Screen Preset

You’ll discover other interesting and creative methods when editing your videos. The points below are the ways you can try when adjusting your single video in a
split-screen preset.
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Zoom in and Zoom out: Select one clip in the split screen preview. Next, simply drag the slider to zoom in and zoom out.
Mute Audio: To remove sound on one clip, tap the Mute icon in the split screen preview window.
Remove the clip from split screen video: If you want to remove a single video on the split screen manually, choose the clip in the split screen preview and tap
the Remove icon.

adjust single video split screen preset

• Advanced Split Screen Edit: Click Edit > Advanced Split Screen window. This interface allows you to rotate any of the clips, change the position or scale, do
color correction, and even apply motion effects.

adjust single video split screen preset

24.2	Templates

Preset Templates in Filmora populate the timeline with some introductory clips, audio tracks, elements, stickers, and a stock video that you can replace with your
footage to personalize the output. Furthermore, you can also customize any or all the other decorative objects to get the engaging movie that you want.

These preset templates not only make your post-production task quick and easy but also help you avoid the tedious process of fine-editing that you have to go
through otherwise.

Index
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01 Add a Template to the Timeline
02 Replace the Template Footage
03 Customize the Video Template
04 Preview and Export the Video

Add a Template to the Timeline

Go to the Templates tab at the top and click the Templates menu under the Mine category on the left side. You can see there are dozens of templates, click one to
preview it, and then drag the template to the timeline.

Select A Template

Note:

To switch from one template menu to the other, you only need to scroll down to the bottom.

Replace the Template Footage

On the timeline, there will be a box indicating how many segments of the template can be replaced with materials, and you can click to edit the materials.
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Replace the Video Clips

For example, if this template has 8 items that can be replaced, when you click "8 items can be replaced," the replacement material segments will appear directly
above the timeline. You can click the loop icon on each material to replace the video, and customize the text in each segment in the text section on the right.

Replace the Video Clips

After you have replaced the material segments, you can click the "Edit" button in the middle of the video to customize the video segment selection. Once everything
is complete, click "close" to finish replacing the materials.
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Select Video Segment

Customize the Video Template

Return to the timeline to add stickers, effects, and other elements.
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Customize the Video Template

Preview and Export the Video

Click the Play button that is present below the Preview window to preview the expected output. Click Export from the top-center and use your preferred option to
export the final video.
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Preview and Export the Video

25.1	Exploring and Using Filmora's Asset Center

Filmora's Asset Center is your gateway to a vast collection of creative assets designed to enhance your video projects. It acts as a curated marketplace within Filmora,
offering themed packs, trending elements, effects, titles, stickers, and more. This feature helps you discover new, popular, and specific resources easily,
complementing the standard library categories.

Index

01Accessing the Asset Center
02Navigating the Asset Center
03Finding, Downloading, and Using Assets

Accessing the Asset Center

1. Launch Filmora:Open your Wondershare Filmora application.

2. Locate the Asset Center Button:Look at the top section of the main interface. You'll see the primary asset category tabs (Media, Stock Media, Audio, Titles,
Transitions, Effects, Filters, Stickers, Templates). Directly below these tabs, you will find the Asset Centerbutton, typically positioned next to the search bar
for the selected category.

3. Open Asset Center: Click the Asset Center button. It is accessible regardless of which main asset category tab (like Effects, Titles, or Stock Media) is
currently active.
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Access Asset Center

Navigating the Asset Center

Once clicked, the Asset Center window will open, typically showing the Discover tab. Here you can find:

1. Promotional Banners: Large banners showcasing featured themes or collections (e.g., "Pixel Style Takes Over"). Clicking these takes you to dedicated pages
for that theme.

2. Top Lists: Sections like "Best of New," "Premium Pick," and "Creator's Pick" highlight popular, high-quality, or curated assets.

3. Explore Categories: Browse assets by specific themes or types like "Game," "Vlog," "Spring," "Birthday," etc. Clicking a category filters the displayed
resources.

Navigating the Asset Center
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Asset Center Top Lists

Finding, Downloading, and Using Assets

Whether you're browsing through Promotional Banners, Top Lists (like "Best of New," "Premium Pick"), or Explore Categories, the way to use assets is similar:

1. Locate an Asset: Browse the Asset Center to find an individual asset or a pack that interests you.

2. Add to Timeline:

Hover over the asset or element you want to use.
Click the '+' (Add) icon.
If the asset isn't already downloaded, Filmora will automatically start downloading it. A progress indicator will appear.
Once downloaded (or if already downloaded), the asset will be added directly to your timeline at the playhead's current position, ready for customization.
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Add to Timeline

Customize the Asset

3. Add to Favorites (Optional):

To save an asset for quick access later, hover over it and click the star icon.
This will add the asset to your "Favorites" section, accessible from the main Filmora library panel.
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Add to Favorites

25.2	A Complete Guide to Using Creative Assets in Filmora

Filmora offers a wide range of creative assets to help you enhance your video projects with ease and creativity. These resources include Stock Media, Audio, Titles,
Transitions, Effects, Filters, Stickers, and Templates. With these assets, you can make your videos more engaging and professional. In the following sections, we will
introduce each type of resource and show you how to use them effectively. For each asset, you can also add your favorites to custom groups for easy access and
organization.
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01Stock Media Resources
02Audio Resources
03Title Resources
04Transition Resources
05Effect Resources
06Filter Resources
07Sticker Resources
08Template Resources

Stock Media Resources

Stock Media in Filmora provides you with a vast library of high-quality images and video clips that you can use in your projects. Whether you need background
footage, overlays, or specific scenes, you can easily find and insert stock media to enrich your video content.
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Tip: If you find stock media you like, you can add it to your favorites and organize it into groups for quick access later.

Audio Resources

  

 584/641

  

 



Filmora’s Audio library includes a variety of music tracks and sound effects to suit any mood or scene. You can browse by genre, mood, or type, and easily drag and
drop audio into your timeline to enhance your storytelling.

Tip: Save your favorite audio tracks to custom groups so you can quickly find the perfect sound for your next project.
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Title Resources

With a diverse selection of Fonts, Filmora allows you to customize your titles and text overlays to match your video’s style. Choose from different font styles, sizes,
and effects to make your text stand out.
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Tip: To quickly access your favorite fonts, head to the "Mine" subcategory—just like with Stock Media and Audio, your grouped and favorited assets will be listed
there.

Transition Resources

Transitions help you create smooth and dynamic changes between scenes. Filmora offers a wide variety of transition effects, from simple fades to creative
animations, making your video flow seamlessly.

  

 587/641

  

 



Tip: You can organize your favorite transitions into groups, which are accessible under the "Mine" section.

Video Effects Resources

Filmora provides a rich collection of Effects to add visual flair to your videos. From cinematic looks to fun animations, you can apply effects to clips to achieve the
desired atmosphere or style.
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Tip: If you want to revisit your favorite effects, simply go to the "Mine" subcategory, where all your grouped and saved creative assets are conveniently stored, just
like with other resources.

Filter Resources

Filters in Filmora allow you to quickly change the color tone and mood of your video. With just a few clicks, you can apply vintage, cinematic, or artistic looks to
your footage.
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Tip: Your favorited filters can be found in the "Mine" section, where you can easily browse through your organized groups.

Sticker Resources

Stickers are a fun way to add personality and emphasis to your videos. Filmora offers a variety of animated and static stickers that you can drag onto your timeline to
highlight key moments or add creative touches.
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Tip: Like other creative assets, grouped and favorited stickers are available in the "Mine" subcategory, making it simple to find and use them whenever you need.

Video Template Resources

Templates in Filmora provide ready-made video layouts and designs, making it easy to create professional-looking videos even if you’re a beginner. Simply choose a
template, customize it with your own content, and you’re ready to go.
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Tip: To manage your favorite templates, check the "Mine" section, where all your grouped assets are stored for quick and easy access.

26.1	Workflow for Exporting

You will export the video when you will finish editing. Here is the workflow of exporting:

Step 1: Enable Export Settings

After importing your clip in the timeline and editing it, hover your cursor towards the top right corner of Filmora's editing window and click the "Export" button.
Choose the one way you want to export and click the “Export” button. You will see your video in the specified position.

click the export button
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Step 2: Adjust the Export Settings

Commencing the prior action will feature an "Export" window on the screen from where you can customize the export settings. You can personalize your name, file
location, format, resolution, and more settings from this window. Once you're through, click the "Export" button to save the file to your device.

adjust settings and click export button

To export one or more video clips, you can follow the below steps:

Select one or more video clips on the timeline and right-click to export the clip(s) easily and fast instead of having to export the whole project.

Now you’ll see a new window shows up, and you can now select the video format, quality level, the save path (local folder or devices) and other settings.

Click the “Export” button to start exporting your desired video clip. You can preview the video and the rate of progress.

26.2	Export

Filmora provides six ways to export your videos. Here is the introduction to the six ways. You can customize the export settings and save them to apply the same
settings next time.
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02Export to Device
03Export to YouTube
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06Burn a DVD

Export to Local

You can export your project file and video to the local computer. It supports to export as MP4, AVI, WMV, AV1, MOV, GoPro Cineform, F4V, MKV, TS, 3GP,
MPEG-2, WEBM, GIF, MP3.

Step 1: Click the Export button and choose the Local tab.

Select the format you want to export in. You can rename the video and change the location on your computer where you save it. You can also check the output
resolution, frame rate, size, and duration before you export.
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Export by selecting "Local" tab

Step 2: Make Related Settings

To change your export settings (i.e. resolution, bit rate, and frame rate) click the Settings button.

Adjust Settings of MP4

The settings window has three quality levels: Lower, Recommend, and Higher. The only difference between them is the Bit Rate. You can adjust this or other
parameters, such as Resolution and Frame Rate, in this window.
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Video and Audio Settings

It is best to export your video with the same settings as your original video.

Note:

The size of the video depends on the length of the project and the bit rate. If the file size looks too big, you can try changing the bit rate in the Settings window to
make it smaller.

Step 3: Export the file to the specified location

When you're finished adjusting your video, press the Export button in the Export window. You can find the video in the specified location you selected.

Export to Local

Pro Settings: High-Precision Video and Audio Export

1. Project Settings: Support for Audio Sample Rate Configuration

You can now set the audio sample rate to 44.1kHz or 48kHz in the project settings, ensuring better audio fidelity during export.
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Project Settings

2. Adjusting Audio Bit Depth in Video Format Settings

In the Advanced interface, you can select PCM encoding for audio format and set the bit depth, allowing for more precise audio quality control.
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3. Exporting WAV Format PCM Audio with High Precision

When exporting pure audio in WAV format, users can choose the sample rate (44.1kHz or 48kHz) and adjust the bit depth up to 32-bit for maximum audio quality.
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Export to Device

You can export the video in a format suitable for your device; simply select your device, and the export format will be adjusted accordingly. Devices supported by
Filmora include iPhone, iPad, Apple TV, Apple TV 4K, iPod, Samsung Galaxy, Smart Phone, Android Generic, Google Pixel, Xbox One, PlayStation 4, PSP, and
Smart TV.

Step 1: Choose the device.
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In the Device tab under Format, you can choose to output your video according to the ideal settings for different types of devices, such as iPhones, iPads, Apple TVs,
Samsung Galaxy phones, PlayStation 4s, and more.

Step 2: Adjust the export settings.

You can also make manual adjustments to your settings by clicking the "Settings" button.

Step 3: Click "Export" when you're finished.
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Note:

Exporting in this way won't automatically transfer your videos to your devices. Your videos will still be stored on your computer's local hard drive.

Export to YouTube

Filmora supports exporting your video to Youtube directly. All you need to do is logging your Youtube account and export.

Step 1: Select YouTube to Export

To upload a finished video directly to YouTube, click "Export" and select "YouTube". Then Login to your Youtube account.
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Select YouTube to Export

Step 2: Log In

Check your browser to log in to your account.

Select "Log in"

Step 3: Access Account

Click "Allow", which allows Filmora to access your account.
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Access to YouTube Account

Step 4: Continue the Process in the Filmora

After allowing, you will see a new page to indicate that: Continue the process in the software. Now, come back to Filmora.
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Continue the Process in the Software

Step 5: Input Information for Videos

Input the title, description, and tags for the video and choose whether to upload the video as public, unlisted, or private.
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Input Information for YouTube video

Step 6: Do More Settings

If you want to do more settings, you can click "Settings". When you finish setting, just click OK.
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Do More Settings

Step 7: Export Now

Click the “Export” button to export your video directly to your Youtube channel.

Export to TikTok

When you finish editing a video clip in Filmora, you can also export and share it to TikTok directly. Follow the steps below:

Step 1: Select TikTok to Export

To upload a finished video directly to TikTok, click "Export" and select "TikTok". Then Login to your TikTok account.
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Step 2: Login to Your TikTok account

You'll see the login options; choose the one you registered in TikTok. (If you don't have a TikTok account, you'll need to create one from here.)

Here we take the phone number as an example, enter the number and login code, and then click "Log in" to proceed.
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Step 3: Continue to Process in Filmora

Once you log into your TikTok account successfully, authorize Filmora to connect with TikTok, and you'll see a window below.

Step 4: Customize and Export

You can customize the video and audio settings in Filmora before sharing it with TikTok.
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Export to Vimeo

Filmora supports exporting your video to Vimeo directly. All you need to do is logging your Vimeo account and export.

Step 1: Select "Vimeo"

To upload a finished video directly to Vimeo, click on "Export" and then select "Vimeo".

Step 2: Log in to your Vimeo account
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Then, you can check your browser to log in to your account. Click "Allow" to allow Filmora to access your account.

After allowing, you will see a new page to indicate that: "Continue the process in the software". Now, come back to Filmora.

Step 3: Edit video information

Input the title, description, and tags for the video and choose whether to upload the video as public, unlisted, or private.
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Step 4: Change the settings

If you want to do more settings, you can click "Settings". When you finish setting, just click "OK".
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Step 5: Click the Export button to export your video to Vimeo.

Burn a DVD

You can burn your video from a DVD. Choose the DVD tab and enter the required settings, such as the aspect ratio and disc type. To convert your video into DVD
during exporting it. Then follow the below steps:

Step 1: Choose the DVD tab.

Step 2: Enter the required settings, such as the aspect ratio and disc type.
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Step 3: Click to export to DVD and wait for a while.

26.3	Auto Highlight

Auto Highlight is used to automatically extract the highlights from a clip. This will save your time when trimming your video and get the best parts from it more
easily.

If you are a user of short video platforms like YouTube Shorts or TikTok, or a social media user, this guide will teach you how to quickly extract and upload video
content to social media.

Index

01 Locate Auto Highlight
02 Enable the Auto Highlight Options

Step 1: Locate Auto Highlight

Import and add your video clip to the timeline, go to Export < Local < MP4, you will see the Auto Highlight feature.

Export

Step 2: Enable the Auto Highlight Options

In the Export to MP4 interface, you can choose to tick the Auto Highlight check box. After ticking the check box, you can choose to export with Auto, 15s Tiktok,
60s Youtube Shorts option. Or you can Custom by yourself.
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Auto Highlight Options

26.4	AI Thumbnail Creator

Filmora's AI Thumbnail Creator can generate attractive thumbnails for your videos with AI assistance. It analyzes your video frames and takes out some of the best
ones as thumbnails. If you want to grab your audience's attention with eye-catching thumbnails, here is your guide:

Index

01How to Access an AI Thumbnail Creator?
02How to Generate a Video Thumbnail with Filmora?
03How to Generate a Local Thumbnail with Filmora?

How to Access AI Thumbnail Creator?

This is your ultimate step-by-step guide to extracting thumbnails from your videos or generating new ones along with AI’s help:

Method 1: Using the Export Window

After editing your video completely with Wondershare Filmora, click the "Export" button. The export window will appear; click the "Edit" button at the left top
corner of this window. This will take you to the thumbnail generator window.
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Click export to open export window

Method 2: From the Project Info Panel

After editing your content, click anywhere in the timeline other than the media clip, and a panel named "Project Info" will appear at the right. From this panel, click
the "Edit" button. This will take you to the "Set Thumbnail" window, from where you can generate thumbnails from your video in the "Video" tab and export it in
the same manner above.

Click edit button in project info

How to Generate a Video Thumbnail With Filmora?

Step 1: Choose a Frame as a Thumbnail

After accessing the thumbnail generator, navigate towards the left. There, AI is showing the best-fitted frames from video as thumbnails. Select the frame you like
and click "Edit".
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Select an image and click edit

Step 2: Choose a Template

Another editing window will appear where you can enhance your thumbnail. It has built-in AI templates for different categories to fit yours perfectly. Select a
category, choose a template from the given options, and click "Save".

Choose a template and click save

Step 3: Export the Thumbnail

Following that, the export window will appear again. Click the "Export" button, and the AI will convert this selected video frame into a thumbnail image so the
conversion will start. After its completion, click on the "Open Folder" option to see the AI thumbnail.
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Click open folder to see thumbnail

How to Generate a Local Thumbnail with Filmora?

Sometimes, you want a different and creative outlook for your thumbnail. That is when you generate it from a local source; read below to learn how to do that step-
by-step:

Step 1: Select the Local Option

Once you have edited your video, click "Export "and select the "From Local" tab from the top of the respective window. Click on the "Add picture to set as
thumbnail"and import a picture from your device. Once the picture is added, click "Edit" to proceed further.

Import a picture from device

Step 2: Set a Suitable Template

A new window will appear where you can select the template for your video. Furthermore, you can also make several adjustments to your image, like cropping or
replacing it with another picture. Then click the "Save" button for further processing.
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Pick a template and press save

Step 3: Export the Thumbnail

By doing this, you'll be directed towards the export window again; click "Export" to finalize. The conversion will start, and you can see the progress on screen.
When the conversion process completes, click the "Open Folder" button to view the final results.

Press open folder button for results

26.5	Export Selected Clips

There are various occasions when you edit multiple clips in a timeline and need to export any of them, and Filmora offers this functionality. Users can optimize the
editing process with its export option for selected clips in a few clicks.

If you are interested in knowing more about exporting selected clips through Filmora, follow this step-by-step procedure:

Index

01Exporting the Selected Clips
02Export Clip Range

Exporting the Selected Clips

Step 1: Expand the Export Button

If you are editing many clips at once and want to export just one, right-click on the selected clip and choose "Export Selected Clips".
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Choose the Selected Clip

Step 2: Make Customizations in the New Window

Upon the new window opening, change the file name, location, frame rate, resolution, and other settings and hit the "Export" button to save this clip on your device.
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Customize export settings and click export

Export Clip Range

To maintain the seamless editing flow in Filmora, users can set a specific range from the existing clip and export it. This function has many benefits, as users do not
need to trim and export the clip. Scroll down to find more about how to export selected ranges with ease:

Step 1: Import Media Files to the Timeline

Launch Filmora on your computer, import your files, and add it to the timeline.

Import Media Files

Step 2: Select the Start Point of the Clip Range

Once the clip has been imported in Filmora, hover towards the Preview Window and click the "{" icon, and a slider will appear to adjust the starting point of the clip.
An alternative method for commencing the same action is using the "I" key to define the start and the "O" key to define the endpoint.
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Choosing the start point

Step 3: Select the End Point of the Clip Range

Repeat the same process for adjusting the end point of this clip; however, choose the "}" icon this time.
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Choosing the endpoint

Step 4: Export the Clip Range

Once the clip range has been set, move towards the "Export" button and click it. A "Select Clip Range" window will appear; from there, set the relevant settings like
the folder for your clip, its name, and more, and hit the "Export" button.
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Export selected range

26.6	Video Compressor on Windows

Are you looking to share videos without hassle? Filmora makes it easy to shrink your video files by up to 90% at an astonishing 47x faster speed, perfect for social
media and email. Enjoy seamless conversions to popular formats like MP4, MOV, and AVI for free without any noticeable loss in quality while benefiting from the
best video compressor for both PC and Mac.

Learn how to simplify your video editing with unmatched speed and efficiency in the guide.

Index

01Steps to Use Video Compressor
02Conclusion

Steps to Use Video Compressor

To efficiently compress your video with Filmora, follow these straightforward steps:

Step 1: Upload Your Video

Import your video file from Google Drive or Dropbox, or drag and drop your videos into Filmora.
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Upload Your Video

Step 2: Compress Your Video

Click "Export" at the right top, and then select the mode of video compression: "By Quality" or "YouTube Upload". Choose one compression preset and
wait for the tool to automatically compress your video.
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Compress Your Video

Note:

1. If you click "By Quality", you can choose the quality level to adjust the size of the compressed file, ranging from 10% to 90%.
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Choose Quality Level

1. If you click "YouTube Upload", the video will be automatically compressed at the recommended bitrate for the YouTube platform, which will prevent
blurriness caused by secondary compression when uploading to YouTube.

Step 3: Export Your Video

Export your compressed video with the reduced file size.
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Export Your Video

Conclusion

With Filmora, compressing your videos is quick and easy. Enjoy reduced file sizes and efficient sharing without compromising on quality. Whether for social media
or email, Filmora ensures your videos are optimized and ready to go with just a few simple steps.

27.1	Wondershare Drive Overview

Wondershare Drive is a cloud storage for work and content creators. You can safely store and share photos, videos, files and other contents without the device
limitation.
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If you want to learn more about Wondershare Drive and get more cloud storage, please visit Wondershare Drive to get more information.
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How to Get 1GB Cloud Storage for Free in Filmora

Step 1: Download and open Filmora. (Download Filmora 9 or X here)
Step 2: Click "Filmora Cloud" and then log into your account to activate the cloud.

Step 3: Click "Authorize" to allow Wondershare Drive to quickly back up files.
Now, you can get 1GB for free and start to use the drive.

Note:

You can get 1 GB for free after activating Filmora account.

Launch Wondershare Cloud on Windows

The following are the steps for launching the Wondershare Cloud after logging in.

Step 1: Open the Transfer Center Panel

On the top toolbar, in the right corner, find the Transfer Center icon. Click it to launch the Transfer Center panel.

Step 2: Launch the workspace

On the bottom left of the pop-up Transfer Center panel, go to "Filmora Cloud is here", and click "Try it out!" to experience this feature.
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Save Files in Wondershare Drive

There are 2 ways to save your files as cloud files.

Method 1: Save as a project

If you haven't finished editing your video, you can save the video as a project file. So that you can directly continue to edit your video next time.

You can also save your project files to Wondershare Drive so that you can continue to edit your video with another computer at any time.
Just find the "Local Projects", and click the "cloud" icon to save your project files into Wondershare Drive.
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Method 2: Save to drive while exporting

Videos can be saved to Wondersahre Drive while exporting the video. Toggle the option on to upload your project to Cloud as you export.
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Then, you can check the uploading status in the Transfer Center.
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Find Files in Wondershare Drive

There are 2 ways to save your files as cloud files.

Method 1:Find cloud files in Filmora Cloud.

Method 2: Find cloud files in the Local Projects.

Method 3: Find your custom effects in Media>Cloud Media>My Cloud Media
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Manage Wondershare Drive in Filmora

Click "Filmora Cloud", then you can check and manage your cloud project files in Filmora Cloud.

You can also manage your cloud files in Transfer Center. Click the "cloud" icon to get in the Transfer Center.
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Share files in Wondershare Drive

With Wondershare Drive, you can easily share your videos and project files with others. People can see your sharing videos and edit with your project files.

Note:

The sharing project files are only supported to edit in Filmora.

Step1: Back up local files to the cloud

Click the "cloud" icon to back up any saved local projects to the cloud.
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Step2: Share cloud files to others

When the upload is done, find your file in Cloud Project and click the "share" icon to share your fiels.

You can also find the "share" icon in Transfer Center.

Step3: Edit your sharing option

You can share your files with or without passwords. The validity period is about 1,7 and 30 days.

If share passwords, you can set the passwords you want. Filmora supports 4 letters or numbers as passwords.
If share without passwords, all you need to do is choose the validity period.
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Step4: Create the sharing link

After setting the sharing options, you can create a link for sharing. When you see "Link copied successfully", you can copy the link to others.

27.2	Wondershare Drive Basic information

Wondershare Drive is a cloud storage for work and content creators. You can safely store and share photos, videos, files and other contents without the device
limitation.
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Main Function

Free 1G cloud storage space upon activation;
Provide upload, download and share operations;
The files that can be uploaded are: project documents (including packaging), project templates, finished videos
Support macOS/Windows interoperability and collaboration；
A variety of membership levels to choose from to meet the different needs of users.

User Scenario

Students make videos on the school computer, back up the project to the cloud disk, and log in to the account at home to continue editing and perfecting;
Internet celebrities share their engineering templates with their fans for use.
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Users with Cross-Platform Plan can upload the materials from mobile and edit the project on desktop.
As a business client in the video industry, constantly sending videos back and forth for review and modification can be inconvenient. By utilizing an online
link shared with the video editors, you can provide immediate feedback and view changes as soon as they are made.

Use Wondershare Drive in Filmora

After you get 1GB Cloud Storage in Filmora, you can do it with these:

Upload your videos and project files.
Download your videos and project files.
Share your videos and project files.

Workspace Interface

Here is the introduction of the features in the workspace interface.

Media File

Here is where to save your uploaded video. You can drag or drop your locally saved video to this section. Then, the clip will be displayed here, available to be
renamed, shared, viewed, or downloaded.

Note:

The following are tips on how to share and comment on your videos.

Share

The Share feature can create a link for you to send to other people. You are able to share the link With Password or Without Password.

If you choose to contain an Access code, it will be given automatically with four characters. It's uneditable.
The expiration of the link can be set from 1 day, 7 days, 30 days, to Never.
Permission, including Download and Comment, can also be set.
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View

Here is where you can send feedback on the video. You can select to comment on the exact time of the clip or the Overall video. Apart from noting down your own
views, you can invite others to leave an opinion by sending them the link to the video.

Finished Videos

Here shows your exported videos if you've uploaded them from Filmora after editing.

Project Files

This section displays your project files uploaded from Filmora.
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Shared Files

You can check the recordings of all videos you have shared. It allows you to view the clips, find the link to the video, and adjust the expiration time or permissions.

Recycle Bin

In the Recycle Bin, you can find accidentally deleted files and restore them in Media Files.

If you want to learn more about Wondershare Drive and get more cloud storage, please visit Wondershare Drive to get more information.

Function Entry of Cloud Backup

A total of 3 function entrances and 1 cloud disk task management. The entrance is as follows:

Startup Window

Cloud Backup in Startup Window

Cloud Media
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Cloud Backup in Cloud Media

Video Export
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Cloud Backup in Video Export

Cloud Disk Task Management
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Cloud Backup in Cloud Disk Task Management

For more information, click to learn Wondershare Drive.
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